
Welcome to Mixcraft 5.0, the easiest multitrack audio, MIDI, and video workstation on the planet!  

We've tried to make the help instructions as easy as possible to navigate.  You can search our "How To" section to learn 
how to do common operations in Mixcraft, such as using virtual instruments or recording audio.  For more advanced 
assistance, you can search our "Mixcraft Reference" section for detailed information about every feature in Mixcraft.  Finally, 
check out "Troubleshooting" section to solve common computer problems with Mixcraft, including problems playing back 
audio.

Important Sound Setup Information! (Read This!)
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Important Sound Setup Information
When you first start Mixcraft, you should make sure that the audio latency response is set up properly.  All sound 
devices and sound cards are not created equal and some have better performance than others.  In addition, your 
computer's speed will make a difference in audio performance.  Adjusting your sound device's performance will be a 
balancing act between latency versus gapping or breaks in continuous sound.  

If you are recording audio with Mixcraft's built in monitoring or playing virtual instruments, you will definitely need to 
adjust your latency response properly.

Choosing An Audio Driver Type
1. Click "Preferences" from the "File" menu. 

2. Click on the "Sound Device" tab.

3. For Vista and Windows 7 users, the default choice is "WaveRT".  If you have a slower computer, you may need to 
adjust the latency to a higher value.  (1000 milliseconds = 1 second.)  WaveRT is recommended if you have Vista.  If 
"WaveRT" is enabled, click it.  (WaveRT stands for Wave Real Time.)   In standard mode, WaveRT goes down to 20 
milliseconds latency.  

http://www.primoburner.com/


4. If you have Windows 7, you may be able to click WaveRT "Exclusive Mode".  This mode will allow you to go down 
to one millisecond of latency, depending on your computer's speed and power.  Note that in this mode, other 
programs will lose audio capability while you run Mixcraft.  You may need to restart the other programs to get their 
audio back.  WaveRT exclusive mode is advantageous for those seeking to use every last ounce of power out of their 
computer, but at the same time other programs will cease to make audio during WaveRT Exclusive Mode.

5. If you don't have WaveRT, the next best option is "ASIO".  If available, click "ASIO".  If it is grayed out, go to your 
sound device or sound card manufacturer's website and install the latest drivers. Click on the "ASIO Device" and 
choose the sound device or sound card you wish to use.   You can adjust the settings of the ASIO device by clicking 
"Open Mixer".  Each ASIO driver is implemented differently and so you will have to consult the manual or help for your 
sound device in order to adjust the latency response.  Make sure that the "Default Output (Playback)" is set to the 
correct device so that you will hear audio properly. 

6. If you don't have Vista or an ASIO option enabled, you have to use the last option "Wave".  Click the "Wave" radio 
button.  To reduce latency, decrease the "Number Of Buffers" and reduce the "Buffer Size".  As you adjust these 
fields, the "Latency" field will update.  You will have to make adjustments, click "OK" and play some audio.  100 
milliseconds or less is tolerable.  20 milliseconds or less is preferred.  

Computer Speed Consideration
If you have a slower computer, you may need to adjust your latency to be longer in order to avoid gapping or breaks in 
the audio.  If you are hearing breaks in the audio, you will need increase your latency.  Alternatively, you may need to 
purchase a higher performance sound device or sound card designed with music recording and playback in mind.  
Changing the latency will depend on what type of audio driver you are using.  See the section above on "Choosing An 
Audio Driver Type" for more information.  Another good speed enhancement is to de-fragment your hard drive.   

Notice the CPU meter on the lower right hand corner of Mixcraft.  

This will report how much CPU Mixcraft is using compared to the entire computer's CPU usage.

Shutting Down Unnecessary Software
When using Mixcraft, shut down unnecessary programs such as email, instant messaging, and your web browser.  
Each additional program uses your computer's memory and CPU, and, in many cases, it will cause performance to 
suffer in Mixcraft.  Check the Window's task manager to see what programs are using a lot of memory or CPU usage.  
On XP and Vista, you can bring up the task manager by pressing Ctrl+Alt+Delete.  If you can remember to reactivate 
your anti-virus software, shut down your anti-virus software while using Mixcraft. HOWEVER, DON'T FORGET TO 
TURN YOUR ANTI-VIRUS SOFTWARE BACK ON WHEN YOU ACCESS YOUR EMAIL OR THE INTERNET!  

Notice the CPU meter on the lower right hand corner of Mixcraft.  

This will report how much CPU Mixcraft is using compared to the entire computer's CPU usage.

Get The Latest Drivers
Always make sure to have the latest drivers for your sound device in order to get the best performance and quality in 
your recordings!  Visit the website for your sound device or sound card to install the latest drivers.  (Even if you just 
purchased the device, it is very likely that the included drivers are out of date already.)

Other concerns
Sound Is Breaking Up / Popping Or Clicking
Sound Is Delayed Or Lagging (Latency)
Recordings Are Drifting And/Or Start At The Wrong Time
Recordings Are Not In Sync
ASIO Is Not Available 



Quick Start
So you want to get something done in a hurry, eh?  Let's follow our favorite musician Sound Warrior (SW) through the 
paces of using Mixcraft™.

Load in sounds or loops
SW starts Mixcraft and clicks the Loop Library Tab.  He selects the style 12-8 Blues and drags in Bass 16 Bars to the 
start of track 1.  He scrolls down to Drums Hat & Snare 1 to the start of track 2. More on loading sounds...

Create loop
To add looping, SW moves his mouse to the right side of the sound until the cursor turns into the left-right resize 
cursor .  SW clicks and drags to the right to loop the sound.  Each loop is represented by a triangular tick so that he 
can visibly measure out 10 loops.  In this manner, SW loops both the bass and drums.

Records a Lead Synth Pad
SW hooks up his MIDI keyboard and creates a Virtual Instrument Track.  He finds a groovy synth lead and records 
himself.  In a few spots, he played the wrong note and so he simply goes to the Piano Roll Editor and moves the notes 
to the right spots!

Records Himself
SW writes down some quick lyrics about how square wheels just don't get you rolling.  He clicks the Arm button on 
track 3 and clicks the Rewind button in case the playback indicator is not at time 0.  He then clicks the record button 
on the Master Bar and start belting out his Grammy winning performance.  When he is done, he clicks the Stop 
button!

Add effects
He decides to add some echo or delay to his vocals so that "yo cave lady" sounds more like "YO yo CAVE cave LADY 
lady".  He clicks on the FX button on track 3 and selects the effect "Delay" from the list.  In a sudden inspiration, he 
decides that the whole thing needs reverb so that it sounds like it's in a cave and clicks on the Project Details Tab to 
add a global reverb effect.  Now it sounds just right and 'cavey'.

Mix it down to MP3
Soundwarrior needs to mix it down to a single sound.  He chooses File then choose Mix Down To followed by clicking 
MP3.  He selects a file name and clicks save.  Without hesitating he launches his email browser and starts composing 
a new message to his current #1 fan.  "Dear Mom, you've gotta check out this new cave mix I made!!!"

Burn it to CD
Sound Warrior is so happy with himself he decides to burn a spinning wheel (also known as a CD) so that he can play 
it at the next 'rock' concert.  He adds a few track CD markers so that he has tracks on his CD, and clicks the Burn 
button.  Minutes later, he prints a CD label with the optional Acoustica CD/DVD Label Maker !  

(Of course, SW has purchased all Acoustica software because he knows it is smart to support good software!)

How To's … 

What's New?
Version 5 Changes 

• Video support 
• Track level automation 
• Send/aux tracks 
• Master track automation 

http://www.acoustica.com/cd-label-maker/


• Built in noise reduction for audio clips 
• Musical typing keyboard 
• Notation editing and printing (sheet music) 
• New effects (Tube EQ, Amp simulator) 
• New VSTis ( Messiah, Lounge Lizard, Acoustica Expanded Instruments, Alien 303 Bass synth) 
• Mixer tab ( built in track EQ, etc.) 
• Metronome count-in 
• Improved loop mode 
• Updated user interface look and feel 
• Support for WaveRT exclusive mode on Windows 7 
• Link clip feature 
• New ALT drag to make a quick copy of a clip 
• New +1 looper button on clips 
• Improved support for faulty VSTs 
• Lower CPU usage 
• Better hard drive utilization 
• Record directly to OGG mode.

Version 4.5 Changes 
• Support for saving projects to MIDI 
• New Primo Burning engine! 
• Can now select channel for mono audio clips 
• Bug fixes for some audio devices 
• Bug fix for freezing tracks.

Version 4 Changes 
• Support for MIDI - record and playback. 
• Integrated support for VSTi software synthesizers. 
• Integrated VST MiniMogueEx, VB3 organ, General MIDI synth 
• Presets allow you to make mega instruments, combining effects and virtual synthesizers. 
• Support for Vista's WaveRT low latency audio system. 
• Piano Roll interface   for editing, quantizing and snapping notes. 
• Looping MIDI clips

Version 3 Changes 
• Brand New Interface 
• Support for ASIO low latency driver system 
• FlexAudio time stretching 
• Beat Matching and Key Matching 
• Detects beats in songs 
• Supports ACID and Apple loops 
• Downloadable Loop Library 
• Effects are accessed on Track details or Project details page 
• Envelopes work slightly different than in version 2 
• Transfer project feature 
• Record multiple audio tracks at a time. 
• Import MP3s, WAVs, OGGs or AIF files 
• Supports 24 bit, 192 kHz high resolution audio.



If you are upgrading from Mixcraft version 2, there are a few features that are different. 
Some of the features that you were used to in version 2 have slightly different interfaces.

Envelope Points On Sounds
In Mixcraft 2, you were able to add envelope points anywhere on a clip by simply clicking at that spot.  In v 2, you 
were able to drag an envelope line by dragging the line.  

In the latest version, when you move your mouse over the sound, you will now see the I-Beam cursor  which shows 
that you can make a partial selection of the sound.  You can now add points by clicking down on the envelope line.  If 
you want to add points anywhere on the sound, hold the Ctrl key and click down on the sound.  If you want to move an 

envelope line, hold down the Shift key and drag an envelope line (the cursor will turn into an up-down arrow ).

Add an envelope point anywhere: Hold down the Ctrl key and click.
Drag an envelope line: Hold down the Shift key and drag.
Delete an envelope point: Hold down the Alt key and click on a point.

More on shaping sound volume, pan and filters.

Recording
In Mixcraft 2, recording was limited to one track at a time.  In version 2, the new recording would be placed wherever 
the caret was.  In the latest version, you can 'arm' tracks and record multiple tracks at a time.  Each recording will be 
placed on its respectively armed track.   More on arming tracks in version 3.

Other Changes
The interface was dramatically changed.  The software supports low latency ASIO sound drivers.  You can now 
visually time stretch with FlexAudio™.  The latest version supports beat matching, tempo and key changes and will 
detect the beats in imported songs. 

Registration
Normally, Mixcraft has a trial period of 7 days (this may vary.)  After the trial period is over, you will need to purchase 
the software in order to burn audio CDs or mix down. 

Purchasing The Software
To purchase a registration code, click the "Buy Now!" item from the "Help" menu or the click the 'ying-yang' button on 
the toolbar. 

If you have Mixcraft LE (Light Edition), you do not need to purchase a registration code.  

Otherwise, click "Buy a code!" to launch the web browser with the purchase website.

Purchase Methods
Once on the website, you should find the following options available.

• Credit card. 
• Pay Pal - pay via the popular service Pay Pal. 
• Traditional postal mail - mail a money order or check.  
• Phone Order - Make a call to send payment. 
• Stores - Some brick & mortar stores sell Mixcraft.

The price of registration is about the cost of going out to dinner!  
(If you have Mixcraft LE, you do not need to purchase the software.)

Entering In Your Registration Information
Once you have purchased the software, you should receive instructions on completing the registration and entering in 

http://www.acoustica.com/mixcraft/buy.asp


your registration code. 

Type in or copy and paste your "Registration ID" (usually your email address)  in the Step 3 edit box and type in or 
copy and paste the 20 character "Registration Code" (excluding dashes) into the Step 4 edit box.  (Make sure to not 
enter in any extra spaces, as well.)

Thank You!
Your support and contribution will go towards unlimited use of Mixcraft.  Paying for a registration code helps our 
business and lets us continue to write great software! 

How To...
Basics
Manipulating Sounds
Hook Up A MIDI Keyboard
Choose A Virtual Instrument
Record
Customize Your Tracks
Use Loops
Trim Or Crop A Sound
Cross Fade Sounds
Burn A CD
Create An MP3

Medium
Use Selections
Add Volume And Pan Fades On Sounds
Boost Or Reduce Parts Of Sounds
Slow Down Or Speed Up A Song with FlexAudio™
Beat Match Songs

Advanced
Fix Songs With Drifting Tempos
Extract A Loop From A Song

How To Manipulate Sounds
So how do you playback sound?  You'll need to add some audio clips to your project.  

Add A Sound
There are several ways to add sound to your project.  You can load any sound on your computer or drag in sounds 
from the loop library.
In this example, we are going to add a sound from the loop library.

Click the Library tab.



Let's add the Reggae style drums.  On the category drop down, make sure that Song Kit is selected and then click on 
Reggae One Drop.  Click the + icon next to the Drums or drag the sound into the Sound Workspace area.  If the 
software asks you if you want to change the tempo of the project, click Yes.

We now have a sound in our project. 

Once a sound is in your project, you can do all kinds of edits to it, including looping, time stretching, pitch shifting, 
editing the volume and pan.

Learn more about editing and manipulating sounds here.

How To Hook Up A MIDI Keyboard To Use With Mixcraft
A MIDI keyboard or controller allows you to use your computer like a synthesizer.

If You Have a MIDI Keyboard Already:
If you have a MIDI keyboard, you will need a USB MIDI interface to connect to your computer.  USB MIDI interfaces 
will cost anywhere from $30 to $200.  Install the drivers for the USB MIDI interface and then hook up the MIDI 
interface to your computer.  It's also possible that the computer's sound card already has a MIDI port and, thus, you 
would not need an extra USB MIDI interface.

Connect a MIDI cable in the MIDI-Out of your keyboard to the MIDI-In of the MIDI Interface and you'll be ready to 
record.

If You Don't Have A MIDI Keyboard:
Your best option is to purchase a USB MIDI keyboard controller.  You can purchase them from around $70 to $1000, 
depending on quality, number of octaves, size and performance.  Once you have the USB MIDI keyboard controller, 
simply a USB cable from the MIDI keyboard to the computer and you'll be ready to record.

Alternatively, you can use the built in Musical Typing Keyboard (MTK).

What MIDI Channel Should You Use?
Mixcraft does not care what MIDI channel you are playing on your keyboard and will record on any MIDI channel by 
default.

How To Select A Virtual Instrument 
Mixcraft is designed to work with virtual instruments and synthesizers.  

To select a virtual instrument, simply create a Virtual Instrument Track by clicking Track, followed by clicking Insert  
Track, followed by clicking Virtual Instrument Track.



Click on the instrument icon:

This brings up the instrument dialog:

Select a category and a preset.

Close the window by clicking the [x] on the top right corner, if you'd like.  Make sure that the track is selected and then 
go to your MIDI keyboard and start playing!

More details on choosing a Virtual Instrument. 

How To Record Audio
You can record anything from your computer's microphone to your entire band with each member on its own track. It 
depends on the sound device or sound card hooked up to your computer.

Getting Ready To Record
Before you can record, you need to actually hook up your microphone, plug in guitar and make the necessary physical 
connections from your input sound device to the computer.   Consult your sound device's manual or browse the 
Internet for help with your sound device.

Arming Tracks
When you record in Mixcraft, you need to prepare, ready or arm a track.  Click the Arm button on a track or use the 
arm option on the track menu.  Once it's armed, the track is ready to record.

If you have a special sound device that allows multiple inputs, you'll need to make sure to arm the correct input.  For 
example, if you had a four channel input device and your guitar was on input 3, you'd need to make sure that you arm 
input 3, otherwise it might not record anything!  Click the arrow next to the arm button and choose the correct input.

Arm as many tracks as you can for true multitrack recording.



Recording Source
If you are in Wave mode or WaveRT mode and are recording from your sound card's CD, microphone or line-in, you'll 
need to select the correct recording source and recording level.  You can do this by clicking the Arm arrow, selecting 
your sound device, followed by clicking Stereo Source.  Choose the source that you'd like to record from.  Adjust the 
track's red recording level slider to an appropriate recording volume.

Start Recording
Now that you have the correct recording input and/or source selected, click the record button on the Master Bar and 
start playing your instrument.  If you have any existing audio in the project, the software will play that back 
simultaneously.  When you are finished, click the Stop button. 

How To Customize Your Tracks
You can edit the color, name, track image and size of your tracks.  Make them look personalized for organizational 
purposes or just for fun.

For example, if you are recording a pod cast, you can add an image of the person you are recording.  Or you can add 
images of each band member so that it's always clear which track they are on.

Change the color of your tracks for better organization. Some people assign all the bass parts to blue, drum parts to 
black and vocals to green, for example.  Go to the track section for more on changing a track's color.  Right click on a 
track to change it's color.

Save time and create a template.  If you are recording your band and have your external mixer or sound device on the 
same mics and line levels, you can set up the tracks, arm them appropriately and save your project as a template so 
that the next time you start a new song, you don't have to do any setup.

If you need to edit a sound's volume or pan, you can resize the track for more detail. 

How To Add Volume And Pan Fades On Sounds
Let's fade out a sound.  Normally, you could do this by dragging the envelope points around, adding new points and 
shaping the fade out manually.  However, there is a built in way to make a fade.

Make A Selection
Make a selection on the area of the sound you'd like to fade out.

Make A Fade
Now push Alt+2 to fade it out and it creates the following:

You can also create a fade out by clicking the Sound menu, followed by clicking Fade Out, followed by clicking Fast,  
Medium or Slow.  



Fading Pan, Low Pass or High Pass Filters
You can also fade in and fade out the other envelope types by choosing the correct envelope type on the toolbar and 
then using the fade in or fade out commands.  Choose from pan, low pass filter, low pass resonance, high pass filter 
and high pass resonance on the toolbar.

Keyboard Shortcuts
The keyboard shortcuts are designed so that you can use the mouse to make selections with one hand and with the 
hand use the keyboard to fade in or out.  Simply hold down the Alt key, make your selections and push either 1 or 2 
for either a fast fade in or fade out.

Here are the actual keystrokes that correspond to the fade types.

Alt+1 Fade in fast
Alt+2 Fade out fast
Alt+3 Fade in medium
Alt+4 Fade out medium
Alt+5 Fade in slow
Alt+6 Fade out slow 

How To Boost Or Reduce Parts Of Sounds
Let's say that you were doing a voice over a backing music track and you wanted to reduce the volume of the music 
when the voice over starts. Instead of manually adding and dragging points, you can use the Boost or Reduce feature.

Make a selection on the music track that corresponds to the time of the voice over.

Now click Ctrl+Alt+S four or five times and the volume will be reduced in the selected area (boost or reduce the sound 
until it sounds the way you want it).



Alternatively, you can reduce the volume for the selected area by clicking the Sound menu, followed by clicking 
Reduce, followed by clicking either -1%, -5%, -25% or -50%.  

Boost works in the opposite manner and raises the volume for selected areas.  

Boosting or Reducing Pan, Low Pass or High Pass Filters
You can also boost or reduce the other envelope types by choosing the correct envelope type on the toolbar and then 
using the boost or reduce commands.

Keyboard Shortcuts
The keyboard shortcuts are designed so that you can use the mouse to make selections and with the hand use the 
keyboard to boost or reduce.  Simply hold down the Alt and Ctrl key, make selections and push either W or S for 
either a 5% boost or a 5% reduction.

Here are the actual keystrokes that correspond to the boosts and reductions:

Alt+Ctrl+Q Boost 1%
Alt+Ctrl+A Reduce 1%
Alt+Ctrl+W Boost 5%
Alt+Ctrl+S Reduce 5%
Alt+Ctrl+E Boost 25%
Alt+Ctrl+D Reduce 25%
Alt+Ctrl+R Boost 50%
Alt+Ctrl+F Reduce 50% 

How To Beat Match Songs
Beat matching is a process of taking one or more songs and matching up their beats and adjusting their tempos so 
that the beats stay locked through the transition.  This example shows how to take two songs, beat match them and 
then increase the tempo from 107 bpm to 119 bpm during the transition.

We are going to mix Atomic Dog by George Clinton with Beds Are Burning by Midnight Oil.  We've loaded in Atomic 
Dog and the software has detected that the tempo is 107 bpm.  Click on the Sound Details Tab to look at the sound's 
detected tempo.



Next, we load in Beds Are Burning so that we now have two songs in our project.  Notice that the project's tempo is 
still 120 bpm.

We change the project's tempo to 107 by either going to the Project Details Tab or by right clicking the first marker 
and choosing Edit...  (we've highlighted the new tempo in red).

Zoom in on the transition and move the sound Beds Are Burning to start on the last major beat of Atomic Dog.

We don't want Beds Are Burning to play at 107 bpm because its normal tempo is at 119, so we add three tempo 
markers that ramp up the tempo during the transition.  Add a marker by double clicking the time line or right clicking 
the time line and selecting Add Marker...

That's it!  Add more songs, add more tempo markers and burn it to CD or mix it down. 

How To Fix Songs With Drifting Tempos
Most songs do not keep a constant tempo and it makes it very difficult to make a remix or mash-up.  So, what can you 
do about it?  With Mixcraft, you can dissect the song into multiple beat matched clips using a metronome.  Then you 
can mix down the modified song to a new WAV file.

Let's edit the song Not Ready To Make Nice by the Dixie Chicks to be at a constant tempo.  Its detected tempo was at 
83.243515 bpm, but as you can see from the Loop Editor on the Sound Details Tab, the sound's tempo drifts from 81 
bpm to 84 bpm.



Since the song starts at around 81 bpm, we adjust the song to 81 bpm initially.  Turn on the metronome and listen to 
the song.  When it is no longer in time with the metronome, you'll need to split and adjust.

In this case, the tempo speeds up in the middle of measure 19.  The actual beat (shown in red) should have lined up 
with measure 20.

If possible, pick a section of sound a measure or so before the obvious audio drift.  Make sure that snap is off on the 
Snap Settings so that you can make a precise split.  After the split, select the right hand side clip and adjust the tempo 
on the Sound Details tab.  

On the Loop Editor, you'll be able to see a dark gray area which shows that the left side of the sound has been 
trimmed by the split.  You can zoom in to the light gray side to visually determine the best tempo.

Proceed from the left to the right on the sound with the following process:

1. Listen to the song until the beats no longer sync with the metronome.
2. Split the active sound clip a measure or so before the drift is noticeable.
3. Assign a new tempo to the right most clip you just created from the split.
4. Repeat this process until you get to the end of the sound.

When you are done, you'll end up with a group of clips like this:

Mix it down to a new WAV file for future remixing!



How To Extract A Loop From A Song
You can extract a portion of any song and make it into a loop.  This loop can then be combined with other loops or 
beat matched songs.

If the song is in time with the metronome and is beat matched properly, you can extract a seamless loop. You may 
need to fix the song if the tempo is drifting.  Make sure that snap is on and aligned to the measure or bar.  

Select the measure or measures of audio on the sound and click Copy from the Edit menu (Ctrl+C).  Paste it on a new 
track by clicking Paste from the Edit menu (Ctrl+V).  Select the new click and then click Make Into A Loop from the 
Sound menu (or right click on the sound and select Make Into A Loop).  Loop the new sound as many times as you'd 
like! 

Mixcraft Reference
This is the main view of Mixcraft.  Click on an area for more information!

Project - Sounds - Tracks - Sound Workspace - Effects - Timeline
Details Area - Preferences - Master Bar - Menus & Toolbar - Keyboard Controls - Cursors

Other Important Features
Piano Roll
Notation View
Video
Automation
Musical Typing Keyboard 

Project
The project is everything in your mix, including the tracks, sounds, effects, markers and more.  Click on one of the 
following topics for more details.

New Project Dialog
Loading A Project



Save A Project
Save As MIDI File...
Project Templates
Copy Project Files To...
Burn Audio CD
Mix Down To Audio File
Mix Down To Video
Project Tempo, Key And Time Signature
Author Information
Metronome
Auto Beat Match
Recording Folder
Global Effects 

New Project Dialog
The New Project Dialog is displayed when you start a new project.  Choose between three types of projects or load an 
existing project or project template.

Record Yourself Or Your Band *
This option is best for making recordings from live instruments or your microphone.  Auto Beat Match is off by default 
and any loaded sounds will not be beat matched unless they are specifically a loop.  The time line view defaults to 
time mode.  Snap is off by default.

Build Loop & Beat Matched Music *
This option is great for DJs or just anyone constructing music with loops.  Auto Beat Match is on by default and any 
loaded sound will be beat matched.  This is a good choice if you are making a remix, a mash-up or a loop based 
song.  The time line view defaults to measure and beats mode.  Snap is set to one quarter note by default.

Build Virtual Instrument Tracks*
This option is great for anyone that wants to play and/or record from a MIDI keyboard or create music from scratch 
using the bundled virtual synthesizers.  Two Virtual Instrument Tracks and 4 normal audio tracks are created with this 
option.  The time line view defaults to measure and beats mode.

Load An Existing Project Or Template
Choose an previously loaded project, standard MIDI file or template from the drop down or click Browse and select a 
project file to load.

* Notes On Project Modes
The main difference between the three options are pretty simple.  If you start in one mode, you don't need to start 
over.  For example, if you want to auto beat match sounds, simply go to the Project Settings Tab and click the Auto 
Beat Match button to be on.  If you want snap on or off, click a new snap setting on the toolbar or by choosing Snap 
To Grid from the View menu and selecting a new snap setting. 

Loading A Project
Mixcraft can load Mixcraft project files (MX5, MX4, MX3) by clicking the File menu and choosing Open Project... 
(Ctrl+O).  Navigate to your project file, select it and click Open. 

Alternatively, you can click the Open Project button on the toolbar  or click Browse... on the New Project Dialog

The software can also load Mixcraft 2 project files (MXC) and Mixcraft Templates (MX5Template, and MX4Template 
files).

Loading A Standard MIDI File
Standard MIDI files contain MIDI data on multiple tracks and Mixcraft will import them.  When it creates a new track, it 
will use the default General MIDI synthesizer as set in the MIDI preferences. 



Save A Project
Save your work often.  You never know when the power might go off. :)

Choose Save or Save As...  from the File menu, navigate to a save folder, type in a name and click OK.

Your Mixcraft project will be saved as a Mixcraft project file (MX4).  You can also save it as a Project Template 
(MX4Template).

Alternatively, you can save the project by clicking the Save button on the toolbar.  

If you want to save your project as a single MP3, WAV, OGG or WMA file, you should mix down your project to an 
audio file.

If you want to export the MIDI in your project to a Standard MIDI file, choose Save As MIDI File... from the File menu.  
Alternatively, you can choose Save As... from the File menu and then click on the Type field and select MIDI File Type 
1.  (Note that this creates a type 1 standard MIDI file.)  Any audio tracks will be skipped, as they do not contain MIDI 
data. 

Save As MIDI File...
This option allows you to export MIDI data from Mixcraft into other tools such as notation software.  MIDI is found on 
Virtual Instrument Tracks.  When saving to a MIDI file, data on audio tracks will be skipped.

To save your project's Virtual Instrument Tracks as a MIDI file, click Save As MIDI File... from the File menu.  
Alternatively, you can choose Save As... and then select MIDI File Type 1 from the Type drop down control. 

Project Templates
A template is a special project that stores track names, track images, volume settings, armed states and other track 
settings.  You can load a template so that you don't have to set up your tracks each time you start a new project.

Mixcraft project templates are stored as .mx5template files.

To save a project template, choose the File menu followed by Save As...  On the Save Your Mix window, click the 
Save as type drop down and select Mixcraft Template.  Type in a name and pick a folder and click Save.

When you load a template and then click Save, the software will ask you to save it as a MX5 project and will not save 
over the original template. 

Copy Project Files To...
You can copy your project and all the sounds, videos and/or recordings used in your project to a single folder or zip 
file.  This is handy for organizing your projects and backing them up! In many cases, you use sounds from various 
folders on your computer.

To copy your project and its sounds, make sure to save it and then click the File menu followed by clicking Copy 
Project Files  To...  followed by clicking Folder or Zip File.

Copy To A Folder
Pick a folder to copy your project and sounds to and click OK.

Copy To A Zip File
Pick a name of the zip file to create and all project files will be automatically zipped and added to the compressed zip 
file.  Audio does not necessarily compress well, but this is a great feature for quickly creating a single file that can be 



emailed or posted to a website.

Tips
Choose a folder that does not have any other sounds or audio in it.  In this way, you know exactly which sounds are in 
the project.

If you are copying a newer version of project to a folder, make sure to clear or clean the folder of all audio files and 
project files before transferring.  Otherwise, you may end up with duplicate sounds.  (The reason duplicates might 
occur is because  files in a project can have the same file name and may conflict with each other when moved to a 
single folder.)

If a sound that is in the project is already in the destination folder, it just skips it, making it easy to update a project that 
is already in the destination folder.

Backing Up Your Project And Sounds To CD or DVD Using Windows
You can burn the project and associated files to a blank CD or DVD by using the Copy Project Files To... feature and 
then burning the contents of that folder in your file burning software.  

If you have a DLA (Drive Letter Access) burning solution, make sure to format the CD first and then you should be 
able to transfer directly to a blank CDR.  (Select the CD/DVD Recorder when choosing a folder to transfer to.)

Otherwise, you can put in a blank CD or DVD and then drag the files on to the CD recorder in My Computer.  Then 
right click on the CD/DVD burner and choose Write These Files To CD.

Your digital master is now safe and sound on Disc.  Put it in a bank's safety deposit box or some other safe place.  

Burn Audio CD

  To burn an audio CD, click the Burn CD icon on the toolbar.  Alternatively, click on the File menu followed by 
clicking Burn CD... (Ctrl+B). 

** Note - the Burn Audio CD feature is not available in Mixcraft LE (Light Edition).

Burning A CD
Insert a blank CD and click the Start Burn button to burn a CD.  After burning an audio CD, the software will ask if 
you'd like to make a label with the optional Acoustica CD/DVD Label Maker. 

If you have trouble burning a CD, go to the troubleshooting section.

This is what the cd burning window looks like. 

The options on this screen are described below.

Writer
Select a CD writer if you have more than one CD writer in your computer.

http://www.acoustica.com/cd-label-maker/


Speed
Choose a CD writing speed.  In some cases, burning at a slower speed may improve the success rate of burning and 
may be more compatible in some older CD players.  If you have a CD writer with Burn Proof type protection, you can 
burn at maximum speed without worrying about a burn failure.

Test Mode
In this mode, the CD writer will not turn its laser on for writing and will go through the process of transferring the data 
to CD.  If you are having problems burning a CD, go to our troubleshooting area.  This allows you to see if your 
computer can send data to the CD writer at the desired speed.

Convert To WAV First
This will convert the mix to one or more WAV files on your hard drive.  CD quality WAV files use up around 8 MB for 
every audio minute that you are burning.  Therefore, a 74 minute mix will take up around 650 MB or hard drive space.  
The advantage to converting to WAV first is that it may help the success rate of burns for some older CD recorders, 
especially if your CD writer does not have Burn Proof.

Create CD-TEXT
Some CD writers support CD-TEXT.  If your CD writer supports CD-TEXT, you should be able to check the CD-TEXT 
box to burn CD-TEXT.  When you burn CD-TEXT, the software adds text to each CD track so that when you play the 
CD on a CD player that *supports* CD-TEXT, you can see the titles and names of each track.  Usually, Sony CD 
players support CD-TEXT.  

You can type in a CD-TEXT title for the CD's title.  Track names will be derived from CD track markers.

Burn As One Track
This option essentially skips any CD track markers in the project and burns the whole project as one track.  If your 
burner is only supported in IMAPI mode this is a good option for a seamless mix because IMAPI mode will always put 
a two second gap between tracks.  (The main drawback is that you can't seek to a specific track in the CD player.)

Burn All Or Selection
Choose Burn All to burn up to 80 minutes of audio, depending on the capacity of your blank CD.
Choose Burn Selection to burn the current selection of audio.  This can be useful if your mix goes beyond 74 or 80 
minutes and you want to burn the extended sections.  (Note that it simply uses the selected area to define a time 
range to burn.)

Back Up Your Project To CD 

Mix Down To Audio File
Mix down your project to one of the following audio file types: MP3, WAV, WMA or OGG. 

** Note - the MP3 format is not available in Mixcraft LE (Light Edition).

  Click the Mix Down button on the toolbar or select Mix Down from the File menu, followed by selecting the 
format you'd like to mix down to.  Alternatively, you can choose Save As.. from the File menu and then click the Save 
as type drop down control to select the desired format.

Once you are viewing the Save Your Mix window with the correct format, you have the following extra options and 
details



Format Details
This shows the current format details such as bit rate and channels.  Click Edit Details... to change the format details 
for the current format.  A window will pop up and allow you to change the bit rate, channels and other options.

Estimated Size
This shows the approximate size of the mix down in Megabytes (MB).

Create A New File For Each CD Marker
If you've added CD markers to your project, this will cause the mix down to create multiple files for each CD marker it 
encounters.

Use Marker Titles
If you've chosen to Create A New File For Each CD Marker, this option will use the titles in the marker for the name of 
the file and the tag.

Use File/Tag Information
Click this option if you want the audio file(s) to be tagged with the project's author information and CD track names (if 
set).  Click Tag Info... to edit the project's author information.

Use Selection
If you've made a selection, you have the option of just mixing down the audio in the time range of the selection. 

Mix Down To Video
If your project contains video, you can mix down to a new video.  Mixcraft supports mixing down to AVI and WMV 
formats.

Learn more about video in Mixcraft here.

To mix down your video to an AVI or WMV, select the "File" menu followed by clicking "Mix Down To..." followed by 
clicking either "AVI" or "WMA".  Choose a folder, type in a name and click "Save".

If you are saving to WMV, you will have the option of editing the format details by clicking "Edit Details...".  More on 
saving video... 

Project Tempo, Key And Time Signature
Choose a master or project tempo, key and time signature on the Project Details Tab.  Alternatively, you can edit the 
first marker on the time line.

Project Tempo *
All sounds that have a tempo and are set to Adjust To Project Tempo mode will adjust based on the project's tempo.  
For example, if a sound has a tempo of 200 bpm and the project has a tempo of 100 bpm, the sound will playback two 
times as fast and be 1/2 the normal duration.  In addition to affecting any tempo adjusted sounds, the project tempo 
also determines the Metronome's speed and frequency.  

Project Key *
All sounds that have a key and are set to Adjust To Project Key mode will adjust based on the project's key.  For 
example, if a sound has a key of A and the project's key is B, the sound will playback two semitones or half steps 
higher than normal in order to be in tune with the key of B.

Project Time Signature *
The time signature affects the software's snap behavior if the snap is set to Snap To Measure or Snap Bar.  For 
example, if the time signature is 3/4 and the software is snapping to the measure, it would mean that the software is 
snapping every three beats, instead of four beats for 4/4 time.  As expected, the metronome plays based on the 
current time signature.  



The numerator of the time signature indicates the number of beats per measure and the denominator indicates what 
type of note receives a beat.

* Keep in mind that this setting only affects the time period from the first marker to the second and is really just a 
shortcut or convenient interface to access the first marker's settings. 

Author Information
Click on the Author Info... button on the Project Details Tab to edit the tag or information about this project.

This information is saved with all projects and also is saved in the textual tag information when mixing down to audio 
files, such as MP3 files.

• Title 
• Author 
• Album 
• Genre 
• Year 
• Copyright 
• Comments 

Metronome
The metronome helps to keep time and will play a sound on each measure and beat.  To turn the metronome on or 
off, go to the Project Details Tab and toggle the Metronome button.  Alternatively, you can click the Mix menu followed 
by clicking Metronome (a checked state indicates that it is on).  The easiest way to toggle the state of the metronome 
is to click the metronome icon on the Master Bar.

Customizing The Metronome
You can customize the metronome's sounds and volume level by going into the Preferences and choosing the 
Metronome page. 

Play Every X Beats
By editing a marker, you can also instruct the metronome to play every Nth beat (it defaults to playing every beat).

Count In
You can set up the metronome to count in for a specific number of measures before playback or recording.   You can 
toggle the Count In feature on or off via Preferences or via the button on the Master Bar.  When Count-In is activated 
and the Record button is pressed, Mixcraft will "pre-roll" or play the audio for the selected number of measures prior to 
starting recording.  For example, if your recording Count-In is configured to count in for two measures, Mixcraft will 
play two measures worth of the metronome sound, as well as two measures worth of the project's audio, before 
recording begins.

Alternatively, you can click the Mix menu followed by clicking Recording Count-In to turn on the count in.

You can configure the number of measures to count in via the Preferences. 

Auto Beat Match
Auto Beat Match is a mode that analyzes all sounds for tempo, beat and key data.  It attempts to detect the beats in 
any supported audio file.   The drawback to automatic beat match mode is that it takes longer to detect tempos and 
key information (initial loads are two times longer although, subsequent loads will be cached and load faster).



If you click the Auto Beat Match button on the Project Details Tab after loading in some songs or sounds, it will detect 
the tempos and keys of loaded sounds and adjust them to match the project tempo.

Alternatively, you can toggle Auto Beat Match mode by choosing Automatically Beat Match New Sounds from the Mix 
menu.

For tips on beat matching, see How To Beat Match Songs or How To Fix Songs With Drifting Tempos. 

Recording Folder
Each project has its own recording folder which defaults to the Default Project Recording Folder in the Preferences 
under the Recording area.  You can change the recording folder for each project for better organization. 

All new recorded sounds will be placed in this folder.  

Click Change... on the Project Details Tab to set a new recording folder. 

Global/Master Effects
The global or master effects are effects that are applied to all the audio tracks after the track effects have been 
applied.  Usually, you should choose mastering effects such as EQ or reverb.  

The global effects can be accessed by clicking the Effects button above the tracks and below the toolbar.

The global effects are also located on the Project Details tab.  

You can automate the global or master effects on the Master Track. 

Click Here For Manipulating Global Effects or Track Effects 

Project Details
Click the Project tab on the bottom of the screen to bring up the Project Details.

Click on an area for more information.

Project Tempo, Key And Time Signature
Author Information
Metronome
Auto Beat Match
Recording Folder
Global Effects 

Sounds 
Sounds can be moved, trimmed, looped, resized, time stretched and more. In Mixcraft, there are two types of sounds: 



Audio Clips

Virtual Instrument Clips

Audio Clips
Adding...
Recording
Cross Fading
Edit In An External Editor
Loop Editor
Setting the Snap Point
Setting A Sound's Active Channel
Noise Reduction

Virtual Instrument Clips
Adding...
Recording
Editing

Many operations and features are common to both types of clips.

General Sound Manipulation
Moving Sounds
Trimming Sounds
Looping Sounds
Splitting Sounds
Removing Spaces Between Clips
Deleting Sounds
Copy And Paste
Merge Clips
Adjusting Volume
Adjusting Pan
Editing Low And High Pass Filters
Time Stretching Sounds (FlexAudio™)
Adjusting Tempo
Pitch Shifting Sounds
Adjusting Key
Renaming A Sound
Locking Sounds
Linking / Unlinking Clips
Muting Sounds
Adding Effects To Sounds
Sound Details And Properties

Audio Clips
An audio clip is an audio recording.

Audio clips can be added or recorded.  You can add MP3, OGG, WMA, WAV or AIF files to Mixcraft.  Recordings are 



WAV or OGG files that are stored in your project's recording folder.

Adding Audio Clips
Recording Audio Clips
Moving Sounds
Trimming Sounds
Looping Sounds
Splitting Sounds
Removing Spaces Between Clips
Deleting Sounds
Copy And Paste
Merge Clips
Setting A Sound's Active Channel
Adjusting Volume
Adjusting Pan
Editing Low And High Pass Filters
Time Stretching Sounds (FlexAudio™)
Adjusting Tempo
Pitch Shifting Sounds
Adjusting Key
Renaming A Sound
Locking Sounds
Linking Sounds
Muting Sounds
Adding Effects To Sounds
Sound Details And Properties
Noise Reduction
Cross Fading
Edit In An External Editor
Loop Editor
Setting the Snap Point 

Adding Audio Clips
There are several ways to add audio clips to the project.

Click Add Sound File.. From The Mix menu.
Navigate to a folder with the sound, select it and click Open.  The sound will be placed where the caret was.  
Alternatively, you can click the Add Sound File... option on the Sound menu (Ctrl+H) or click the Add Sound  .   button on 
the toolbar.

Double Click The Sound Workspace Area
When you double click the sound workspace, you set the caret and simultaneously bring up a window letting you 
choose a sound.  The sound will be placed where the caret was.

Add A Sound From The Loop Library
Click the Library Tab on the bottom of the Mixcraft window or click the Show Loop Library button on the toolbar. Select 
a sound from the library, position the caret where you'd like the sound to go and then click the + button next to the 
sound.  Alternatively, you can drag the sound from the library directly into the sound workspace.

Drag A Sound In From Window's File Explorer
Open a Window's File Explorer window and navigate to the sound or sounds that you want to add.  Select the 
sound(s) in the File Explorer and drag them into the sound workspace.

Sound Analysis During Loading
When a sound is loaded, the software parses it for peaks in order to display the wave form.  If Auto Beat Matching is 
on, the software also parses for tempo, beats and key (for sounds over 30 seconds).  If the software detects a tempo 
or key, it may adjust the snap point to the first beat and alter the sound based on the project key and tempo.

For more on adding sounds, see How To Manipulate Sounds. 



Recording Audio Clips
Recordings are placed on armed tracks.  When a track is armed, it means that it is ready for recording.  Just click the 
Arm button on a track to prepare for recording.  

After clicking the armed button, it should turn red signifying that it is ready for recording.

You should see a level or signal coming in on the track, as shown below.  

If you don't see a level or it's not a very strong level, go to the Track   section   for more on arming tracks and 
setting the correct recording source.

Sounds will be recorded at a default CD quality.  The recording sound quality can be changed in the Sound Device 
Preferences by clicking Preferences from the File menu and clicking on Sound Device.

  When you are ready to record, click the record button on the master bar.

The software will start recording and the new sound will be displayed in red.

You can use a recording timer to limit the amount of recording, especially if Mixcraft is running unattended.

For more details on recording, punch in recording, click here.

Recording Directly To OGG
If you find your hard drive filling up with huge WAV files, you can record directly to OGG files.  Recording to OGG will 
take up less space on your hard drive.  Go to the Recording Preferences, click Compressed Ogg Vorbis (.OGG) and 
then choose the desired quality.  All new recordings will be in the compressed OGG format.

Recording Timer
You can set a recording timer to automatically record for a specific amount of time and then stop automatically.

To turn on the recording timer, select Use Recording Timer from the Mix menu.  Enter in a number of minutes to 
record.  (If you only want to record 30 seconds, enter 0.5)

To turn off the recording timer, click Use Recording Timer from the Mix menu so that it is no longer checked.

See more on recording here. 



Loop Editor
The loop editor lets you adjust the loop points of any audio clip.  It is located on the Sound Details Tab.

Adjusting A Loop
The looping and audible part of a sound is displayed in gray.  The unused parts of the sound are shown in green.  (If 
the sound is trimmed in the sound workspace and it is not looping, the software will show the trimmed area in dark 
gray.)

   -    
Move the Start marker to adjust the start of the loop and the End marker to adjust the end.  Alternatively, you can right 
click on the loop editor window and choose Set As Loop Start or Set As Loop End to set a loop point.

 Push the Play button to preview how your loop will sound. 

Showing Detected Beats

 If you are not seeing the detected beat points, click the Show Detected Beats button.  This will show the beats in 
the sound.  Each beat point has tempo.  The software will not show all the beat points depending on your zoom level.  
Zoom in to see more detail and beat points.  Hover your mouse over a beat point and the tool tip will show you the 
detected tempo at that time.

Zooming
You can click the Zoom In or Zoom Out buttons to the left of the loop editor.  Alternatively, you can zoom in or out with 
the mouse wheel.

Making The Perfect Loop Tip
If the Loop Editor is displaying beat points and you drag one of the loop markers over a beat point, it will snap to the 
beat point to make a very precise loop. 

Setting The Snap Point
The Snap Point is the offset in a sound that is used with the Snap Settings ( by default, the Snap Point is at time 0).  
For example, if you had a sound with a long introduction and you wanted the sound to snap to that first beat, you 
could move the snap point to the first beat.  Alternatively, you can right click on the loop editor wave form and choose 
Set As Snap Point to set the Snap Point. More on the setting the Snap Point.

Resetting Your Loop And Snap Point
To start over and reset your loop, simply right click on the loop editor window and choose Reset Loop And Snap. 

Cross Fading Audio Clips
Cross fading is extremely easy in Mixcraft.  Just drag one sound over another sound and you have an instant cross 
fade where one sound fades seamlessly into the next!

The cross fade looks like a cross hatched area. The red line shows the cross fade area in this example. 



Edit In An External Editor
The software will work in conjunction with an external sound editor in order to apply permanent changes or edits to the 
sound.  For example, if you want to reverse a sound or edit out clicks and pop or some other audio editing, you may 
want to use an external editor.  (This requires that you own or have downloaded a sound editor.)

Configure An External Sound Editor
Go to the preferences and choose the General tab to select an external sound editor to use.

How To Edit A Sound In An External Editor
Right click on a sound and choose Edit In External Editor or choose Edit In External Editor from the Sound menu.  
You will have the option of editing the original sound or a copy.  If you edit the original sound, the change will be a 
permanent and will not be undo-able.  

Setting the Snap Point
The snap point is the position in the sound that is snapped or aligned.  The snap point defaults to the start of the 
sound.  The snap point only matters if you have snap on.

When a sound is analyzed for beats, the snap point will be positioned at the first detected beat.  You can adjust the 
snap point's offset in the Loop Editor. 

Virtual Instrument Clips
A Virtual Instrument Clip is made up of MIDI data and instructs a synthesizer what to play.  Virtual instrument clips do 
not contain the actual audio data and can be edited in more detail. 

Each line inside the clip represents a note.

Adding...
Recording
Editing
Moving Sounds
Trimming Sounds
Looping Sounds
Splitting Sounds
Removing Spaces Between Clips
Deleting Sounds
Copy And Paste
Merge Clips
Adjusting Volume
Adjusting Pan
Editing Low And High Pass Filters
Time Stretching Sounds (FlexAudio™)
Adjusting Tempo
Pitch Shifting Sounds
Adjusting Key
Renaming A Sound
Locking Sounds
Muting Sounds
Adding Effects To Sounds
Sound Details And Properties
Printing Notation 



Adding Virtual Instrument Clips
You can add Virtual Instrument Clips in several ways.

Create a blank Virtual Instrument Clip.
Double click a Virtual Instrument Track or right click on a Virtual Instrument Track and click Add Instrument Clip to 
create a blank Virtual Instrument Clip. 

Record a Virtual Instrument Clip.
Arm a Virtual Instrument Track and record.  Use your MIDI keyboard to playback notes and click Stop on the Master 
Bar when you are finished.

Import a MIDI file.
You can right click on a Virtual Instrument Track and select Add Sound File...  Select a MIDI file (.MID) and click 
Open.  (Please note that if the MIDI file has more than one track, each track will be loaded on to a separate track and 
new tracks may be created if necessary.)  You may be able to download or purchase MIDI files that contain popular 
beats and rhythms. 

Recording Virtual Instrument Clips
Recordings are placed on armed tracks.  When a track is armed, it means that it is ready for recording.  Just click the 
Arm button on a track to prepare for recording.  

After clicking the armed button, it should turn red signifying that it is ready for recording.

You should see a level or signal coming in on the track, as shown below.  

  When you are ready to record, click the record button on the master bar.

The software will start recording and the new Virtual Instrument Clip will be displayed in red.

In addition to recording, if there are any other sounds in the project, the software will start playing back the project 
simultaneously.

You can use a recording timer to limit the amount of recording, especially if Mixcraft is running unattended.

For more details on recording, punch in recording, click here. 

Editing Virtual Instrument Clips
You can view any Virtual Instrument Clip in either the Piano Roll Editor or the Notation View Editor.

Click on a sound clip and then click on the Sound Details tab.



Switching to the Piano Roll Editor
To switch to the Piano Roll Editor, click the Piano Roll View button on the Sound Details.

Switching To Notation View
To switch to the notation view, click the notation view button on the Sound Details.

 

Piano Roll Editor
The piano roll editor allows you to edit the MIDI data for a Virtual Instrument Clip.  Just double click a Virtual 
Instrument Clip or right click on a Virtual Instrument Clip and select Edit to bring up the Piano Roll Editor.  (The Piano 
Roll Editor is located on the Sound Details area when a Virtual Instrument Clip is selected.)  You can also edit and 
view Virtual Instrument Clips in the Notation View Editor.

Each blue box represents a note.  The note is determined by how it lines up with the vertical piano, hence, the name 
'piano roll'.  Click on a piano note to audition how it will sound.

Switching to the Piano Roll Editor
To switch to the Piano Roll Editor, click the Piano Roll View button on the Sound details.

Piano Roll Buttons And Controls

Selecting Notes
Click on a note to select it.  Alternatively, select the Arrow tool and drag a selection.  All notes that fall within the 
selection rectangle will become selected.  Hold down the Shift or Control key to multi-select notes.  

Double click a note on the piano roll keyboard and all notes of that value will become selected.  
Click anywhere besides a note to deselect it or press the Esc key.

Selected notes will appear black.

Moving Notes
Select a note and drag it.  You can be in either arrow or pencil mode.



(Before moving.)

Move the note or notes by dragging up, down, left or right.  The piano roll will auto scroll if you go beyond the extents 
of the window.  Movement will be aligned based on the Piano Roll's snap level.

(After moving.)

Editing Notes
Move your mouse to the left or right side until it turns to a left-right arrow cursor.  You can resize a note by drag and 
drop.  Resizing will be aligned based on the Piano Roll's snap level.

(Before resizing.)

(After resizing.)

You can also edit a note or group of notes by right clicking and selecting "Edit..."  The note edit dialog will pop up and 
allow you to edit the specifics, which include:

• Start time (Measure, beat and fractional beat) 
• Duration (Measures, beats and fractional beats) 
• Note value (A0-G10) 
• Velocity ON (1-127) 
• MIDI Channel (1-16) 
• Velocity OFF ( 0-127)

Quantizing Notes
You can quantize a note or a group of selected notes by clicking the Quantize... button. 
More on quantizing notes...

Snapping In The Piano Roll
The piano roll has its own snap level which allows you to edit and move notes to exact measure and beat positions.  If 
you find that you cannot move or resize a note, try turning off the piano roll snap.  Click on the snap button and select 
a new snap setting.

Editing Controller Information
You can edit controller information in the controller area in the lower portion of the piano roll.



Copy, Cut, Paste And Clipboard Operations
You can select a group of notes to copy, cut or paste in the expected manner.  You can use the keyboard shortcuts or 
simply right click on the Piano Roll Editor and select the appropriate operation.  Once you copy or cut some notes or 
partial notes, the notes reside in the clipboard.  You can paste them at the position of the playback indicator.  
Alternatively, you can select notes and paste them to a new clip on track by clicking on a track, positioning the caret in 
the desired location and then pasting.

More on editing and viewing controller information... 

Quantizing Notes
Quantization is the process of aligning a set of musical notes to a precise setting.  This results in notes being set on 
beats and on exact fractions of beats.

Click the Quantize... button on the Piano Roll Editor to quantize the notes.

Quantize All or Selection
Choose whether to quantize the selected notes or all the notes in the current virtual instrument clip.

You can quantize the start of the note(s) and/or the duration(s).  After making your choice, click OK to quantize the 
note(s).

Quantizing Note Start
Click the checkbox next to Quantize Note Start and then choose a setting.  The software will move all notes to the 
closest beat or partial beat, based on the selection.  In addition, you have the option of choosing a swing setting.  If 
you want to quantize with swing, click Swing Amount.  Swing will offset every note that is on an odd beat or odd partial 
beat, depending on the quantize note start setting.  

For example, if you had a recording of eighth notes and set your Quantize Note Start to be eighth notes and then set 
your swing to 30%, you would end up with a rhythm where every other eighth note is offset by 30% to the next eighth 
note.

This shows the eighth notes before the swing quantization:

We then quantize to eighth notes with a 35% swing.



Quantizing Note Length
Click the checkbox next Quantize Note Length and then choose a setting.  The software will align the end of the note 
to the closest beat or partial beat, based on the selection.  

Please note that if you have this set to eighth note and you are actually quantizing a whole note, it will not adjust the 
length of the note to an eighth note, but rather align it to the closest eighth note!

Piano Roll Buttons And Controls
These are the tools and controls for the Piano Roll Editor.

Tools

There are three tools on the piano roll editor. 

Arrow: A selection tool.  
Pencil: Add new notes with the pencil.
Eraser: Remove notes with the eraser.

Duration Buttons

Choose a default duration when adding a new note with the pencil tool.  Choose from whole note, half note, quarter 
note, eighth note, sixteenth note and thirty-secondth note.  In addition, you can choose from the two modifiers: Dotted 
Note Modifier and Triplet Note Modifier.  For example, if you had eighth notes chosen and then added the Triplet Note 
Modifier, the pencil would create eighth triplet notes.

Default Velocity

Snap Level

Quantizing Notes

Controller Area
The controller area is on the lower portion of the window.  You can resize the controller area by clicking on the gray 
bar and dragging it.  Choose a controller type by selecting the controller drop down below the piano roll keyboard.

More on editing and viewing controller information. 

Controller Information
You can edit MIDI controller data on the bottom portion of the Piano Roll Editor on the Sound Details tab.



Choose The Controller Type
Click the drop down on the left hand side to pick a specific controller.  Alternatively, you can type in a controller 
number from 0 to 127.  You can choose from the following controller types:

• Velocity (Special 'controller' that is linked to notes in the piano roll.) 
• Velocity (Special 'controller' that is linked to notes in the piano roll.) 
• Program Change 
• Channel Pressure 
• Pitch Wheel 
• Modulation

If the clip has controller information for a specific controller, the controller will appear in bold in the drop down list.

Editing Controller Data
There are two modes in the controller window: Drawing and Erasing.
Select the eraser button to erase controller data and select either the arrow or pencil tool to draw controller data.

In this example, we are going to modify the velocity of the notes so that it ramps up.  Here is the way it looks initially.  
Each line represents the velocity of the note in the piano roll above.

Now we click down and drag the mouse to draw the following shape.  The dark blue represents the area we have 
drawn.

When we are satisfied, we release the mouse and we end up with the following ascending velocities.



If you need more room or pixels to edit the controller data, simply click on the bar at the top of the controller area and 
drag it up or down to resize the controller area.

Precise Editing Of Controller Information
Sometimes you may want to edit a controller to a specific value, but it is too difficult to move your mouse to the exact 
pixel on the screen.  For all controllers, besides Velocity, you can right click to add, edit or delete controller 
information.

For example, if you want an external synthesizer to switch to patch 67, choose the "Program Change" controller, move 
to the start of the track, right click and select "Add Controller" from the menu.  A dialog box will pop up and allow you 
to type in 67. Click OK and you will now have a program change #67.

The options that will appear on the right click menu are:
• Add Controller 
• Edit Controller 
• Delete Controller 
• Delete All Controllers

Setting Virtual Instrument Clip Loop Points
You can make a Virtual Instrument clip loop.  In the Piano Roll Editor, you can adjust the start and end loop points.  To 
move a loop point, simply click on the word Start or End and drag it.

For example, we'd like to make a loop from measure 2 to measure 3.  Here is what we started with:

In this example, we drag the End loop point to measure 3 and then drag the Start loop point to measure 2 like this:



Once you are satisfied with the loop, you can extend the clip in the session area to loop it as many times as you'd 
like.  See Looping Sounds. 

M.I.D.I. Primer
M.I.D.I. stands for Musical Instrument Digital Interface.  It is simply a series of messages that keyboards and 
synthesizers use to play notes or change the sound of a synthesizer.  A Virtual Instrument Track in Mixcraft contains 
Virtual Instrument Clips, which contain MIDI data.

MIDI Notes
When you play the middle C key on a music keyboard, it sends a short message that translates to 'play middle C'.  
When you let go of the key, a message is sent that translate to 'stop playing middle c'.  In addition, the message 
contains other information, such as the MIDI channel and key velocity.  There are 16 MIDI channels which allow you 
to route MIDI messages.  The key velocity is a number from 1 to 127 which describes how fast the key was 
depressed.  A velocity of 1 would hardly be heard and a velocity of 127 would be full volume.

Each MIDI Note message contains the following information:  Note Value (C0 - C10), Key Velocity (1-127), MIDI 
Channel (1-16)

Note Value
This is the value of the note.  There are 128 possible MIDI notes.  Note 0 corresponds to 'C0', where 'C' means the 
note C and '0' means octave 0. Note 127 corresponds to G10.  A normal eight octave MIDI piano keyboard has a 
range from A1 to C9.

Key Velocity
This is how fast the key was pressed.  Faster velocities usually corresponds to louder sounds or may trigger extra 
sounds, depending on the synthesizer.

MIDI Channel
This is the channel that the note is on.  MIDI channels allow you to route specific channels to specific synthesizers 
and/or tracks.

MIDI Controllers
A controller is another type of MIDI message that controls other parameters.  The most commonly used controllers are 
Modulation and Pitch Wheel.  A standard MIDI piano keyboard has two wheels that correspond to modulation and 
pitch wheel (pitch bend).

Modulation
This is also known as vibrato and will usually cause the pitch to oscillate around the note.  However, it depends on the 
synthesizer being used.  Modulation has a value of 0 to 127 (127 is the most extreme modulation).

Pitch Wheel (Pitch Bend)
This controller usually bends the pitch up or down a half step in pitch.  However, it depends on the synthesizer being 
used.  Pitch wheel or pitch bend has a value from -8191 to 8192.

Other Controllers



There are other controllers that are useful for various synthesizers.  

Learn more about MIDI on Wikipedia 

Notation View Editor
Mixcraft allows you to edit, view and print your music in notation or sheet music form.  You can also view and edit your 
Virtual Instrument Clips in the Piano Roll Editor.

Switching To Notation View
To switch to the notation view, click the notation view button on the Sound Details.

Notation View Is Based On Virtual Instrument Clips
The notation view shows one clip at a time.  Importantly, the key signature and time signature are from the key and 
signature of the clip (not the project).  If you have several clips on a track and want to print them out, the 
recommendation is to merge all clips on the track into one clip and then print that clip.

Horizontal Zoom
Zoom in and out using the horizontal zoom buttons found just below the green play icon.  This changes how closely 
the notes are spaced together.  This is useful for editing smaller notes.

Vertical Zoom
Change the size of the notation for easier viewing or editing.  The vertical zoom buttons are located below the 
horizontal zoom buttons.

Editing
Mixcraft allows you to edit a piano bar on the staff directly.  By editing the size and position of the piano bar, you can 
change the way the notation is displayed.

Here is a typical example of a quarter note with its associated piano bar. 

After clicking on the piano bar, it turns blue.  

http://en.wikipedia.org/wiki/MIDI


You can now click the note to move it or resize the left or right hand side of the note to change its duration or starting 
time.  After releasing the mouse, the notation will update to reflect the new piano bar.

Tidy Notes
Tidy Notes attempts to present a cleaner representation of the note data.  A performance does not always equal the 
printed sheet music. 

For example, if you played a quarter note but shortened the note by a 32nd note duration, then the software would 
show a dotted 8th note tied to a 32nd note with a 32nd rest.   This would look like the following.

To remedy this situation, simply set the Tidy Note level to an 8th note or less.

After changing the Tidy Note level, the note will now look like a quarter note.

The draw back is that if you have some 16th notes, they will now appear as 8th notes.  Of course, you can always set 
the Tidy Note level to 16th notes and then edit any piano bars that are not correct.

Printing
When you've selected a Virtual Instrument Clip, just make sure that you are viewing the notation view by clicking the 
notation switch button:

Once a clip is properly selected, click the Print... button on the Notation View toolbar or press Ctrl+P to print it.  If you 
want to print an author and title, make sure to edit the Author Information. 

Notation Tools

 Click the arrow to move, select and edit piano bars.

 Click the pencil to add new piano bars, move, select or edit existing piano bars.

 Click the eraser to erase piano bars or notes.

 Click the flat tool to lower notes by a semitone or half step.

 Click the sharp tool to raise notes by a semitone or half step.



Moving Sounds
To move a sound, select its title bar and drag while holding down the mouse button..  

(The title bar is the top area of the sound where the name is displayed.)

BEFORE MOVE

AFTER MOVE

You can also move a sound by using the keyboard.  Select a sound or group of sounds and then use the arrow keys 
to move the sounds.  By holding down the Ctrl and Shift key, you can move the sound(s) in different increments.

The sound(s) will move based on the snap settings (if you cannot move a sound to a specific location it is probably 
because snap is on and you need to turn it off).

Keyboard Modifiers
Hold down the Ctrl key and use the left/right arrow keys to move a sound by +/- 20 milliseconds
Hold down the Ctrl and the Shift key and use the left/right arrow keys to move a sound by +/- one millisecond.

Setting Exact Position
You can set a sound's exact offset or position by clicking on the Sound Details Tab and editing the Offset's minutes, 
seconds and milliseconds edit boxes directly. 

Trimming Sounds
You can trim the start and end of any sound.  Just move the mouse to the right or left edge of a sound.  The cursor will 
change into a left-right resize arrow .  Hold the mouse down and drag to resize or trim.  (Resizing can also lead to 
looping.)

Drag to the left or right to get the desired trim.  Zoom in or use the snap setting to trim with better precision.



You can trim the left or right edge of any sound.  The sound will trim based on the snap settings.  If you cannot trim a 
sound to a specific length it is probably because snap is on and you need to turn it off.

Trim Silence
You can automatically trim the silence from the start and end of sounds by selecting them and then clicking Trim 
Silence from the Sound menu.  (This is currently only available for Audio Clips.)

Setting Exact Length
You can set a sound's exact length by clicking on the Sound Detail Tab and editing the minutes, seconds and 
milliseconds via edit boxes.

Looping Sounds
You can loop any sound by dragging.  Move the mouse to the left or right edge until the cursor turns into a left right 
resize cursor .

Simply click on the left or right edge of the sound, hold the mouse down and drag left or right.  In the example below, 
the user drags it to the right creating three   loops.

Each loop is represented by a triangle on the top and bottom of the sound.  

The sound will loop based on the snap settings. (If you cannot change a sound to a specific length it is probably 
because snap is on and you need to turn it off.)

Creating A New Loop
You can re-loop a sound or make a loop out of any section of any sound.  Click on the Sound Details Tab and use the 
Loop Editor to adjust the start and end loop points.

Alternatively, you can   trim the sound   and then click Make Into Loop from the Sound menu.  This sets the loop points 
to the start and end of the trimmed sound.  The Loop Editor will show more details.

Setting Exact Loop Length
You can set a sound's exact length by clicking on the Sound Detail Tab and editing the length in minutes, seconds 
and milliseconds.  This will allow you to easily change the number of loops in a sound. 

Splitting Sounds
Splitting allows you to take one sound and cut it into two parts without any gaps. Splitting occurs at the caret's 



position.  

In this image, we show two selected sounds.  We've highlighted the caret in red to show its position ( the caret 
determines the split point ) .

Select Split from the Edit menu or the shortcut Ctrl+T 

Four new sounds are now in place of the original two.

The caret will be set based on the snap settings. (If you cannot set the caret to a specific location it is probably 
because snap is on and you need to turn it off.) 

Remove Spaces Between Clips
Removing Spaces Between Clips causes any selected sounds to be moved so that there is no silence between 
sounds.  It does not combine the sounds into one big sound, though.  Use the Merge Clips feature to combine clips.

You can remove gaps or space between the selected sounds by selecting Remove Spaces Between Clips from the 
Edit menu or by pushing Ctrl+J. 

Deleting Sounds
Select a sound or group of sounds and then select Delete from the Edit menu.

Alternatively, you can push the Delete key on your keyboard to delete the sounds.

Deleting Parts Of Sound
If you select part of a sound, it will only delete the selected part. For example, if you have recorded a singer and there 
is an extra audible breath, just select the unwanted area and delete it. 

Copy And Paste
You can copy and paste clips.  Select a clip or a portion of a clip using the selection rectangle.  Select Copy from the 
Edit menu and then click to position the Caret.  Then select Paste from the Edit menu.  A new copy of the clip will be 
pasted at the caret position.  You can also click Ctrl+C to copy and Ctrl+V to paste.



(Copy N' Paste makes the world go 'round.  Become a fan of "Copy And Paste" on your favorite social networking 
site.)

Quick Copy Tip
To quickly copy the selected clips, hold down the ALT key and click a clip to quickly make a duplicate.  This can be an 
incredibly useful and fast tool.  ( Try it.  You won't be disappointed.  This simple feature was suggested by a user. ) 

Merge Clips
To merge two or more audio or virtual instrument clips on the same track, select the clips and then click the Sound 
menu followed by clicking Merge To New Clip. 

Before a merge

After the merge

Reasons why you might want to merge clips:
• You have multiple virtual instrument clips on one track and want to print out the sheet music for the entire 

track.  The notation view works on one clip at a time.  Merging the clips together would allow you to edit it as 
one giant clip. 

• You have multiple audio clips one track recorded with the same noisy air conditioner in the background and 
you want to remove the noise in one command.  Merging the clips together allows you to remove the noise 
one time. 

• You have hundreds of clips and your workspace is getting confusing and slow.  Merging the clips to one 
sound will cut down on resources, speed up your mix by cutting down on CPU and declutter the interface, as 
well. 

• You just like using the Merge function and you are a merge freak?  (Sorry, we had to inject some humor into 
this help file...and congratulations if you are still reading this!) 

Setting A Sound's Active Channel
(This applies to audio clips only.)

Mixcraft displays stereo and mono audio clips in the same way.  If it's a stereo sound, the left and right channel are 
merged into one view.

If you only want to play the left channel of a stereo sound, you can select the sound clip and then choose Channels 
from the Sound menu.  (Alternatively, you can right click to bring this up.)  Choose Stereo, Left Channel,, or Right  
Channel.  

The sound clip will display [Left Channel] on its title area if it is only playing the left channel and it will display [Right  
Channel] on its title area if it is playing the right channel.

Noise Reduction
Mixcraft comes with a built in noise reduction feature for audio clips.  (Noise reduction only works on audio clips.)

Definition Of Noise
Noise could be background hum, clicks and pops and, generally, any unwanted sound.  However, Mixcraft's noise 
reduction works best on constant noises such as fans, air conditioners or anything constant throughout the recording.



Using Noise Reduction In Mixcraft
Click on the audio clip that you would like to remove the noise from.  Click on the Sound Details tab on the bottom.  
Click on the Noise Reduction control and select a value up to 100%.

Once you have selected an amount, Mixcraft will attempt to automatically find a good noise sample.  Mixcraft shows 
the noise section by two controls called Noise Start and Noise End.

The above image shows an example of a good noise sample.  The noise is determined by the audio section between 
the Noise Start and Noise End controls.  You can edit the noise sample by clicking and dragging the Noise Start or 
Noise End controls.  If you want the software to automatically locate the next best noise print, click Next Noise>>.  
This instructs Mixcraft to look for the next best noise sample based on what it thinks could be noise.  Only you know 
what noise is, though, so you may need to adjust it manually.

Finding A Noise Sample
The best candidate for noise reduction is a sound that has a snippet of the noise by itself.  For example, if you had an 
air conditioner in the background and you started recording, you should have one second of the air conditioner by 
itself.  Then choose the section of audio that is just air conditioner for your noise sample. If you don't have a good 
sample of the noise, you could try and re-record the noise by itself and then Merge the clips together. 

Adjusting The Sound's Volume
In addition to setting the track volume, you can also set the volume of individual sounds.

To edit the volume of a sound, go to the toolbar and make sure that Volume is selected.

When Volume is selected, each sound clip shows its own volume envelope.  In the sound below, the volume envelope 
corresponds to the two green points and the line connecting them.

This shows a clip with two envelope points, each at 100% volume. 

Change the Volume Envelope
Click on the line to create a new volume point.  The cursor will change to an Envelope Point Edit cursor.



In the image above, a new volume envelope point has been created.  Click on the point to drag it to a new volume 
level.

In the image above, the volume of the sound now goes from 100% up to about 170% and then slowly down to 100% 
again.  In this manner, you can add as many points as you'd like to shape the volume of the sound over time.

Volume Range
Volume can be set to values from 0% to 200%  ( -Inf dB to +6 dB ).  For better precision while dragging envelope 
points, you can resize the track.

Keyboard Modifiers
Hold the Ctrl key down and to add points anywhere on the sound. 
Hold the Shift key down and click down on an envelope line to move the line up or down.
Hold the Alt key down and click points to remove or delete them.

Setting Exact Volume
If the desired level cannot be set via mouse dragging, you can set it by right clicking on the point and choosing Edit 
Exact Value...  This brings up a dialog box that lets you set the exact value.

Fades, Boosts and Reductions
These are shortcuts that add multiple envelope points at a time.  Select an area of a sound and choose Fade In, Fade 
Out, Reduce, or Boost from the Sound   menu  .  Fades go from one volume to another over time.  Boost increases the 
volume for a selected period of time.  Reductions lower the volume for a selected period of time.  You can Normalize 
a sound by selecting it and then choosing Normalize from the Sound menu.

For tips on boosting or reducing volume, see How To Boost Or Reduce Parts Of Sounds.
For tips on creating fade ins and fade outs, see How To Add Volume And Pan Fades On Sounds. 

Adjusting The Sound's Pan
Pan is the volume balance between the left and right channel (speaker).  You can pan a sound so that it sounds like it 
is moving from the left to right or vice-versa.  This is what makes stereo more interesting to listen to.

To edit the pan of a sound, go to the toolbar and make sure that Pan is selected.

To pan a sound, edit a point by dragging it up or down.  Like volume, you can add as many envelope points as you'd 



like.  

The image below shows a sound panned from left to right.  A envelope point panned all the way to the left channel 
would be at the bottom of the sound.  An envelope point panned all the way to the right would be at the top of the 
sound.

Pan Range
Pan can be set to values from 100% left to 100% right.  For better precision while dragging envelope points, you can 
resize the track.

Keyboard Modifiers
Hold the Ctrl key down to add points anywhere on the sound. 
Hold the Shift key down and click down on an envelope line to move the line up or down.
Hold the Alt key down and click points to remove or delete them.

Setting Exact Volume
If the desired pan cannot be set via mouse dragging, you can set it by right clicking on the point and choosing Edit 
Exact Value...  This brings up a dialog box that lets you set the exact value.

Fades, Boosts and Reductions
These are shortcuts that add multiple envelope points at a time.  Select an area of a sound and choose Fade In, Fade 
Out, Reduce, or Boost from the Sound   menu  .  Fades go from left to right or vice versa over time.  Boosts increase the 
pan to the right channel for a selected period of time.  Reductions lower the pan to the left channel for a selected 
period of time.

For tips on boosting or reducing, see How To Boost Or Reduce Parts Of Sounds.
For tips on creating fade ins and fade outs, see How To Add Volume And Pan Fades On Sounds. 

Editing Low And High Pass Filters
In addition to changing the volume and pan of a sound over time, Mixcraft allows you to change the low pass and high 
pass filter over time.

What Is A Low Pass Filter?
A low pass filter is an audio filter that literally allows low frequencies to 'pass' while removing (or 'filtering out') high 
frequencies.  A low-pass filter has a cutoff value, such that every frequency below the cutoff can be heard, and every 
frequency above the cutoff is reduced or removed entirely from the audio.  For example, if you use a low-pass filter 
with a cutoff frequency of 2000 Hz, every frequency below 2000 Hz will be heard in full, but every frequency above 
2000 Hz will be reduced or removed entirely.

The low pass filter in Mixcraft is a resonant filter.  This means that in addition to the cutoff value, there is also a value 
for the amount of resonance.  Simply put, resonance involves emphasizing frequencies at the filter's cutoff point.  So, 
if we imagine a filter with a cutoff frequency of 2000 Hz and a high resonance value, what will be heard is a sound 
where frequencies above 2000 Hz have been removed, frequencies below 2000 Hz remain the same, and 
frequencies at and directly around 2000 Hz are louder.  Resonance is a simple concept, but it can be a dramatic 
effect, especially if resonance is high and the filter's cutoff frequency is changing.  This effect is what's known as a 
'filter sweep'.

Every sound in Acoustica Mixcraft has its own resonant low-pass filter.  These filters can be used in many ways.  You 
can use them as an EQ effect, reducing certain high frequencies such as acoustica guitar finger squeaks.  Or, you can 
use them to create filter sweeps, by adding resonance while the cutoff frequency moves up or down.  The cutoff 
frequency and resonance amount are each controlled via an envelope, and these values can change over time, in the 
same way a volume or pan envelope can be used to change to volume and pan amount over time.

How To Edit A Low Pass Filter



To edit a sound's low pass filter cutoff, go to the toolbar and make sure that Low Pass Cutoff is selected.  By default, 
all points on this envelope are at 100%, meaning that all sounds below the cutoff (i.e. everything) can be heard.  
Adding points lower than 100% will cause high frequencies to be increasingly removed from the audio.

To edit a sound's low pass filter resonance, go to the toolbar and make sure that Low Pass Resonance is selected.  
By default, all points on this envelope are at 0%, meaning that there is no resonance/emphasis at the cutoff point.  
Adding points higher than 0% will cause emphasis at the cutoff frequency, if any frequencies exist at and around that 
frequency.

What Is A High Pass Filter?
A high pass filter is the exact opposite of a low pass filter, meaning that high frequencies above the cutoff point are 
allowed to pass, while frequencies below the cutoff point are reduced or removed.

The high pass filter in Mixcraft is also a resonant filter.

How To Edit A High Pass Filter
To edit a sound's high pass filter cutoff, go to the toolbar and make sure that High Pass Cutoff is selected.  By default, 
all points on this envelope are at 0%, meaning that all sounds above the cutoff (i.e. everything) can be heard.  Adding 
points above 0% will cause low frequencies to be increasingly removed from the audio.

To edit a sound's high pass filter resonance, go to the toolbar and make sure that High Pass Resonance is selected.  
By default, all points on this envelope are at 0%, meaning that there is no resonance/emphasis at the cutoff point.  
Adding points higher than 0% will cause emphasis at the cutoff frequency, if any frequencies exist at and around that 
frequency.

What Famous Examples Of Music Have This Effect?
Many songs in many genres take advantage of resonant filter sounds.  The opening note to the Rush song Tom 
Sawyer contains a famous resonant low pass filter sweet of a synthesizer sound.  Many dance songs begin with a low 
pass filter whose cutoff frequency is slowly rising, so the song starts off muted and suddenly is full and bright. 

Time Stretching Sounds (FlexAudio™)
Time travel may not be possible yet, but you can change the speed of a sound without changing its pitch.  :)  In the 
past, changing the speed or playback rate of a sound resulted in changing the pitch, also known as the dreaded 
"chipmunk" effect.

Time Stretching Sounds
Each sound can be time stretched with or without changing its pitch..  A sound can be adjusted by 25% to 400% 
which would result in a sound four times as fast or four times as slow.  You can visually time stretch a sound with 
FlexAudio™, described below.  Otherwise, click on the Sound Details Tab on the bottom and select the sound you are 
interested in adjusting.  

Make sure to switch the sound from Adjust To Project Tempo to Time Stretch By mode, if it's not already in that 
mode.  

Adjust the sound to the desired percentage.  Setting it to 50% would cause the sound to be 1/2 the size and playback 
two times as fast.

If you want the sound's tempo to slow or speed up over time or beat match, you should change the sound's mode to 
Adjust To Project Tempo on the Sound Details Tab and add several successive tempo markers to the timeline.

FlexAudio™
FlexAudio™ is Acoustica's trademarked way to visually time stretch a sound clip.

In this example, the sound is around 14 seconds long and we'd like it to be 10 seconds.  



While holding the Ctrl key down, click on the right edge and move your mouse left to the 10 second mark on the time 
line.
(You will know that you are in FlexAudio™ mode if the cursor turns into the FlexAudio™ cursor .)

The sound will now play in 10 seconds, instead of 14 seconds!  

Tips With FlexAudio™
Use FlexAudio™ to create perfect loops.  If you have a loop without a detected tempo, set the snap to measure 
aligned.  Use FlexAudio™ to snap the sound to the nearest measure.  Loop the sound first to make sure all loop 
points line up.  Now it should be in perfect synchronization unless there are tempo changes during the loop, in which 
case, you should figure out the actual tempo of the sound.  

Once FlexAudio™ helps you figure out how much to time stretch the sound by, you can set the tempo with a simple 
calculation.  Just find the tempo of the closest tempo marker before the sound's start in this calculation.  Tempo of 
sound = (Project Tempo) X (Sound's Time Stretch Percentage) / 100.0 .  Switch the sound to Adjust To Project 
Tempo and then type in your new tempo.

If you have made a commercial and it needs to fit in exactly 30 or 60 seconds and you are over by a few seconds, just 
time stretch it with FlexAudio™.  Have you ever heard one of those legal disclaimers?  They are inhumanly fast and it 
is due to a sound being time stretched by about 75%.  Turn off snapping and FlexAudio™ it to the desired length.

Time stretching can be set from 25% to 400%.  However, in most cases, it will only sound good from around 75% to 
125%

Adjusting The Sound's Tempo
You can change a sound's tempo by clicking the Sound Details Tab on the bottom of the window.  Each sound can be 
in one of two modes: Adjust To Project Tempo or Time Stretch By.  Select the drop down to change the mode to 
Adjust to Project Tempo if it's in Time Stretch By mode.

Adjust To Project Tempo
If the sound is in Adjust To Project Tempo mode, Mixcraft will time stretch the sound based on the difference between 
the project's tempo and the sound's detected tempo.  For example, if the project tempo was 120 bpm and the sound's 
detected tempo was 60 bpm, it would time stretch the sound to be half as long, because it would be playing the sound 
back two times as fast.

However, you can have more than one tempo change in a project.  For example, in a transition between two songs, 
you could slowly ramp the tempo up with multiple tempo changes..  In this mode, the sound keeps perfect 
synchronization and adjusts the playback rate based on the latest tempo change.

Changing The Tempo Of A Sound
Assuming that the detected tempo of the sound is correct, you can change the tempo of a sound by adding markers 
with tempo changes.  You do not need to change the detected tempo of the sound, but, instead you should change 
the project tempo or add tempo markers!  In short, if you want to speed up the sound, increase the project tempo!  
Changing the detected tempo of a sound should only be done if the detected tempo of the sound is wrong!



Changing The Detected Tempo Of A Sound
You must be in Adjust To Project Tempo mode to change the detected tempo of a sound.  

If the sound's detected tempo is wrong, you can adjust it via the Detected Tempo drop down control.  The original 
detected tempo will show up with an * next to it in case you need to restore it to the original detected tempo.  

*** Audio Clips only ***

The following information is for audio clips only.

Sounds longer than 30 seconds will show the actual beats in the Loop Editor.  This can be extremely useful as each 
beat will show a tempo at that beat point.  Most songs do not keep a constant beat and drift, in addition to having 
varying tempos, keys and time signatures.  Therefore, you can trim a sound and use a tempo within that trimmed 
area.  

Learn How To Fix Songs With Drifting Tempos here.

In fact, you can set the detected tempo to the average tempo within the active loop by clicking the Use Average 
Tempo In Active Loop button! 

 Use Average Tempo In Active Loop button

In some cases, the detected tempo is off by a factor of two.   To quickly adjust the tempo by two, click the Double Or 
Half Tempo button! 

 Double Or Half Tempo button 

Pitch Shifting Sounds
You can change a sound's pitch by clicking the Sound Details Tab on the bottom of the window.   If you want the 
sound to obey key changes on the time line or be relative to the project's key, you should look into setting the key of 
the sound.

Do Not Fix Pitch
If you don't care about changing the sound's pitch, you can choose Do Not Fix Pitch on the Sound Details Tab.  If you 
are time stretching the sound, the pitch will be altered by the same percentage as the time stretch.

Adjust Pitch By
Choose Adjust Pitch By from the drop down list on the Sound Details Tab.

This allows you to change the pitch by semitones.  You can type in a partial amount such as 1.26 semitones or use 
the drop down or spin arrows to adjust by a whole semitone or 1/10th of a semitone.  You might use this option to fix a 
slightly off key vocal performance or transpose a sound into a key you are more familiar with.



Adjust To Project Key
Click here for more on adjusting a sound's key.

Transposing Virtual Instrument Clips
You can transpose a Virtual Instrument Clip by clicking on the Sound Details tab on the bottom of the window.  Click 
on the drop down entitled Adjust To Project Key and choose Transpose By.

Then either type in or select the number of half steps that you'd like to transpose the clip by.  

Virtual Instrument clips can be transposed without audio degradation because each time they are played the 
synthesizer recreates the sound from the MIDI data. 

Adjusting The Sound's Key
You can change a sound's key by clicking the Sound Details Tab on the bottom of the window.  Each sound can be in 
one of the following modes: Adjust To Project Key, Adjust Pitch By, Transpose By (Virtual Instrument clips only) or Do 
Not Fix Pitch. (Audio clips only)  Select the drop down to change the mode to Adjust to Project Key.

Adjust To Project Key
If in this mode, Mixcraft will adjust the pitch of the sound based on the difference between the project's key and the 
sound's key.  For example, if the project key was F# and the sound's key was F, it would adjust the pitch of the sound 
up by one semitone so that it was in tune with F# instead of F.

However, you can have more than one key change in a project.  A sound in Adjust To Project Key mode will adjust to 
the correct # of half steps in order to play in the correct key based on the most recent key change.  To continue the 
example, if your sound was in F and you had two key changes to A and then G, it would correspond to shifting the 
pitch of your sound by four semitones up  to A and then by two semitones up to G. 

The software adjusts the pitch by the shortest distance between two keys.  For example, if the project key was G and 
the sound's key was F, it will adjust it by +2 semitones, instead of -10 semitones.

Changing The Key Of A Sound
Assuming that the key of the sound is correct, you can change the key of a sound by adding markers with key 
changes and/or by changing the project's key. You do not need to change the key of the sound on the Sound Details 
Tab, but, instead, you should change the project key or add key change markers!  In short, if you want to change the 
key of a sound, change the project key!  Changing the key of a sound should only be done if the detected key is 
wrong!

Changing The Detected Key Of A Sound
You must be in Adjust To Project Key mode to change the detected key of a sound.  

If the sound's detected key is wrong, you can adjust it via the Detected Key drop down control.  The original detected 
key will show up with an * next to it, in case you need to restore the original detected key.  

Renaming A Sound
You can rename a sound by going to the Sound Details Tab  and editing the sound's name in the edit box labeled 
Name.  Press the Enter key or click on another part of the window to finish the name change. 



Locking Sounds
Lock a sound so that it cannot be moved or resized.  You can still edit the sound's envelopes, though.  To lock a 
sound, select it and then choose Lock from the Sound menu.  Alternatively, you can select the Sound Details Tab and 
click the Lock button. 

Linking / Unlinking Clips
You can link several clips together so that when you drag them, they move in unison.  This can be useful for video 
clips and their associated audio clips.  

When a clip is linked, it will have an extra button on it to make it easy to unlink.  

To link two clips together, select the clips and then click the Edit menu, followed by clicking Link >, followed by clicking 
Link Selected Clips.  The clips will now move together relative to each other's start. 

Muting Sounds
You can mute a sound so that it is inaudible.  The reason you might do this is to keep a sound in the project without 
having to listen to it.  A muted sound will appear light gray.  If you mute a track, it will mute all sounds on that track.  
To mute a sound, select it and then choose Mute from the Sound menu.  Alternatively, you can go to the Sound 
Details Tab and click on the mute button (looks like a speaker). 

Adding Effects To Sounds
You can adjust the volume, pan, low pass filter and high pass filter envelopes for each sound.  If you are interested in 
adding reverb, delay or other effects, go to the Track Effects section. 

Sound Details
The Sound Details tab allows you to rename a sound, change its length, change its time offset, mute it, lock it, change 
its tempo, pitch shift or key. 

If you have selected an Audio Clip, the Loop Editor will be displayed on the right side:

If you have selected a Virtual Instrument Clip, the Notation View Editor or Piano Roll Editor will be displayed on the 
right side:



(This shows the Notation View Editor.)

Lock or Unlock Sound
Click the lock icon or unlock icon to toggle a sound's locked state.

Name
Change the name of the sound in this edit box.

Mute or Unmute Sound
Click the speaker icon to toggle a sound's muted state.

Offset
Change the offset of a sound by entering in minutes, seconds and milliseconds or using the spinner controls.

Length
Change the length of a sound by entering in minutes, seconds and milliseconds or using the spinner controls.  (If the 
sound is made long enough, this will also cause it to loop)..

Time Stretch / Tempo
Set the mode of the time stretching for this sound.   Choose from Time Stretch By or Adjust To Project Tempo.

Adjusting Pitch, Key or Transposition
Set the mode of the pitch shifting for this sound.  Choose from Adjust To Project Key, Adjust Pitch By, Transpose By, 
or Do Not Fix Pitch.  

For Virtual Instrument Clips, you will have two options: Adjust To Project Key and Transpose By.

Sound Format
The sound format shows the type of sound, its bit rate and channels.  (Audio clips only.)

Sound Location
This shows where the sound is located, including its folder and file name.  (Audio clips only.)

Signature
Edit the time signature of the clip.  (Virtual Instrument clips only.) 

Tracks
Click on an area on the image for more help.

There are five different kinds of tracks in Mixcraft: 



• Audio Tracks   
• Virtual Instrument Tracks   
• Send Tracks   
• Video Track   
• Master Track  

Adding Tracks
Deleting Tracks
Choosing A Virtual Instrument
Track Name
Track Image
Resize Track
Moving Tracks
Track Color
Track Volume
Track Pan
Solo Track
Mute Track
Track Effects
Arming For Recording
Monitor Input
Duplicating Tracks
Freeze Track
Track Automation
Track Details 

Audio Tracks
Audio tracks contain audio clips.   Audio clips can be recorded or loaded.  The image below shows an audio track and 
an audio clip.

Adding Audio Clips
Recording Audio Clips
More On Audio Clips
More On Tracks 

Virtual Instrument Tracks
Virtual Instrument tracks contain virtual instrument clips.   Virtual instrument clips can be recorded or loaded.  The 
picture below shows a virtual instrument track with a clip.

Virtual Instrument Tracks have the extra instrument button to the left of the mute button.

Click the instrument button to choose an instrument.  Play an optional MIDI keyboard to trigger notes or use the 
Musical Typing Keyboard to play music via your computer keyboard.

Choose A Virtual Instrument



Creating Your Own Virtual Instrument
Play the Musical Typing Keyboard to trigger and record notes
More On Tracks

Included Virtual Instruments:
• Acoustica Instruments (General MIDI synthesizer) 
• Acoustica Expanded Instruments 
• Alien 303 Bass Synthesizer 
• Impulse 
• Lounge Lizard Electric Piano 
• Messiah 
• MinimogueVA 
• VB3 Organ 

Send Tracks
Send Tracks are special tracks that can hold their own effects and track automation.    Audio Tracks   and Virtual 
Instrument Tracks can send their audio output to be mixed on a Send Track.  A Send Track is also known as an "Aux 
Bus".

When To Use Sends 
• Use a send when you want to use effects on a specific portion or section of a track. 
• Use a send when you want to share effects over multiple tracks.

Routing Audio To A Send Track
First, add a send track.  

Now expand the track automation portion of the track by clicking the Send Track's automation button.

This will expand the automation window.  On the automation type drop down, click Send Track 1

Now you can adjust the amount of this track's audio that gets sent to the Send Track via track automation.   Change 
the Send knob to adjust the amount of audio or "send" that gets sent to the Send Track.    You can also draw in an 
automation envelope that adjusts the amount of audio sent over time!



This audio will be sent to any effects loaded on the Send Track.  Additionally, the track's audio will also be processed 
with the volume and/or pan automation envelopes on the Send Track.

Adjust the Send Track's automation, just as you would adjust any track's automation envelopes.

Send Volume Type
This determines if the track's audio is sent to the Send Track before or after it's own track's volume 
automation/adjustment is mixed in.

• Pre Volume Adjustment - The track's audio is sent to the Send Track before applying its own volume 
adjustments.  (PRE-Fader Send) 

• Post Volume Adjustment - The track's audio is sent to the Send Track after applying its own volume 
adjustments. (POST-Fader Send)

To change the Send Volume Type, right click on the Send knob on either the Mixer or the Send knob on the 
automation pane.

To reiterate, the send volume type determines whether audio from the track is routed to the Send Track before or after 
the track fader and volume automation.  The audio signal flow for a track is as follows:

1.   [Clips (with clip-level automation)]

                            |
                            |
                           V

2.              [Track Effects]

                            |
                            |
                           V

3.           [PRE-Fader Send]   *

                            |
                            |
                           V

4.          [Track volume & pan]

                            |
                            |
                           V

5.          [POST-Fader Send]  *

* Depending on the send volume type, the audio from a track will be sent at one of the starred * points in the audio 
signal flow.



Tip With Effect Sends
When adding an effect to a Send Track, it is recommended to choose a preset designed for being on a Send Track.  
Many effects will list this with the word Send in it.  When using any effect, make sure to click the Edit... button and 
adjust the dry mix down to 0% and the wet mix to 100%.

Learn more about Send Tracks
• Adding Effects To A Track   
• Track Automation   
• Adjusting Send Via the Mixer   
• More On Tracks   

Video Track
The Video Track holds video clips.  There is only one video track.

Add Video Files
You can add video files in one of two ways. 

• Drag them in from Windows. 
• Click Add Video File... from the Video menu.

Supported Video Formats (AVI and WMV)
Mixcraft will load AVI and WMV formatted videos by default.  Depending on your computer's configuration, though, 
you may be able to load in more video formats, such as MPEG or MP4.  Please note that support for formats other 
than AVI and WMV will depend on the quality and availability of the DirectX decoders installed on your computer. 

Other Video Formats
Mixcraft will allow you to load file formats other than "AVI" and "WMV" by selecting Add Video File... from the Video 
menu and then switching the Files of type drop down to All Files.  Select the video file and then choose "Open".  If the 
video fails to load, it is because you are most likely missing the correct DirectX video decoder.  The best advice is to 
do one of the following:

• Install the software that came with your video camera.  It may also have come with a DirectX video decoder 
that would allow other programs such as Windows Movie Maker or Windows Media Player to play the files.  
(This assumes that the file was created with a video camera that you own.)  Make sure to restart your 
computer after installing. 

• Download a video file converter to convert it to AVI.  This is better than loading the original video format, as it 
will be faster. 

• Install a DirectX/DirectShow video decoder for the video format you are attempting to load.  Beware of many 
faulty/buggy/error prone decoders out there.

Your Video's Audio
Your video's audio will be loaded into a separate audio track.  By default, the video clip and it's associated audio clip 
are linked.  When you move the video clip, the audio clip will follow.  To unlink the clips, right click on the clip and click 
Link followed by Unlink This Clip or Unlink All Selected Clips. 

Alternatively, you can click the clip's unlink button which looks like this: 

Viewing Your Video
Mixcraft will automatically launch a "Video Preview" window when you start playback.  You can maximize, resize or 
click the X on the top right hand corner to close the video preview window.  To see the "Video Preview" window, click 
the "Show Video Window" on the Video Track.

Tip: To quickly see the video frame at a particular location, click the timeline and the video frame at that time will be 
displayed in the "Video Preview" window.



Editing Video Clips
Move and resize video clips just as you would move and resize audio clips.  

• Click a Video Clip's title bar to move it around. 
• Resize the left or right hand side of a clip to trim or crop it. 
• Overlap two videos to cross fade between them. 
• Split a video clip by left clicking it to position the caret and then right clicking and clicking Split or pressing 

"Ctrl+T".

More On Tracks
Video Loading Problems
Video Playback Problems

Master Track
Each project has one Master Track.  All tracks are mixed to the Master Track.

Show The Master Track
To view the Master Track, click Show Master Track from the Track menu.  Alternatively, click the +Track button at the 
top of the tracks and then click "Show Master Track".

More On Tracks...

All audio is routed and mixed to the Master Track.  You can adjust the master or global volume or add master or 
global effects, as well.  You can also automate volume or any other effect parameter for the master track.  

Tip: If you want to fade out your project, show the Master Track and select Master Volume in the automation drop-
down.  Scroll over to the end of the project and add volume automation points to lower the volume.  See more on 
automation help... 

Adding Tracks
Each new project starts with 8 blank tracks.  

You can add tracks by clicking the +Track button above the tracks to the left of the time line.  

You can also click Add Track followed by selecting the type of track from the Tracks menu to append a track.

** Note - Mixcraft LE (Light Edition) is limited to 8 audio tracks and 16 virtual instrument tracks.

Inserting A Track
If you would like to add a track at a specific location, select the track before the insertion location and then click Insert 
Track, followed by selecting the type of track from the Track menu.

If the track isn't where you wanted it, you can always move the track.

There are five different kinds of tracks in Mixcraft: 
• Audio Tracks   
• Virtual Instrument Tracks   



• Send Tracks   
• Video Track   
• Master Track   

Deleting Tracks
Select a track by clicking it so that it highlights.  Then choose Delete Track from the Track menu or right click on the 
track header and choose Delete Track.  Any sounds on the track will also be deleted. 

Choosing A Virtual Instrument
Assuming the track is a Virtual Instrument Track, click the instrument piano keyboard button to bring up the Instrument 
Preset window.

This will bring up the instrument preset window.

Click on a category and then click on a preset.

Click the [x] button on the top right of the window to hide the instrument dialog.  Alternatively, you may click the 
instrument button on the track header to toggle the visible state of the instrument preset window.

There are three special categories: <Custom>, <Instruments>, & <External Devices>.

<Custom>
This means that you have made your own custom virtual instrument.  
Learn more about creating a custom virtual instrument patch.

<Instruments>
This category will show all available virtual instruments on your computer, including any external ones.  The bundled 
synthesizers include Acoustica Instruments, Impulse, MinimogueVA and VB3 Organ.  VSTis are the only supported 
type of plug-in. If you have a virtual synthesizer that is not showing up, you may have to edit your VST Effect folders.

Acoustica Instruments - This is a general MIDI synthesizer with additional banks of sampled sounds.



Impulse - This is a polyphonic subtractive analog synthesizer.
MinimogueVA - This is an emulation of the popular MiniMoog™ synthesizer.
VB3 Organ - This is an emulation of the popular Hammond B3™ organ.

When you click on a virtual instrument, the window will expand and you will see the following:

Click on the preset column to select a preset.  
Learn more about creating your own virtual instruments.

<External Devices>
This category will show all external MIDI outputs or sound card MIDI synthesizers.  If you have an external synthesizer 
connected via a MIDI interface, select the appropriate MIDI output interface.  Please note that you will not be able to 
render or burn the audio made by these synthesizers unless you record them to an audio track first!

MiniMoog™ is a trademark of Moog Music, Inc.
Hammond B3™ is a trademark of Hammond-Suzuki, Inc 

Creating Your Own Virtual Instrument
You can make your own virtual instrument presets by layering multiple synthesizers, editing presets, setting key range 
and more!

To create your own Virtual Instrument, click the Instrument button on a Virtual Instrument Track.

On the pop-up window, click the Show Details... button

This will extend the instrument window and show more details about the preset.



To add a virtual instrument, click on <Select Synth> and then choose a synthesizer from the drop down list.

After selecting an instrument, you can change the following parameters:
• Preset - Select a preset or patch from the synthesizer 
• Edit - If the synthesizer has an interface, click the Edit button to bring it up for further customization. 
• Volume - Click on the volume column and type in a value from 1 to 200 % 
• Pan - Click on the pan column and type in a value from -100% to 100% 
• Range - You can set the range of MIDI notes that this synthesizer responds to.  Click on it and select a range 

of notes from the pop-up keyboard.  The synthesizer will only play audio for notes in this range. 
• Transpose - Type in a value to transpose notes for this synthesizer.  For example, if you set the transpose to 

12 and you play a C4 on your MIDI keyboard, it will actually play a C5. 
• Velocity - Type in a velocity range that this synthesizer will respond to. (1-127) See the MIDI primer for more 

information on velocity. Make sure to type in a dash so that the software understands what the range is.  For 
example, if you wanted it to respond to velocities from 120 to 127, you would type in '120 - 127'.

Once you have edited the values for this synthesizer, you will end up with something like this:

At this point, you can add more synthesizers and effects.



Choose an icon by clicking Set Icon... and you've made your own custom virtual instrument!

Save Preset...
You can save your preset for later use in other projects, as well.  

Type in a name and select a category.  You may create a brand new category by typing it in, if you wish.  Optionally, 
you can have the custom icon embedded in the preset file by clicking the Embed Icon checkbox.  When are satisfied, 
click Save.

New Preset
Click this to create a blank preset.  If you have made changes to this preset, Mixcraft will ask you if you want to save 
your changes.

Preset Files
Your preset files are located in your Mixcraft 4 folder under a sub-folder called InstPresets.  Preset files have a 
.instrument extension and can be traded and sent between computers and users.  (Please note that you will need the 
appropriate VSTi's and virtual synths installed so that they will work.) 

Track Name
You can name a track by left clicking on its current name, which defaults to "Track".  An edit box will appear.  Type in 
or edit the track name and push the Enter key or click on another area of the window to finish. 

Track Image
Each track can have its own image for distinction, personalization and organization purposes.  Choose from 20 stock 
images or include your own!  

Choose A New Image
Double click an existing track image or move your mouse to the upper left corner of the track image until a button 
pops up so that you can push it.  Alternatively, you can click Choose Image... from the Track menu or right click on a 
track and select Choose Image...

The Choose A Track Image window comes up.



Select a new image and click OK.

Add Your Own Image Or Photo
You can add any image or photo of your band members, your dog or almost anything that is in the one of the following 
image formats.

• .JPG 
• .BMP 
• .PNG 
• .GIF

Click on Add My Own Image File... and then navigate to the image you'd like to add.  Select the image and then click 
Open.  After a few moments, the image will be added to your list of images for use with other projects and put on your 
track header.

 

Resize Track
You can resize a track so that you can better edit the sounds on the track or so that you can see more tracks on the 
screen at once.

Resize a track by moving the mouse to the bottom of a track and drag up or down.  Alternatively, you can click on the 
Track menu, followed by Track Height, followed by a size of Small, Normal or Large.  You can also right click on a 
track and select Track Height followed by Small, Normal, or Large.  Another way to resize the track is to click on the 
Track Details Tab  followed by selecting a track size.

Resizing All Tracks
You can resize all tracks at once by clicking on the View menu, followed by All Tracks Height followed by Small,  
Medium or Large.

Moving Tracks
You can move tracks by drag and drop.  Simply click down on a track header and move the mouse up or down.

Alternatively, you can right click on a track and choose Move Track Up (Ctrl+Shift+U) or Move Track Down 
(Ctrl+Shift+D).  This menu options can also be accessed on the Track menu.

Track Color
Each track's color can be set on the Track Details Tab.  All sounds on a track acquire the track's color.  The default 
color can be changed in the Preferences on the Display section. 

Track Volume
Each track has its own volume which can be adjusted by the slider on the track.  Click down on the slider and move it 
left or right.



The volume can be set from 0% to 200%.   ( -Inf dB to +6 dB )

Alternatively, you can set the track volume by selecting the menu Track followed by Set Volume followed by a value or 
Set Exact Value...  You can also right click on a track to get the same menu options.

Note on Armed Tracks: The volume slider turns into a red slider and allows you to adjust the recording level.  When 
you disarm the track, the volume slider returns to its original position and color.

Tip: Hold down ALT, Shift or Ctrl and click drag the slider for finer and more accurate adjustment. 

Track Pan
Each track has its own pan.  Adjust the pan control by clicking down on it and moving the mouse up or down.  You 
can adjust the pan from 100% Left to 100% Right.

Each Pan control starts in the Center position which means that the sound is balanced equally between the left and 
right channel or speakers.

 - Pan control in the Center position

 - Pan control panned partially to the left channel.

 - Pan control panned partially to the right channel.

Alternatively, you can set the track pan by selecting the menu Track followed by Set Pan followed by a value or Set 
Exact Value...  You can also right click on a track to get the same menu options.

Tip: Hold down ALT, Shift or Ctrl and click drag the slider for finer and more accurate adjustment. 

Solo A Track
If you'd like to hear the audio on just a single track, without hearing other tracks, click the Solo button on the track 
header.  You can solo multiple tracks, as well.  For example, if you want to hear how the bass and guitar sound 
together without the drums, just solo the bass and drum tracks. 

You can also solo a track by choosing the Track menu followed by Solo (Ctrl+L) or by right clicking on a track and 
choosing Solo. 

Mute A Track
If you do not wish to hear a track, you can mute it by clicking the Mute button on the track header.

Alternatively, you can click the Track button followed by clicking Mute (Ctrl+M) or by right clicking on the track header 
and selecting Mute. 

Track Effects
Each track has its own effects which are applied to all sounds on the track.  Learn more about editing effects here. 

Track Automation
In addition to adjusting a clip's volume, pan and filters, you can also add volume and pan automation for an entire 
track.  In fact, you can automate or create automation envelopes for every parameter of every effect and virtual 
instrument, and automate the Sends as well.



Click the "Toggle Automation" button to view the automation for a track: 

This will show the automation part of a track.

The default automation is the track volume.  This will adjust the volume over the course of the track. Now you can use 
the mouse to add track volume envelope points.  

Click on any point in the automation body to add a point and then drag it to the desired value.

Moving Track Automation Points

The global snap value will apply when adding and editing automation points.   If you are having 
problems moving an envelope point to a specific location, turn off snap.

To move the automation line, hold down the Shift key and the cursor will turn into an up down arrow   .  Move the 
line up or down to the desired value.

Dragging an automation point over other automation points will cause them to be 'over-run' and then deleted when the 
mouse is released.

Fine Tuning Automation Points
Right click on an automation point to edit its value or to delete it.  

Right click on a track automation header (to the left of the automation type) to clear, invert or hide the automation 
area.

Automating Effects
Each VST, VSTi, and Acoustica Effect that is loaded into Mixcraft can be automated.  In fact, each parameter of every 
effect can be automated.  This means that you can change the delay amount of a delay effect at specific times or 
change the chorus level over time.  The sky is the limit.  (Note: DirectX effects can not be automated in Mixcraft)

To automate an effect:

1. Choose an effect for the track.



2. Click the automation drop down to show the automation. 
3. Now select the effect.  Click on the control titled "Track Volume", followed by clicking the effect you wish to 
automate, followed by clicking the effect parameter you wish to automate.
4. Add automation points at the values you desire.

Automating Virtual Instruments
Each VSTi or virtual instrument can be automated as well.

To automate a virtual instrument:

1. Choose a virtual instrument for the track.

2. Click the automation drop down to show the automation. 
3. Now select the virtual instrument.  Click on the control titled "Track Volume", followed by clicking the virtual 
instrument you wish to automate, followed by clicking the parameter you wish to automate.
4. Add automation points at the values you desire.

Automating Virtual Instruments Effects
To automate a virtual instrument's effects:

1. Choose a virtual instrument for the track.  Add an effect to the virtual instrument.  See "Creating Your Own Virtual 
Instrument".

2. Click the automation drop down to show the automation. 
3. Now select the virtual instrument's effect.  Click on the control titled "Track Volume", followed by clicking the effect 
under the "Instrument Effects" header, followed by clicking the parameter you wish to automate.
4. Add automation points at the values you desire.

Automating Send Tracks
To automate a send track:

1. Add or set up a Send Track.        

2. Click the automation drop down to show the automation. 
3. Click on the control titled "Track Volume", followed by clicking the appropriate Send Track.
4. Add automation points at the values you desire.

Arming A Track For Recording
Arming a track simply means that you are preparing it for recording.  When you arm a track, you are instructing the 
software that you want to record on that track.  

To arm a track, click the Arm button on a track header. 

Once a track is armed, it will highlight in red.  

Choosing Recording Input 

Audio Tracks

You can record from multiple sound cards and different inputs at the same time.  Some specialty sound devices allow 
you to record on multiple inputs at a time.  Typical sound cards usually only have one stereo input with one source. 

On the track header, click the little arrow on the Arm button. 

This brings up a list of sound devices, followed by inputs.  In the following example, it shows one device.  (Conexant 



HD Audio).

 

For those that wish to record a mono signal, click the sound device followed by clicking Left or Right depending on 
where you've plugged in your device.

Virtual Instrument Tracks

You can record multiple tracks of virtual instruments at the same time.  By default, Mixcraft will listen to all MIDI 

channels (Any Channel) for each track.  However, if you click the little arrow on the Arm button    you will be able to 
choose the MIDI channel that the track listens to.  

For example, if you have two keyboards and want to record each keyboard on a different track, try the following.  Set 
keyboard 1 to send on MIDI channel 1 and set keyboard 2 to send on MIDI channel 2.  Now click the Arm button on 
track 1 and select Channel 1.  Choose Channel 2 for track 2.   You are ready to record.    

Alternatively, you could split your MIDI keyboard into two sections.  You could make the first section or range of notes 
go to MIDI channel 1 and the second range of notes go to MIDI channel 2.  This would have the same effect as two 
keyboards.  You will need to consult the manual for your MIDI keyboard to see if this is possible, though.

Choosing A Recording Source (Audio Tracks only)
When you are using the Wave driver system (the default), and you are using a standard Window's sound card, you 
will also have the choice of choosing which mixer source to record from.  Typical choices are microphone, wave out 
mix, line in and auxiliary.  Click the arm arrow, select your sound device and then choose Stereo Source. 

You can alternatively choose a recording source by going to your Window's mixer and choosing a source.  Hint: Click 
the Window's Start button followed by choosing Run..  Type in sndvol32 -r and adjust your source control.

Setting A Recording Level (Audio Tracks only)
In Wave mode, you can set the recording level of the armed track.  When you arm a track, the volume slider turns into 
a red recording level adjuster.  This is not an option in ASIO mode due to the way that ASIO drivers work.  However, if 
it is a typical sound card, you can adjust the recording level by opening the Window's audio mixer, by clicking the 
Window's Start button followed by choosing Run..  Type in sndvol32 -r and adjust your source control recording levels.

After disarming the track, the slider restores to its original setting.

Setting Recording Level On Vista With WaveRT (Audio Tracks only)
If you are using Window's Vista and are using the WaveRT drivers, right click on the speaker icon on the lower right 
area of your desktop.  (The speaker icon should be to the left of the time display).  Right click on the speaker icon and 
click on Recording Devices.  Select the recording device that you wish to record and then click Properties.    Click on 
Levels from the pop up window.  Move the slider to the appropriate level.  You can keep this window open and try a 
test recording in Mixcraft.  Adjust as necessary.

Recording Multiple Tracks At A Time (Audio Tracks only)
You can arm multiple tracks at the same time if your sound device supports it.  In this way, you can record an entire 
band in real time, with each recording on its own separate track.  Just keep in mind that you will need to use the arm 
chooser button as described in the above section to choose the correct input for each track.  

Tip: You can set up a project with the correct inputs and armed tracks for your band and then save it as a project 
template.  The next time you record your band, simply load the template and everything will be ready to record!



Monitor Your Input (Audio Tracks only)
You can hear yourself with effects by turning monitoring on.  More on monitoring.

Recording Problems?
Recordings Are Not In Sync
Recordings Are Drifting Or Getting Out Of Sync Over Time

Monitoring
"Oh, how I love to hear myself louder!" - Some overjoyed musician. 

Some sound devices include a feature that allows you to hear what you are recording.  Many devices (such as USB 
microphones), though, do not allow you to hear what you are recording.  And other times, you may wish to monitor 
your live performance through Mixcraft's effects - for example, guitar players wishing to play live through Mixcraft's 

guitar amp simulators.  To hear or 'live monitor' a track, click the arm recording selector button  followed by clicking 
Monitor Incoming Audio. 

We recommend that you use headphones in order to avoid feedback when recording with a microphone.

One caveat to this is that you must set your sound card to mix with a low latency, otherwise it will sound like an echo 
chamber and the sound could be delayed by seconds.  You can go into the preferences and try ASIO mode, if 
available, or reduce the buffer size to 4096 or 2048 and reduce the number of buffers to 2 or 3 in Wave mode.  The 
down side to reducing your buffers and buffer size is that you may hear gaps in the audio, depending on your sound 
card and computer speed.

Hearing Effects In Real Time
If you add effects, you will also hear the effects on a track if monitoring is on.  The effects are not recorded and you 
can change them or remove them later, without affecting the recording. 

Freeze Track
If your computer is slow or audio is starting to gap or stutter because of a lot of effects or time stretching, you can 
freeze a track to reduce the amount of processing the track needs.  After freezing a track, the software uses a 
temporary WAV file that includes all effects and audio.

You cannot edit the effects or sounds on a track until you Unfreeze the track. ( Dragging a new sound on to a track will 
unfreeze a track ). 

If you want to lock a sound, go here.

To freeze a track, go to the Track Details Tab, select the track you'd like to freeze and then click the Freeze button.  

Duplicating Tracks
You can duplicate or copy all settings and sounds on a track.  Click the Duplicate button on the Track Details Page to 
duplicate the selected track.  Alternatively, you can choose Duplicate Track from the Track menu or right click on a 
track and select Duplicate Track. 

Track Details

Click on an area for more information.



 

Mixer
Each track can be mixed on the Mixer.  This is an alternative way to mix your project that looks like the familiar analog 
mixer in a typical studio.  Each track is represented by a vertical panel containing a volume slider, pan control, EQ 
(low, mid, high), FX button and optional Send knob and Instrument button.

FX
Click the FX button to bring up the Effect dialog for each track.  If the track has effects on it, it will appear purple.  
Hovering the mouse over the purple FX button will show the currently loaded effects.

Change Instrument Button
If the track is a Virtual Instrument track, you will be able to change the assigned virtual instruments by clicking the 
Change Instrument... keyboard button.

EQ
Each track has built-in equalization (EQ) knobs (Hi, Mid and Lo).  To change the EQ, click a knob and move the 
mouse up or down.

Tip: Hold down ALT, Shift or Ctrl and click drag the EQ knobs for more accurate adjustment.

Send Knob
If your project has a Send Track, you will be able to adjust the amount of audio being sent to the Send Track.  

Use the Send Channel selector on the far left of the mixer to choose which Send Track you are adjusting.

Tip: Double click on any knob to center it or put it back to its default! 

Video
Mixcraft supports loading and saving of video.  It is designed so that you can do the following:



• Add a musical soundtrack to a video. 
• Add sound effects to a video. 
• Get millisecond accurate syncing of video to sound. 
• Export your project to video for burning DVDs or uploading to the Internet.

Learn more about the Video Track
Learn more about video clips

Saving Your Video
Mixcraft supports saving video to AVI or WMV.  AVI is uncompressed and will be larger than WMV.  If you are 
uploading to Google's YouTube, you should choose "WMV" as it will be compressed automatically on YouTube's 
servers.  

To save your project as a video, click the File menu, followed by Mix Down To, followed by AVI or WMV.   To set the 
quality and other details, click Edit Details...   

If you are saving to WMV, you can choose a preset or you can click Specify Settings followed by clicking Settings... to 
choose more detailed options.  See more on the WMV Compression Settings dialog. 

WMV Compression Settings Dialog
This dialog lets you choose specific compression settings when you're rendering a video project to a WMV video. If 
you're using this dialog instead of the Video File Properties generic quality slider, you'll probably want to dig in and 
read all the details, but here are a few quick answers to help you with some common goals:

How do I get the highest quality video?  
Choosing the "Variable Bit Rate with quality setting" encoding option and then setting its quality slider to the highest 
setting (by sliding it all the way to the right) will almost always produce the highest quality results, but it will also 
produce files about three times larger than any other methods. If that's too big, try reducing the quality slider a bit or 
choosing one of the other encoding methods (except the "Constant Bit Rate (1 pass)" method, which usually produces 
low-quality results). Which encoding method works best will generally differ depending on your video content, and you 
might have to try multiple methods and compare them.

Bit rate also has a big impact on video quality. Higher bit rates will result in higher video quality (albeit with larger file 
sizes). There will usually be a point at which a higher bit rate won't help  any, but raising the rate won't hurt video 
quality.

How do I get the smallest video files?
Video dimensions and bit rate will usually have the biggest impact on file size, with smaller dimensions and lower bit 
rates producing the smallest files. Encoding method can also be important - don't choose the "Variable Bit Rate 
(unconstrained)" method, and if you choose the "Variable Bit Rate with quality setting" method, don't set the quality 
slider to its highest setting.

What settings should I use for videos I'm planning to upload to YouTube?
YouTube recommends using the same resolution and frame rate as the original video. Unless your file size exceeds 
YouTube's limits, it's best to use bit rates that err on the side of quality 
rather than file size (in other words, higher bit rates), since YouTube can compress video to produce smaller file sizes 
but can't re-add quality that you removed by using low bit rates. You can see YouTube's guidelines here.  
To see what a video clip's original resolution and frame rate are, right-click on the clip and then select "Properties" 
from the menu that pops up.

The Dialog Controls

Dimensions:
This area lets you specify the height and width of your video. By default, it'll be set to the same resolution as the 
smallest video in your project. The dimensions combo box holds a variety of standard settings, and you can check the 

http://www.google.com/support/youtube/bin/answer.py?answer=132460


"Set Custom Dimensions" box to set whatever dimensions you want.

A few things to remember when setting custom dimensions: height and width must both be even multiples of four, or 
DirectShow will refuse 
to render. If the dimensions you choose are too large, DirectShow may not have enough memory to render the video. 
And if you choose dimensions with a different aspect ratio than your original videos, the resulting video may look 
stretched or squashed.  [Note to Joseph: once I'm able to get a custom resizer filter working, the aspect ratio issue 
should go away, so we'll have to edit this bit.]

Frame Rate: 
This area lets you specify your video's frame rate (how many frames per second the video will contain). By default, it'll 
be set to the highest frame rate found among the video clips in your project. (To learn what a video's native frame rate 
is, right-click on the video clip and select the "Properties" option from the menu that pops up.) The Frame Rate combo 
box contains a variety of standard frame rates, but if it's missing the one you want, you can check the "Set a custom 
frame rate" box to type in a specific frame rate.

Should I change the default frame rate?
Probably not. Increasing the frame rate to one higher than the frame rates found in any of your project's video clips will 
typically increase the size of 
the video file without increasing quality, while decreasing the frame rate will usually lower the quality. Even if your 
primary concern is 
video size, changing the frame rate is not necessarily useful; depending on the encoding method you choose, 
lowering the frame rate can actually increase file size. If you're trying to alter the frame rate to produce smaller file 
sizes, you'll need to experiment to find the best setting.

Video Bit Rate:
This setting specifies approximately how much bandwidth your video will require, in kilobits per second. It's one of the 
primary factors affecting compression. Higher bit rates mean larger files and higher quality, while lower bit rates will 
result in smaller, lower quality video files. The right bit rate to use will depend on the dimensions and frame rate of 
your video; a bit rate that produces a high quality 720 x 480 video may result in a grainy, pixilated video if you use it 
for a 1440 x 1080 video. You may need to experiment to find the results you like best for different types of video.

Video Encoding Method: Microsoft provides a handful of encoding methods for WMV creation. Which one to use will 
depend on your priorities - quality or file size - and on your video content. In practice, an encoding method that 
produces the best results for one video may not produce the best results for another, so you'll have to experiment if 
you want the absolute best results for each project.

Constant Bit Rate (one pass): This method was designed to handle live streaming video, and will usually produce 
the lowest quality results when rendering to a file. Because it's a one-pass method, though, it takes half as long to 
render out to file as the two-pass methods, so it might be the choice for you if the world's ending in a few minutes and 
you really want to be able to watch this video before you go.

Constant Bit Rate (two pass): This method will usually produce good quality video if you've set a sufficiently high bit 
rate. Because it's a two-pass method, it'll take twice as long to create the video as one-pass methods will. Since the 
bit rate will be consistent for the entire video, it should work well for videos that you intend to stream over a network or 
the internet.

Variable Bit Rate with Quality Setting: Using this encoding method with the quality slider at its highest setting 
usually results in higher quality videos than any of the other encoding methods. However, the resulting video files tend 
to be about three times larger, as well. Use this method if quality is absolutely the highest priority. This is a one-pass 
encoding method, which means it will take roughly half as long to create the video as with two-pass methods. (The 
number of passes refers only to the creation of the video, and doesn't affect the speed of video playback.)

Variable Bit Rate with Bit Rate Ceiling: This two-pass method uses a variable bit rate, which means that it's likely 
(but not guaranteed) to produce smaller file sizes than the constant-bit-rate methods. With variable bit rate encoding, 
the bit rate you choose will be the average bit rate, but actual bit rate during playback may vary depending on how 
complex the video is. (Sections of video with lots of motion will probably have a higher bit rate, and sections with little 
motion will have lower rates.) This method has a max rate ceiling, which means that it'll keep the highest bit rates from 
being much higher than the average bit rate. Consequently, this method will work better for streaming than the 
Unconstrained Variable Bit Rate method, but may not produce video of quite as high a quality.



Variable Bit Rate (Unconstrained): This method is similar to the VBR with Bit Rate Ceiling method, just above, but 
lacks the bit rate ceiling. This means that while your specified bit rate will be the average bit rate for the video, the bit 
rate could reach infinitely high (or at least really, really high) levels during short sections of the video. This could cause 
playback to get choppy during these sections if you're streaming the video, but can also result in higher quality for 
these sections, making it a better choice for video that you're planning to playback from a hard drive.

Audio Quality: This section lets you choose the quality of the audio that accompanies your video. It will list all the 
available WMA audio-quality options installed on your computer that are compatible with WMV video. Audio almost 
always uses much less disk space than video does, so choosing a high audio quality setting will rarely have much 
relative effect on the overall size of your video. 128 kbps will usually produce good results for music audio quality. 

Sound Workspace
Sounds - Caret - Selections - Zooming

Click on an area for more explanation.

Caret 

The caret is the point at which editing operations occur.  The caret is set by clicking down in the workspace or on a 
sound.    The caret is made up of a line and 2 triangles.  The triangles show you which track the caret is on.

The caret will obey the current Snap Setting.  Thus, if your snap setting is set to snap to measures, clicking in the 
middle of measure 3 and 4, will cause the caret to move to measure 3.  

New sounds and recordings are added at the caret position.  After adding a new sound, the caret will move to the end 
of the sound.  The caret is also the point at which selected sounds will be split.

You can move the caret around by clicking the mouse or by using the keyboard 

Selections
A selection is an area that you'd like to edit or work on.

Click down on the Sound Workspace or on a sound and then drag the cursor to create a selection.  Selections show 
up as transparent rectangles.  Selections obey the snap setting.



In this example, the user has clicked down in the Sound Workspace area and while holding down the mouse button, 
moves the mouse towards the sound.  The user continues to drag the selection rectangle over the sound.  (The sound 
becomes selected as the selection rectangle intersects it.)

You can also make a selection by clicking on the sound and dragging. (Note that the cursor should look like an I-
Beam cursor .)

As you move the mouse, the selection changes.

Selecting Individual Sounds
You can also select sounds by clicking on a sound's title bar.

You can toggle the selection of multiple sounds by holding down the Ctrl or Shift key and clicking the title bar of each 
sound.

Selecting All Sounds On A Track
To select all sounds on a track, click on the track to select it.  Choose Select All Sounds On This Track from the Track 
menu.  Alternatively, you can double click a track header or use the keyboard shortcut Ctrl+Shift+A.

Selecting All Sounds In Project
To select all the sounds in the project, choose Select All from the Edit menu or use the keyboard shortcut Ctrl+A.

Unselect Sounds
To unselect any selected sounds, push the Esc key.

Operations That Work On Selections
Once you've made a selection, you can cut, copy and paste the current selection.  Other operations that use a 
selection include: Splitting sounds, removing space between clips, trimming silence, normalizing sounds, merging 
clips, creating fades or boosting or reducing audio. 

Zooming
Zoom to get a closer view or a larger view of the sound workspace.  The software will zoom to the last Caret position 
or the last mouse click, whichever was last.



Zoom Via The Mouse Wheel
The easiest way to zoom is to spin the mouse wheel, assuming you have a mouse wheel on your mouse.  (The 
mouse wheel is usually located between the left and right mouse button.)

Zoom Via The Keyboard
Push the - key to zoom out and push the + key to zoom in.  To zoom so that the entire project is visible, push the 0 
key.  Alternatively, you can choose Zoom In, Zoom Out or Zoom To Project from the View menu.

Zoom Via The Toolbar
Click the zoom buttons on the toolbar.

 - Zoom Out

 - Zoom In

Effects
Global or Master Effects
The global or master effects can be accessed by clicking the Effects button on the time line and are also located on 
the Project Details Tab.  The global effects are applied to all sound being produced by Mixcraft. 

Track Effects
To view a specific track's effects, click on the track's FX button.  Additionally, a track's effects are also mirrored on the 
Track Details Tab.  

Click on an area for more details.

Adding Effects
Deleting Effects
Effect Presets
Muting Effects
Reordering Effects
Editing Effect Properties
Automating Effect Parameters
Effects Included In Mixcraft
Adding Effects To A Send Track

Adding Effects
To add an effect, click the drop down labeled <Select An Effect> and choose an effect.  If you want to add effects to a 
track, you can click the FX button on the track to bring up its effect chain.  To edit the global or master effects, click the 



Effects button on the toolbar.

Choose a preset or fine tune each effect.

Add multiple effects in this manner.  The order is important.  (The effects process the sound from top to bottom).

(In the above example, there are three effects added: Acoustica Compressor, Acoustica Delay and Classic Reverb).

If you have your own VST effect and it is not showing up on the drop down, you'll need to add the folder that stores 
the VST effect to your list of VST folders.  In Mixcraft, this is done in the Effect Preferences by clicking the Edit VST 
Effects Folders buttons. 

Deleting Effects
To remove or delete an effect, select the effect by clicking to the right of the Edit button.  The effect should become 
highlighted with a blue rectangle to show that it is selected.  

Click the X button to remove the selected effect.

The effect list is located on the Project Details tab or the Track Details tab.

(In the above example,  Acoustica Delay is selected and would be deleted if they clicked the red X button). 

Effect Presets
After adding an effect, you can choose a preset under the Preset column.  The number of presets and preset types 
will depend on the effect.  You can create your own preset, for any type of effect by clicking the Edit button, changing 
the effect settings to your liking and then saving the preset.

(In the above example, there are three presets chosen: Percussion Tighten-Up, Slapback Echo and [Sys] Grand Hall). 



Muting Effects
You can mute an effect by unchecking the check box to the left of the effect.  This allows you to audition how things 
sound without that particular effect without losing the settings.

Note: When a track is frozen, its effects will not be editable until the track is unfrozen.

(This image shows that the 2nd effect Delay is muted). 

Reordering Effects
The order of the effects in the effect chain list matters.  You can move an effect by selecting it then clicking the green 
up or down arrows.  To select an effect click down to the right of the Edit button of the track you wish to move.

(In the above example, the selected effect is Delay.  Clicking the up or down arrow would move the Delay effect). 

Editing Effects Properties
Each effect has properties that can be changed.  For example, an EQ effect will usually have sliders that allow you to 
adjust the attenuations of different frequencies to add more bass or reduce the treble.  Each effect has its own 
interface.  View our bundled effect list here.  

Click the Edit button to edit all parameters or values for an effect.  

Here is an example of how the bundled Classic Flanger looks:



Each effect interface will have the same controls on the top of the effect window which allow you to choose a new 
preset, save a preset or delete a preset.

Active Checkbox
This determines whether or not the effect is muted or heard.  If it's unchecked, it is muted and is bypassed.

Preset Drop Down
Choose a preset.  If the preset is factory default, it may have [Sys] at the start of the preset name.

 Load VST Preset File (VSTs or VSTi's only)
Some VST effect and instrument manufacturers will distribute additional banks of sounds, in the form of .fxb files.  
These files replace your current presets with a new set of presets, given your effect or instrument a whole new range 
of sounds.

To load a preset file, click the 'Load VST Preset File' button.  Locate the .fxb file on your hard drive and select it, then 
press OK.  The .fxb file will then load into your instrument or effect, and your preset list should change.
 
The .fxb file you select must be designed specifically for the VST instrument or effect that you are using.  If the file you 
select is incompatible, an error message will be displayed.

 Save New Preset
The disk icon allows you to save or re-save a preset.  Change the values of the effect parameters and click this to 
create your own preset.

 Delete Preset
Click the X button to delete the current preset.  (You can only delete presets that you've created.)

Automating Effect Parameters
Each effect has parameters or values that can be automated or changed over time.  

For example, you can change the amount of flanger over time.  To do this, add the "Acoustica Flanger" effect to a 
track.  

Then click the track header's "Toggle Automation" button  to show the automation lane.
Choose the effect parameter you'd like to automate.  In this case, we choose 'Feedback'



After that, we can draw in automation points to change the feedback over time.

Tip: If you want to send a part of a track to be automated, the easiest way is to create a Send Track, add the effect to 
the Send Track and then select the Send on the automation drop drown and adjust the amount of signal sent to the 
Send.  

For example, if you wanted to add a delay on a specific word, create a Send Track, add a Delay effect such as 
Acoustica Delay, then choose the Send Track from the automation drop down on the source track.  Finally, draw in 
automation around the word you'd like to echo.  

Automating Global/Master Effects
You can automate any master or global effects in the same manner by Showing the Master Track.  

Effects Included In Mixcraft
There are several effects included by default with Mixcraft and are detailed below.

Acoustica Chorus
Chorus effects are used to thicken up a sound, such as a vocal or guitar recording.  This effect is often used to give 
the impression that there is more than one instrument or vocalist performing the same part.  The effect introduces tiny 
variations in pitch, as well as small amount of delay, into the original audio to give the effect of multiple audio sources 
performing at once.  

Acoustica Compressor
Compressor effects are used to reduce the difference in volume between quiet sounds and loud sounds in a 
recording.  This effect is often used on vocals and drums, where some portions of the sound are very quiet, and other 
portions are very loud.  By reducing the difference in volume of the quiet and loud parts of a recording, you can then 
make the recording as loud as desired, and the quiet portions will sound louder than they did without the compressor 
effect.

Acoustica Delay
Delay effects are often the simplest and most musically useful effects.  Quiet simply, they take incoming audio, wait a 
certain amount of time, and play the audio back, sometimes at a lower volume.  This creates an echo effect, such as 
hello, hello.  The Feedback parameter allows you to send some of the delayed audio back into the delay effect, so it 
will play again after the delay period.  This can be used to create a long series of echoes, such as hello, hello, hello,  
hello, hello.

Acoustica Distortion



The Acoustica Distortion effect is used to add audio distortion to a recording, similar to that used on electric guitars.  
This effect can range from subtle grit to extreme destruction of the original audio.  Note that adding distortion can 
severely affect the volume of the recording.  Also note that a little distortion goes a long way!  You may want to 
experiment with very low settings to see how the audio is affected, and increase the settings as you see fit.

Acoustica EQ
The Acoustica EQ effect is a 10 band graphic equalizer with gain control.  The equalizer allows you to boost or reduce 
the audio frequencies that make up the sound of your recording.  If, for example, your recording sounds tinny, you can 
boost the bass frequencies.  If your recording sounds too 'bright', or if you wish, for example, to reduce the volume of 
acoustic guitar finger squeaking, you might want to reduce some of the high frequencies in the recording.  The Output 
Gain control is used to raise or lower the volume of the recording after the EQ is processed.

Acoustica Flanger
The Acoustica Flange effect is similar in nature to the Acoustica Chorus effect, and features the same controls.  Unlike 
chorus effects, which are used to subtlety thicken up a sound in natural-sounding ways, flange effects are more 
dramatic, and are used to create audio that sounds unusual and unnatural.

Acoustica Reverb
Reverb effects, like delay effects, are some of the most useful effects in music.  They are used to recreate the subtle 
echoes and reverberation of a natural room.  For example, most people know that they sound better when they sing in 
the shower.  This is because your voice bounces off the walls of the shower, and these echoes serve to improve the 
sound that you hear.  Likewise, a single violin or piano playing in a large church or auditorium takes on new life, when 
the last note bounces around the room and fades away long after the musician has ceased playing the instrument.  
The Acoustica Reverb effect can be used to recreate the ambiance of many different environments, ranging from 
small  spaces to exceptionally large chambers.  The High Frequency Damping control allows you to set the amount 
that the reflected audio's high frequencies are muted.  Carpeted rooms, for example, will absorb most of the high 
frequencies, but large empty houses with marble floors sound extremely bright and 'echoey' in comparison because 
the high frequencies are not dampened.  

Classic Auto-Filter
This extremely powerful effect can be used to produce filtering effects which change over time.  For example, you can 
create a low-pass filter effect such that the sound will be bright, then fade to a dull sound over the course of a second, 
then fade back to a bright sound over the next second, with this cycle repeating throughout your use of the effect.  The 
LFO Sync function allows you to synchronize the timing of these changes with the tempo of your recording.  Instead of 
setting a static time, such as 1 second, you can set the number of beats or fractional beats used to complete a cycle 
as the current tempo.  So with each beat, for example, the effect can complete a cycle, or you can set the effect to 
wait 4 beats (i.e. one measure) to complete an effect cycle.  This effect practically demands you experiment with it to 
learn all of the powerful things it can do!

Classic Chorus
This effect is similar to the Acoustic Chorus effect, with some additional features and a unique sound.

Classic Compressor
This effect is similar to the Acoustic Chorus effect, with some additional features and a unique sound.

Classic Delay
This effect allows you to create echo and delay effects, just like the Acoustica Delay effect.  However, this effect goes 
much further, with several outstanding features.  Most exciting is the Sync feature, which allows you to sync the delay 
amount to the tempo of your song.  Instead of setting a static time for each delay, such as 1 second, you can set the 
number of beats or fractional beats before the delayed sound is played.  In this way, you can have sounds delay every 
eight note, every quarter note, every measure, and more!  Synced delay effects are extremely useful in music.  A 
delay effect with some feedback, with one quarter note delay, can turn a simple percussion parts into a huge-sounding 
orchestration, with all echoed sounds occurring on the beat and at the correct tempo.  You can also use the Classic 
Delay effect to recreate the sound of analog delay effects and tape delay effects from the 70s.

Classic EQ
Similar to the Acoustica EQ effect, the Classic EQ effect gives you individual control over the left and right channel of 
your recording.  This can be used, for example, to create interesting stereo effects, where one speaker emphasizes 
different frequencies than the other speaker.

Classic Flanger
This effect is similar to the Acoustic Flanger effect, with some additional features and a unique sound.



Classic Master Limiter
Similar to the Acoustica Compressor in function, the Classic Master Limiter is designed to be used as a Project level 
("Global") effect.  This effect will take your finished recording and make it sound louder and more consistent overall.  
With most modern forms of music, it is often desirable that the final 'mastered' version of the song be as consistently 
loud as possible, to capture people's attention on CD and over the radio.

Classic Phaser
This effect is similar to the Acoustic Phaser effect, with some additional features and a unique sound.

Classic Reverb
This effect is similar to the Acoustic Reverb effect, with some additional features and a unique sound.

Pultronic Tube EQ 
The Pultronic Tube EQ by G-Sonique is a detailed recreation of the classic vintage vacuum tube-based equalizer 
found in top studios throughout the world. Warm up your tracks or add a completely new character to your sound with 
the Pultronic Tube EQ's array of tube models and killer presets.

Shred Amp Simulator
The Shred Amp Simulator by AcmeBarGig, a complete guitar amp and cabinet suite containing 5 classic amp heads, 
17 cabinet models, and 6 powerful effects.  Shred faithfully models classic British and American tube heads, and adds 
powerful room modeling technology.  From crisp cleans to roaring leads, Shred gives you instant access to $20,000 
worth of classic guitar gear.

Voxengo Amp Simulator
This is an guitar amplifier simulator allowing you to process your guitar or voice to sound like it is going through a 
variety of amps.

Voxengo Spectrum Analyzer
This is a unique effect that does not actually process or change the audio and, instead, allows you to view the 
frequency spectrum of the audio.  This is great for learning about audio frequencies and for helping you to analyze 
your final mix.  You will need to click the Edit button on the effect chain list in order to make use of this effect.

Adding Effects To A Send Track
When adding an effect to a Send Track, it is recommended to choose a preset designed for being on a Send Track.  
Many effects will list this with the word Send in it.  

For example, when selecting the "Classic Reverb", choose "Grand Hall (Send)" or "Small Club (Send)"  

When using any effect, make sure to click the Edit... button and adjust the dry mix down to 0% and the wet mix to 
100%.

For example, when selecting "Acoustica Reverb", click the Edit... button and then adjust the Wet Mix to 100% and the 
Dry Mix to 0%.

Master Bar
Click on an area for more details.

Recording



Playback Controls
Playback Position Display
Loop Playback Mode
Metronome
Recording Count-In
Master Volume

Changing the Tempo or Key Signature
You can change the tempo or key signature by double clicking the current tempo area.  This will pop up the first 
marker, allowing you to edit the tempo, time signature and more. 

Recording
The record button is used to start recording on any armed tracks..  

If the mix is already playing, pushing the record button on and off allows you to punch in and out of recording mode.

Recording Problems?
Recordings Are Not In Sync
Recordings Are Drifting Or Getting Out Of Sync Over Time

Recording Resources
Arming A Track
Setting Recording Levels
Changing To ASIO Mode
Using A Recording Timer 

Playback Controls
The playback controls include play/stop, fast forward, rewind, fast forward to the end, and rewind to the start.

Play / Stop
Starts and stops playback at the current playback indicator position.  Learn how to repeat or loop a section of audio 
here.

Rewind
Rewinds the playback indicator by a measure or so. 

Fast Forward
Fast forwards the playback indicator by a measure or so.

Rewind To Start
Resets the playback indicator to the start of the project.

Fast Forward To End
Resets the playback indicator to the end of the project.



Playback Position Display
This is the green readout that shows the current playback indicator time or measure and beat position.  In addition, the 
display will show the current tempo, time signature and key. 

Loop Playback Mode
In some cases, you might want to repeat playback of a section of audio.  For example, if you are practicing a part 
before recording or adjusting effects on a section, you might want to continuously play a selected section of audio.  

This should not be confused with looping sounds, though.

To loop playback of a section of the project, click the Loop Playback Mode icon  on the Master Bar and it will 
become highlighted in yellow . Click the Master Bar's Play button and it will play the selected loop area until you hit 
Stop.

The loop area will be highlighted and the non-loop area will be shaded. Adjust the Loop Start and Loop End handles 
to change the active loop.

To turn off Loop Playback Mode, click the Loop Playback Mode icon again  .

Alternatively, you can select the Mix menu and select Loop Playback Mode to set the looping area.

You cannot record in Loop Playback Mode

(This should not be confused with looping sounds.) 

Master Volume
The master volume on the Master Bar adjusts the level of the entire mix.  Move the slider left or right to set the desired 
volume.  Alternatively, you can right click on the Master Bar and select Master Volume or choose the Mix menu 
followed by clicking Set Master Volume followed by picking a level % or specifying an exact value.

Changing Master Volume Over Time
If you want to change the volume over time automatically, you can show the Master Track and then add some volume 
automation points.  More on automation...   

Timeline
The timeline displays in time or beats mode.  It also contains markers which includes tempo changes, key changes 
and time signature changes.

This shows a timeline in measures and beats mode.

Click on an area for more details.



Markers
Playback Indicator
Switching To Time View
Switching To Measures and Beats View
Snap Settings 

Markers
Markers can be used for marking a specific time with text such as "Chorus Begins Here" or they can contain tempo, 
key or time signature changes.  In addition, markers can indicate new CD tracks or mix down tracks.

Adding Markers
Moving Markers
Editing Markers
Deleting Markers
Automatic Marker Wizard
Marker Name
Marker Color
Tempo
Key
Time Signature
CD Marker
Metronome Details 

Adding Markers
There are several ways to add markers.  

  Click the Add Marker above the tracks and to the left of the time line.  The marker will be added at the 
time offset of the playback indicator.  If snapping is on, it will adjust based on the Snap Settings.

You can also double click the time line to add a marker or right click on the time line and select Add Marker... Other 
methods of adding markers include clicking the Mix menu followed by clicking Markers followed by clicking Add 
Marker... or by clicking the Mix menu followed by Add Tempo / Key Change.

Markers obey the current Snap Settings.  Markers with time signature changes always snap to the measure, as it 
doesn't make a lot of sense to add a time signature change in the middle of a measure. 

Moving Markers
There are two ways to move a marker.

Drag A Marker
Click on the top of a marker on the time line and drag it to the left or right to reposition it.  It will obey the snap settings 
when dragging it.

Edit The Exact Time
You can edit a marker by double clicking it or by right clicking it and choosing Edit...  Alternatively, you can click the 
Mix menu, followed by Markers, followed by Edit, followed by the marker you'd like to edit.  On the Edit Marker dialog 
(shown below), adjust the offset time of the marker.



Use the up and down arrows next to the minutes, seconds or milliseconds for the marker to adjust the time offset.  
Click the green play button to play the mix from this offset.

Note that you cannot adjust the offset so that it conflicts with another marker. 

Editing Markers
You can edit a marker by double clicking it on the time line or by right clicking it and choosing Edit...  Alternatively, you 
can click the Mix menu, followed by Markers, followed by Edit, followed by the marker you'd like to edit.  

Deleting Markers
Right click on a marker on the time line and select Delete to remove a marker.  (Note that you cannot delete the first 
marker and may only edit it.)

Delete All Markers
Click the Mix menu and select Markers followed by Delete All Markers.  This will delete all markers besides the first 
marker. 

Automatic Marker Wizard
The track marker wizard is a handy way to add multiple track markers at a time.  You can either choose to add 
markers at specific intervals, or you can add markers based on the silence in a sound.  It will even remove the 
silence!  This can be very handy if recording albums from the Internet, LPs or cassettes and need a quick way to 
break up the tracks!

Intervals
Choose At Intervals Of to set markers at an equal spacing for a period of time.

Based On Silence Of Sound
Choose Based On Silence Of Sound to create markers based on the gaps of audio in a recording.  

Select the sound to create markers based on from the drop down.  Each new marker will be created based on a 
detected threshold of silence (The default Silence is 7% of Full Volume).  In order to create a track marker, there must 
be a minimum number of minutes before considering a new track marker (The default is one minute).  Click Remove 
And Trim Silence to make sure that it removes silence and splits the recording into multiple clips.  Choose Fade 
Edges By to set the number of seconds to fade the start and end of the clips by.

CD Track Markers
Choose CD Track Markers to make each new track created also be a CD track marker for burning to a CD.

More on Markers.. 

Marker Name
Edit the marker to change its name.  

Type in text for the name of the marker.  The name will appear to the right of the marker flag and can be used for 
lyrics or other notes about the project.   

Marker Color
Edit the marker to change its color.

Each marker can have a different color.   



Marker Tempo
Edit the marker to change its tempo.

Each marker can have a tempo.  Changing the marker's tempo will affect the metronome and cause any sounds that 
are in Adjust To Project Tempo mode to switch to this tempo.

Marker Key
Edit the marker to change its key.

Each marker can have a key.  Changing the marker's key will cause any sounds that are in Adjust To Project Key 
mode to switch to this key.

Marker Time Signature
Edit the marker to change its time signature.

Each marker can have a time signature.  Changing the marker's time signature will affect the metronome.  Note that 
this will also force the time signature to have a tempo change, even if it's the same tempo as the previous tempo 
change.

CD Marker
Edit the marker to make it a CD marker.

Click the Create Track For CDs Or Audio Files checkbox.  A CD icon will appear on the time line if it will create a new 
CD track or mix down track.

When mixing down to an audio file or burning an audio CD, the software will create a new CD track or audio file if the 
option Create Track For CDs Or Audio Files is checked.

Metronome Details
Edit the marker to change the number of beats per measure that a metronome sound is played.

In some time signatures, such as 12/8, by default, the metronome will play 12 times each measure. This can be very 
distracting and so the software allows you to adjust the number of metronome ticks per measure.

Switching To Time View
Click the eyeglasses above the track headers and to the left of the time line to switch to Time mode.  If it reads Beats, 
you can switch the time line to time mode by clicking the eyeglasses.  Click it again to switch it back to Beats mode. 



Switching To Measures And Beats View
Click the eyeglasses above the track headers and to the left of the time line to switch to Beats  mode.  If it reads Time, 
you can switch the time line to beat mode by clicking the eyeglasses.  Click it again to switch it back to Time mode. 

Playback Indicator
The playback indicator shows the current playback time or where playback will occur when you click Play on the 
Master Bar.  It is made up of a green arrow on the time line and a line in the Sound Workspace. 

If you click in the Sound Workspace 
it will set the playback indicator's 
position and cause playback to 
restart from that position.  However, 
you can configure the preferences to 
not change the playback position 
and playback indicator when click in 
the Sound Workspace.  Otherwise, 
click the time line to set the playback 
position and indicator.

Snap Setting
One convenient way to control the precision of copy, paste, looping, moving and other operations is to set the snap 
level.  

  You can change the snap level on the time line or by clicking the View menu followed by 
clicking Snap To Grid followed by clicking the desired snap setting.

The amount of audio that is skipped or snapped to depends on the current time signature and tempo.  Here are the 
possible snap settings:

• Off 
• Measure (Bar) 
• 1/2 note 
• 1/4 note 
• 1/8 note 
• 1/16 note 
• 1/32 note 
• 1/64 note 
• 1/4 triplet note 
• 1/8 triplet note 
• 1/16 triplet note

Tip: When making a loop, it is pretty convenient to get a sound's beats lined up by using the metronome  Then set the 
snap level to measure and select a measure or two of the sound.  Finally, make it into a loop. 



Details Area
Click on an area for more information.

Project Details
Track Details
Mixer Details
Sound Details
Loop Library
Hide or Show Details Area
Resizing The Details Area

To activate a details tab, click on the tab.  Double clicking a tab will cause the details view to hide.  Click the details go 
away & show button  to hide and show the details.  

Undocking the Details Area
You can undock the details area to its own window.  You can drag the undocked window to another area on the 
monitor or if you have multiple monitors, you can drag it to another monitor to maximize your screen real estate.   To 
redock the window, click the [x] go away button on the window. 

Hide Or Show The Details Area
 If you want to see more tracks, click the Hide Details button on the upper right portion of the Details Area.

  If you want to view the Details Area, click the Show Details button on the bottom right of the screen.

Click here for information on resizing the Details Area.

Undocking the Details Area
You can undock the details area to its own window.  You can drag the undocked window to another area on the 
monitor or if you have multiple monitors, you can drag it to another monitor to maximize your screen real estate.   To 
redock the window, click the [x] go away button on the window. 

Resizing The Details Area
You can resize the details area by clicking on the bottom of the Master Bar and dragging it up or down.  

  The cursor will turn into a Resize Interface cursor.

This is what you need to do to resize the loop library.

Undocking the Details Area
You can undock the details area to its own window.  You can drag the undocked window to another area on the 
monitor or if you have multiple monitors, you can drag it to another monitor to maximize your screen real estate.  To 
redock the window, click the [x] go away button on the window. 

Loop Library
The loop library contains a number of song kits and sound effects for royalty free use within your own projects!  Feel 
free to mix them, loop them and edit them to your heart's content.



Sound Category
Sounds In Library
Downloading Sounds
Update Loop Library 

Sound Category
On the Loop Library page, click the Category drop down to select a new category.  This allows you to view the library 
in a variety of categories.  Choose from the following:

• Tempo Range 
• Key 
• Mood 
• Style or Genre 
• Instrument 
• Name 
• Song Kit (Default) 
• Date

You'll find a list of category ranges below the Category drop down control.  Click on an item to populate the current 
library sounds.  For example, in the Song Kit category you will find the following items: 12-8 Blues, Acid Techno, 
BDiddley, Blues Shuffle, Country Rock, Country Shuffle, Disco, Dub, Electro Groove, Funk Rock, Hip Hop, Music 
Beds, Power Ballad, Punk, Reggae One Drop, Sludge Metal, Sound Effects, and Speed Metal just to name a few.

Sounds In Library
After choosing a category, you will see the sounds that fit into the chosen criteria.  

Click the blue Play button  next to a sound to audition it.  If you are playing back your project, the software will 
automatically beat match the auditioning library sound to the current tempo.

Add the sound by clicking the green Add Sound button  or drag the sound into the Sound Workspace.

Downloading Sounds
One of the neat features of Mixcraft is that all the loop library sounds are downloaded on demand from our servers.  If 
you click the play icon or add icon and the sound does not yet exist on your computer, the software will download it 
from the Internet.  (Of course, to receive any new sounds, you'll need to be connected online.)



Loop Library Details
You can sort the sounds in this view by clicking on any column header.  To sort the column in descending order, click 
the column again.

Each sound shows the following columns:
• Name 
• Tempo 
• Number Of Bars (#) 
• Time Signature (Sig) 
• Key 
• Instrument 
• Style 
• Song Kit 
• Mood #1 
• Mood #2 
• Author 
• File Location

Each column has two black separator bars and if you move the mouse over the black separator bar, it will turn into a 
left-right resize cursor  which allows you to resize the column.  Double clicking the black separator bar resizes the 
column to fit the largest text in the column. 

Downloading Sounds
If a sound in the library is not on your computer's hard drive and you request the sound, either by playback or by trying 
to add it to the project, the software will download it from our servers.

If you are having download problems, try switching your default download server in the preferences.

All downloading will occur on the Loop Library Tab.

Download All Sounds In View
Click the Download All Sounds button  to download all sounds in the current library view.

Cancel Download(s)
If you want to cancel the current download or pending downloads, click the Cancel Download button. 

Update Loop Library
Periodically, we will be adding new sounds and loops to download.  We will probably mention the new loops or sounds 
in our free newsletter, as well. Click the Loop Library Update button  or choose Check For Updates... from the 
Help menu.  If there are new sounds or loops, the software will inform you that the library has been updated.  To see 
the new sounds, choose the Date category and pick the most recent month. 

Preferences
Preferences are options that are changed infrequently and allow you to customize how the software behaves.  To 
open the Preferences, click Preferences... from the File menu (Ctrl+P).

Sound Device
Recording
MIDI
General
Project Defaults

http://www.acoustica.com/newsletter/index.htm


Library
Metronome
Effects
Display
CD Burning

Click Help for help on the current preference page.  Click OK to allow any changes while in the Preferences.  Click 
Cancel to cancel any changes made. 

Sound Device Preferences
Choose settings for your sound devices.

Driver
You can choose from Wave or ASIO or WaveRT mode. This choice changes the rest of the controls available on this 
page.  The ASIO option will be unavailable if no ASIO drivers are found on your computer.  (WaveRT mode is only 
available on Vista.)

Force Single CPU
This will force the sound engine to use a single CPU for mixing audio.  This is only applicable to machines with 
multiple CPUs, such as a Dual-core or Quad-core computer.  If you have one CPU on your computer, this option will 
not be available.  You can use this option for better compatibility with older VST effects and virtual instruments.

Use High Priority Threads For Audio Engine
This will cause all audio mixing sound engine threads to mix at a high system priority.  By default, Mixcraft will mix at 
high priority. 

Default Settings
This button will reset your driver and settings to the default.  This will change your settings to the Wave driver at 
44,100 Hz, stereo, 16 bits ( 8 buffers @ 16384 bytes). 

Wave Preferences
These are the preference options if Wave mode is selected in the Sound Device Preferences.

Tip: Always make sure that you have the latest drivers for your sound device or sound card.  Visit your sound device 
or sound card manufacturer's website.

Default Input (Recording)
Choose the default sound device from which to record audio.  Please note that on Vista, you may need to make sure 
the device is on and plugged in, otherwise it may not show up.

Default Output (Playback)
Choose the sound device from which to play audio.  Please note that on Vista, you may need to make sure the device 
is on and plugged in to the speakers, otherwise it may not show up.

Sample Rate
Choose a sample rate for both recording and playback.  44100 is the default for CD quality.  Mixcraft supports sample 
rates up to 192000, if your sound card supports it.  

Bit Depth
This is the number of bits per sample.  16 is the default for CD quality.  Mixcraft supports bit depth of 24 bit for ultra 
high quality.  Only use 8 bit if you have to (8 bit sounds very noisy).

Number Of Buffers
This is the number of audio buffers to pre-mix before starting playback.  The number of buffers will determine the 
latency.  More buffers lead to higher latency.  Fewer buffers lead to lower latency but possible audio gapping.  

Buffer Size



The size of the buffer also determines the latency of the software.  Larger buffers lead to higher latency.  Choosing 
different buffer sizes may help the software work better with your sound card or sound device.  Smaller buffers lead to 
lower latency but also possible audio gapping.

Open Mixer...
This button opens the Window's mixer to allow you to configure the inputs or recording levels for your sound devices.

ASIO Preferences
These are the preference options if ASIO mode is selected on the Sound Device Preferences.  ASIO is an alternative 
driver system that allows for lower latency and better synchronization between playback and recording.

Tip: Always make sure that you have the latest drivers for your sound device or sound card.  Visit your sound device 
or sound card manufacturer's website.

Default Input (Recording)
Choose the default sound input to record audio from.  Please note that on Vista, you may need to make sure the 
device is on and plugged in, otherwise it may not show up.

Default Output (Playback)
Choose the sound output to play audio from.  Please note that on Vista, you need to make sure the device is on and 
plugged in to speakers, otherwise it may not show up.

ASIO Device
Choose the default ASIO Device to record from.  ASIO only allows for one device at a time.

Open Mixer...
This button opens the ASIO mixer for the ASIO Device and allows you to choose the latency settings and other more 
advanced settings.  (The ASIO mixer is made by a 3rd party and will look different depending on what type of sound 
device you have.)

WaveRT Preferences
These are the preference options if WaveRT mode is selected on the Sound Device Preferences.  WaveRT stands for 
Wave Real Time and is Microsoft's new audio driver layer for Window's Vista only.

Latency
Adjust the number of milliseconds of latency that you'd like.  Lower numbers are better for performance.  However, as 
you lower the latency, you are also increasing the potential for audio gapping or non-continuous audio.

WaveRT is the preferred driver.  Make sure that you have the latest drivers for your sound device.  Also, contact your 
sound device manufacturer to see if the audio drivers support WaveRT properly.

Exclusive Mode
For Windows 7, you have the option of running Mixcraft in Exclusive Mode.  This will take over exclusive control of the 
sound device.  Adjust the latency to less than 20 milliseconds!  Note that when you go into Exclusive Mode, other 
programs will not have access to the sound device and will have to be restarted after Mixcraft is either shut down or 
out of Exclusive Mode in order for sound to play again in them. 

Recording Preferences

Default Project Recording Folder
This folder is the default recording folder.  Each project has its own recording folder that is initially assigned to this 
folder.  Click Browse... to choose a new default recording folder.



Delete Unused Recordings During Save Or On Exit
If this option is checked, Mixcraft will delete any recordings made that are not currently on any tracks during a Save or 
when the software is exited.  If you've noticed that your recordings are disappearing from your recording folder, it may 
be because they were not part of the project.  To stop recordings from being deleted, uncheck this.

When Recording Input Is Used On More Than One Track
This instructs the software on how to handle two different tracks trying to use the same recording input.  

The default is Do Not Allow Duplicate Recording Inputs.  This will cause the newly armed track to get the input and 
any previously armed tracks to become unarmed.  

The second option Allow Duplicate Recording Inputs allows you to arm any tracks, including the option of arming all 
tracks with the same recording input.  With this option, you could actually record 5 tracks of the same recording and it 
is up to you to disarm tracks that you do not wish to record.

Recording Format
Choose from uncompressed WAV or compressed OGG.  OGG allows you to save disk space on your hard drives, if 
audio quality does not have to be perfect.  If you choose OGG, you will be able to also choose a quality setting. 

MIDI Preferences
These preferences are for M.I.D.I.

MIDI Input (Recording) Interface
If you have MIDI interfaces or MIDI keyboards, choose the interface that you'd like to play and record from.  The 
default is All MIDI Devices.

"Chase" Unfinished Midi Notes on Playback And Looping
MIDI is not actual sound.  MIDI is the instructions to play sound.  Therefore, what happens if you start playing a note 
in the middle?   If you play a piano note and it starts off vibrant and decays over time, MIDI has no way of telling the 
synthesizers to start playing the note from the middle.  It assumes that it should start from the beginning each time.  
When "Chase" is on, it means that we send Note On messages even if we are not at the exact beginning.  This will 
lead to a different sounding performance depending on where you start your playback from.  The converse with 
"Chase" off, means that if you start in the middle of a note, it will not play and will simply be skipped.

Default Virtual Instrument
Choose an instrument to be the default instrument when creating a new Virtual Instrument Track.

Default General MIDI (GM) Instrument
Mixcraft will use this synthesizer when importing General MIDI files (.MID).

Default MIDI Settings
This button will revert this page back to the default settings. 

General Preferences
These are the general options that weren't special enough to have their own preference page. :)

Play Exported Files After They're Created
After you mix down to an audio file, this option will launch the associated player to play it.

Set Playback Indicator When Clicking Inside Sound Workspace
When clicking in the Sound Workspace, this option will set the Playback Indicator at the click location.  It will also 
restart playback from this location if the project is playing back.

Change Project Tempo And Key To Match First Sound
When adding loops or sounds with a known key or tempo, the software will change the master tempo and/or key so 
that it sounds good.  For example, if a sound was normally at 68 bpm and you tried to play it at 120 bpm, it would 



sound terrible.  Time stretching works best when the tempos are no more than 10 to 30% different.  This option 
conveniently sets the tempo or key of the project to match the sound's tempo or key.

Ask To Change Project Tempo And Key On First Sound
This option will cause the software to prompt you to see if you want to change the tempo or key for the Change 
Project Tempo And Key To Match First Sound option mentioned above.

Temporary Files Directory
Choose a directory to store any temporary files used by Mixcraft, such as peak data, beat map data and other data to 
make the software run smoother.  Click Browse... to choose a new directory.

Delete Temporary Files
This will delete all temporary files and folders under the Temporary Files Directory listed above.  This includes all .tmp, 
.isk, .beatmap .isk, and .ipk files used in Mixcraft.

External Wave Editor
Choose an external wave editor to be used with the Edit In External Editor feature.  Click Browse... to locate the 
executable file (.exe) that runs the external audio editor. 

Project Defaults Preferences
This defaults are used when creating new projects.

Author
The default author will be filled into each new project's author information.

Copyright
The default copyright notice will be filled into each new project's author information.

Tempo
The default tempo.  (Default is 120 bpm.)

Key
The default key.  (Default is C)

Time Signature
The default time signature.  (Default is 4/4 time.)

Show New Project Dialog
This option will cause the New Project Dialog to display whenever you start the software or start a new project.   

Library Preferences
These are the loop library settings.

Loop Library Directory
This is the folder where your loop library is stored.  When you download a new loop, it is saved in this directory.  
Please note that this folder is shared for all users on the same computer.  If you are using Mixcraft in Administrator 
mode, you can change this folder location.  Schools or labs can even set the folder to be on a server, thereby saving 
space on each workstation.  Type in a new folder path or click Browse to select a new folder.

Loop Library Download
Select a Loop Library download site from the drop down.  Click here if you are having problems downloading sounds. 

Metronome Preferences

Metronome Sound File (Measure)



Choose the sound that plays at each measure boundary.  The default is a sound called HighTone.wav and is located 
in your Mixcraft folder under Program Files.  Click Browse... to choose a new sound.

Metronome Sound File (Beat)
Choose the sound that plays at each beat, besides the measure beat.  The default is a sound called LowTone.wav 
and is located in your Mixcraft folder under Program Files.  Click Browse... to choose a new sound.

Metronome Volume
Choose a volume for the metronome. 

Recording Metronome Count-In (Pre-Roll)
Set the optional number of measures to start the metronome before recording. 

Effects Preferences

Load DirectX Effects
This option will cause the software to load DirectX effects upon start up.

Load VST Effects
This option will cause the software to load VST effects upon start up.

Edit VST Effect Folders
Click this button to add, edit or delete folders that the software will scan for VST effects.   

Display Preferences

Auto-Scroll During Playback
This option causes the software to automatically scroll the Sound Workspace to follow playback indicator.

Conserve CPU Mode
For slower computers, this option will cause the screen to redraw less frequently to save your computer's processing 
power for mixing audio, instead.

Display Volume As:
Choose between Decibels or Percentage.  This will affect the track volume sliders and editing volume on the sound.

Default Track Color
Choose a default track color.  (The default is green.) 

CD Burning Preferences

** Note - the CD Burning Preferences are not available in Mixcraft LE (Light Edition).

Burning Engine
Choose between Primo,  Goldenhawk or IMAPI. 

Primo is the default and recommended CD burning engine.  It will burn audio CDs without gaps between tracks, as 
well as CD-Text.

If supported, our alternate CD burning engine called Goldenhawk will be able to burn audio CDs without any gaps 
between CD tracks, as well. 
 
IMAPI is Windows default way to burn audio CDs.  The draw back is that if you are burning more than one track, it 
inserts a two second gap between tracks and it automatically converts to wav before burning.



Goldenhawk Drive Override...
This allows you to attempt to use a generic driver or a driver of a similar CD recorded model if your CD writer is not 
supported.  (This is only available when Goldenhawk is chosen.)

Use Acoustica ASPI Layer
Toggling option may help the software recognize or 'see' the CD writer while in Goldenhawk mode.  (This is only 
available when Goldenhawk is chosen.) 

Menus & Toolbar
Menus
File - Edit - Mix - Track - Sound - Video - View - Help

Toolbar Buttons

 New Project
Create a new project.

 Load Project
Load an existing project or template.

 Save Project
Save the current project.

 Add Sound
Add a sound to the Project. (MP3, WAV, AIF, OGG or WMA)

 Show Loop Library
Shows the Loop Library details area.

 Undo Last Action
Undo your last action or command.

 Redo Last Action
Redo an action that you've 'un-done' via Undo.

 Burn Audio CD
Burn your project to a standard audio CD.

 Mix Down
Mix down your project to a single audio file.

 Zoom Out 
Zoom out to view more time.



 Zoom In
Zoom in for a closer view.

Preferences
Brings up the Preference dialog.

 Buy or Register Mixcraft
Purchase Mixcraft and enter your registration information.  More on purchasing and registration.

 Select Envelope
Selects the current envelope type for all sounds in workspace.  Choose from Volume, Pan, Low Pass Filter, Low Pass 
Resonance, High Pass Filter, High Pass Resonance.

 Snap Settings
The Snap Setting allows you to edit in precise lengths of measures, 1/4 notes, 1/8 notes or one millisecond 
precisions.  To turn snap off, click the snap button and choose "Snap Off".  To snap to the measure, choose "Snap 
Measure" or "Snap Bar". 

File Menu

New Project (Ctrl+N)
Creates a new project and shows the New Project Dialog.

Open Project... (Ctrl+O)
Opens or loads an existing project or template.  Add

Save (Ctrl+S)
Saves your current project.  If you have not saved it before, it prompts you to name it and select the save type as 
described below in the Save As... section.

Save As...
Saves your current project or mixes down to audio file depending on the Save as type format selection.

Save As MIDI File...
Saves your Virtual Instrument Tracks as a MIDI file.  More info...

Copy Project Files To...
Copies Project Files to a folder or a new ZIP file.  This is useful for backing up your projects (i.e. to CD), for easily 
reorganizing your project files, or for collaborating with others.  For example, you can quickly zip up your project, 
including all included loops, videos and recorded sounds, and e-mail it to another person.

Mix Down To
This menu has four formats in which you can mix down to.  Choosing one of the mix down options for audio (WAV, 
MP3, OGG and WMA) or for video (AVI and WMV) will bring up the Save As dialog with the chosen mix down format.

Burn CD... (Ctrl+B)
Burn an audio CD compatible in any standard audio CD player.

Label CD...
This will launch the optional Acoustica CD/DVD Label Maker so that you can make print a CD label, etch a 
LightScribe disc or print on a direct-to-CD printer.

http://www.acoustica.com/cd-label-maker/


Print...  (Ctrl+P)
Prints the notation display, if currently selected.

Preferences
Bring up the Preference Dialog.

Recent Projects
This is a list of the last ten projects that you have loaded or saved.  It is a convenient way to load a previous project.  
Select one of the recent projects on the pop up menu to load it.

Exit
This will close down the software.  It will ask you if you want to save before exiting. 

Edit Menu

Undo (Ctrl+Z)
This will undo any action up to the point of the last save, load or new project.  If you make a mistake, undo it.  
Alternatively, you can select the undo button on the toolbar.

Redo (Ctrl+Y)
This will redo any action that you have "undone" via Undo.  Alternatively, you can select the redo button on the 
toolbar.

Cut (Ctrl+X)
This will cut or remove any sounds or parts of sounds that are currently selected or in the selection rectangle.  The cut 
operation will also store the cut sounds in the Clipboard for pasting if desired. 

Copy (Ctrl+C)
This will copy any sounds or parts of sounds that are currently selected or in the selection rectangle to the Clipboard 
for pasting if desired. 

Paste (Ctrl+V)
This will paste or insert the audio that is currently in the Clipboard .  It will paste or insert the audio at the caret 
location.  If necessary, it will create new tracks if the Clipboard buffer stored audio clips that spanned multiple tracks.

Delete (Delete)
This will remove any sounds or parts of sounds that are currently selected or in the selection rectangle.  Unlike, Cut, 
this will not store the deleted audio in the Clipboard.

Select All (Ctrl+A)
This selects all the audio in the project.

Split (Ctrl+T)
This will split any selected sounds at the time offset where the caret intersects them.

Remove Spaces Between Clips (Ctrl+J)
Removing space between the clips eliminates the gaps or silence between any selected sounds by moving the 
selected sounds together.

Merge To New Clips (Ctrl+W)
This will merge the selected clips to a new clip.  Please note that this works on a per track basis and will not combine 
clips from different tracks.



Link
The link sub menu allows you to link or unlink clips together. When clips are linked, they move together when 
dragging.  Each linked clip retains its relative offset to the other clips.  The sub menu link options are:

• Link Selected Clips   
• Unlink Selected Clips  

If a clip is linked, it will have a link button on its title bar: 
Click it to easily unlink a linked clip.

Mix Menu

Add Sound File... (Ctrl+H)
Shows the Add A Sound dialog so that you can add any supported sound file.  See Adding Sounds...

Add Instrument Clip
This will add a blank Virtual Instrument Clip on the closest Virtual Instrument Track.  You can also double click a 
Virtual Instrument Track to create a blank Virtual Instrument Clip.

Loop Library
This shows the Loop Library Page.

Play / Stop Playback ([Space Bar])
This starts and stops playback of the project from the Playback Indicator position.

Play From
This shows a pop up menu with an item for each marker in the project.  It is a convenient way to start playback from 
any marker in the project.

Rewind To Start ([Home])
This sets the Playback Indicator to the beginning or start of the project.  If the project is playing audio, it will restart 
playback from the start, as well.

Fast Forward To End ([End])
This sets the Playback Indicator to the end of the project.  If the project is playing audio, it will stop the playback.

Record (Ctrl+R)
This starts recording on any armed tracks and is the same as pushing the record button on the master bar.

Set Master Volume
Set the exact master volume or choose from 20% to 200%.

Edit Global Effects
This pops up the global or master effects window.

Project Settings
This displays the Project Details Tab so that you can edit the project settings such as the global tempo, key, time 
signature, author information, global effects and project recording folder.

MIDI Reset!
This will send a panic message to all virtual synthesizers and external synthesizers which instructs them to stop 
playing any 'stuck' notes.

Add Tempo / Key Change
This adds a marker at the current Playback Indicator position and lets you edit it, including setting a tempo or key 
change.



Markers
This pops up a sub menu allowing you to add, delete, or edit markers.

Automatically Beat Match New Sounds
This toggles Auto Beat Match mode.  Has the same action as pushing the Auto Beat Match button on the Project  
Details Tab.

Transpose Key Changes
This pops up a sub menu with Up or Down and will adjust any key change markers, including the project key marker 
up one key or down one key.  For example, if you had the key changes C, F and D and transposed them up, it would 
turn them into the keys of D, G and E.

Metronome
Select this to toggle whether the metronome should be on.  A check mark will indicate that the metronome is on.

Recording Count-In
Select this to toggle the recording count in, which will start the metronome before recording.  See more on the 
metronome.

Loop Playback Mode
Loop playback of a selection or the entire project so that you can play along with it or edit effects.

Use Recording Timer
Set a recording timer which allows you to automatically end a recording.

Project Settings
This shows the Project Details Tab so that you can edit the project key, tempo, time signature, author information, 
global effects and the recording folder. 

Track Menu

Add Track 
This appends a new audio track . (Ctrl+G) or a new Virtual Instrument Track (Ctrl+E) to the end of the project.

Insert Track
This inserts a new audio track or a new Virtual Instrument Track before the currently selected track.

Duplicate Track
This copies all settings and sounds on the selected track and puts it on a new track inserted after the selected track.

Move Track Up (Ctrl+Shift+U)
This moves the selected track up one spot.

Move Track Down (Ctrl+Shift+D)
This moves the selected track down one spot.

Track Color
Choose a base color for the track and its clips.

Track Height
This pop ups a sub menu to set the selected tracks height to Small, Normal or Large.

Choose Image...
This pops up the Track Image dialog so that you can pick a new track image.

Freeze Track (Ctrl+Shift+F)



This freezes the selected track.  This can be useful if the project is using too much CPU or RAM.

Mix To New Audio Track
This option mixes the selected track to a new audio track.  The original track is retained and is muted after the new 
audio track is created.  This can be useful if the project is using too much CPU or RAM.

Delete Track
This deletes the selected track.

Mute Track (Ctrl+M)
This mutes or unmutes the selected track.  A check mark indicates that the track is muted.

Solo Track (Ctrl+L)
This solos or un-solos the selected track.  A check mark indicates that the track is soloed.

Arm Track
Arms the selected track.

Set Volume
This pops up a sub menu that allows you to set the exact volume of the selected track or choose from 20% to 200% 
volume.

Set Pan
This pops up a sub menu that allows you to set the pan of the selected track.

Edit Effects
This shows the Track Details Tab so that you can edit the effects for the selected track.

Show/Hide Automation Lane
This shows or hides the automation lane for the selected track.

Select All Sounds On This Track (Ctrl+Shift+A)
This selects all tracks on the selected track. 

Sound Menu

Edit / Edit Loop
This will display the Sound Details tab for the currently selected sound.  If it is an audio clip you will be able to edit its 
loop, change its key and tempo.  If it is a Virtual Instrument Clip, you will be able to edit it via the Piano Roll Editor and 
change its key, tempo and more.

Add Sound File... (Ctrl+H)
Shows the Add A Sound dialog so that you can add any supported sound file.  See Adding Sounds...

Add Instrument Clip
This will add a blank Virtual Instrument Clip on the closest Virtual Instrument Track.  You can also double click a 
Virtual Instrument Track to create a blank Virtual Instrument Clip.

Loop Library
This shows the Loop Library Tab.

Play Sound
Plays the last selected sound.

Mute / Unmute
Mutes or unmutes the selected sound.



Lock / Unlock
Locks or unlocks the selected sound.

Channels
Allows you to choose the active/audible channel for an audio clip.  (Audio clips only!)  More info...  (This option is also 
available by right clicking on an audio clip.)

Edit In External Editor...
Edits the sound or a copy of the sound in an external sound editor (3rd party).

Make Into Loop
Makes the trimmed sound into a loop.  ** This only applies to audio clips.

Trim Silence (Ctrl+I)
This trims the left and right edge of each sound and removes any silent or near silent areas for all selected sounds.  ** 
This only applies to unlooped audio clips.

Automatic Marker Wizard...
This automatically creates markers based on a sound or at specified intervals.

Normalize Volume (Ctrl+K)
This adjusts the volume of all selected sounds to the normalized level.  The normalized level is based on the highest 
peak in the sound.

Boost
This shows a pop up menu allowing you to choose a percentage to boost all selected sounds for the current envelope 
type.  Note that the boost is applied to the selected area and if there is a selection rectangle, it will only fade in the 
selection rectangle.

Reduce
This shows a pop up menu allowing you to choose a percentage to reduce all selected sounds for the current 
envelope type.  Note that the reduce is applied to the selected area and if there is a selection rectangle, it will only 
fade in the selection rectangle.

Fade In
This shows a pop up menu with the following options: Fast, Medium & Slow. Each option will add a fade in of the 
current envelope type on all selected sounds.  Note that the fade is applied to the selected area and if there is a 
selection rectangle, it will only fade in the selection rectangle.

Fade Out
This shows a pop up menu with the following options: Fast, Medium & Slow. Each option will add a fade out of the 
current envelope type on all selected sounds.  Note that the fade is applied to the selected area and if there is a 
selection rectangle, it will only fade in the selection rectangle.

Reset Envelope (Ctrl+Alt+T)
This restores the current envelope to its default setting for all selected sounds.

Invert Envelope (Ctrl+Alt+Y)
This inverts or flips the current envelope vertically for all selected sounds.

Split (Ctrl+T)
This will split any selected sounds at the time offset where the caret intersects them.

Remove Spaces Between Clips (Ctrl+J)
Removing space between clips eliminates the gaps or silence between any selected sounds by moving the selected 
sounds together.

Remove Spaces Between Clips (Ctrl+J)
Removing space between the clips eliminates the gaps or silence between any selected sounds by moving the 



selected sounds together.

Merge To New Clips (Ctrl+W)
This will merge the selected clips to a new clip.  Please note that this works on a per track basis and will not combine 
clips from different tracks.

Link
The link sub menu allows you to link or unlink clips together. When clips are linked, they move together when 
dragging.  Each linked clip retains its relative offset to the other clips.  The sub menu link options are:

• Link Selected Clips   
• Unlink Selected Clips  

If a clip is linked, it will have a link button on its title bar: 
Click it to easily unlink a linked clip. 

Video Menu

Add A Video File...
Choose this to add a video file to the project. See more on video...

Show/Hide Video Window
This will show or hide the video playback window.

Set Preview Window Size
Choose from standard video sizes for the Video Window.

Link
The link sub menu allows you to link or unlink clips together. When clips are linked, they move together when 
dragging.  Each linked clip retains its relative offset to the other clips.  The sub menu link options are:

• Link Selected Clips   
• Unlink Selected Clips  

If a clip is linked, it will have a link button on its title bar: 
Click it to easily unlink a linked clip. 

View Menu

All Tracks Height
This option pops up a sub menu that allows you to choose the height of all tracks.  Choose from Small, Normal or 
Large.

Timeline Mode
Choose from Measures:Beats or Minutes:Seconds to view the timeline in beats or time mode.

Snap To Grid
Turn off snap or choose a snap setting for the timeline in the pop up sub menu.

Show / Hide Details Area
Shows or hides the details window, which would include project, track, sound or loop library details.

Project Details
Shows the Project Details Tab.

Track Details
Shows the Track Details Tab.



Sound Details
Shows the Sound Details Tab.

Loop Library
Shows the Loop Library.

Musical Typing
This brings up the Musical Typing Keyboard.

Zoom In ( + )
Zooms in to the project for a more detailed view.

Zoom Out ( - )
Zooms out for a more overall view.

Zoom To Project ( 0 )
Zooms in or out so that the entire project is visible on the screen. 

Help Menu

Help Contents...
Brings up the help file.

Check For Update...
Checks the Internet to see if there is a newer or updated version of this software.

Enter Registration Code...
If unregistered, this allows you to enter in your serial code and register the software.

Buy Now!
If unregistered, this shows a window with instructions on purchasing and registering the software.

Acoustica Software Products
This pops up a sub menu with links to other Acoustica software products.

Download Loops
This goes to a web page with tips and links on downloading more audio loops.

Download Sounds
This goes to a web page with tips and links on downloading more sounds.

Download Effects
This goes to a web page with tips and links on downloading more VST or DirectX effect plug-ins to use with the 
software.

About Mixcraft...
Credits, copyrights and thanks for Mixcraft. 

Keyboard Controls
Moving Clips (assumes a clip is selected)
(<-  or ->  ) +/- quick move (depends on zoom level and Snap Setting)
Ctrl + (<-  or ->  ) +/- 20 milliseconds. 
Ctrl + Shift + (<-  or -> ) +/- 1 millisecond.



Moving the Caret
(<-  or ->  ) +/- quick move (depends on zoom level and Snap Setting.)
Ctrl + (<-  or ->  ) +/- 20 milliseconds.

Ctrl + Shift + (<-  or -> )  +/- 1 millisecond.
(Up arrow or down arrow)  Move the caret between tracks and change the selected track.

Navigating Around Clips
Tab Select next clip.
Shift+Tab Select previous clip.
Esc Deselect any selected clips.

Volume Slider, Pan Slider & EQ knobs
ALT, Ctrl or Shift + left mouse click + drag  Finer resolution adjustments.

Copy And Paste
ALT + left mouse click + drag Quick copy the selected clip.

Playback controls
[Space] Start or stop playback.
[Space] + Ctrl Playback from next timeline marker.
[Space] + Ctrl + Shift Playback from last timeline marker.

[Home] Rewind the playback indicator to the start of the project.
[End] Fast forward the playback indicator to end of mix.

Envelope shaping controls
Alt+1 Fade in fast
Alt+2 Fade out fast
Alt+3 Fade in medium
Alt+4 Fade out medium
Alt+5 Fade in slow
Alt+6 Fade out slow

Alt+Ctrl+Q Boost 1%
Alt+Ctrl+A Reduce 1%
Alt+Ctrl+W Boost 5%
Alt+Ctrl+S Reduce 5%
Alt+Ctrl+E Boost 25%
Alt+Ctrl+D Reduce 25%
Alt+Ctrl+R Boost 50%
Alt+Ctrl+F Reduce 50%

Zooming
0 Zoom to project
- Zoom out.
+ Zoom in

Other
[Delete] Delete any selected sound(s)
[pg up] Scroll tracks view up.
[pg dn] Scroll tracks view down.

Ctrl+A Select all sounds.
Ctrl+Shift+A Select all sounds on the selected track.
Ctrl+B Burn CD
Ctrl+C Copy.
Ctrl+D Move the selected track down.



Ctrl+E Adds a Virtual Instrument Track to the project.
Ctrl+F Freeze the selected track
Ctrl+G Add Audio Track
Ctrl+H Add Sound File...
Ctrl+I Trim silence from selected sounds
Ctrl+J Remove space between selected clips selected sounds
Ctrl+K Normalize selected sounds
Ctrl+L Solo a track
Ctrl+Alt+M MIDI Reset! Stops all stuck notes.
Ctrl+M Mute a track
Ctrl+N New Project
Ctrl+O Open or load a Mixcraft project
Ctrl+P Prints the currently selected Virtual Instrument Clip's notation.
Ctrl+R Start recording
Ctrl+S Save.
Ctrl+T Split sounds at Caret
Ctrl+U Move the selected track up.
Ctrl+V Paste
Ctrl+X Cut
Ctrl+Y Redo the last undone thing you did.
Ctrl+Z Undo the last thing you did.

Nudging Sounds via the Keyboard
You can move sounds via the keyboard. Use the arrow keys to move selected sounds!

Moving horizontally along the timeline.
Use the arrows to move the sound quickly.  
Hold down the Ctrl key and the sounds will move in increments of 20 milliseconds. Hold down Ctrl+Shift key to move 
in increments of 1 millisecond.

(<-  or ->  )  +/- quick move (depends on zoom level.)
Ctrl + (<-  or ->  )  +/- 20 milliseconds
Ctrl + Shift + (<-  or -> )  +/- 1 millisecond

Moving sounds vertically
You can move the sound vertically as well.  You may do this if you are trying to move sound(s) to another track.

Tabbing between sounds via the keyboard
If you are interested in getting around quickly in the session and love the keyboard movement features, you will be 
happy to know that you can switch from sound to sound via the Tab key and Shift-Tab key combination. 

The Tab key will select the next sound on the current track or the first sound on the subsequent track.  (If you are at 
the end of the last track, it will go to the start of the first track.)

Holding down Shift key and pressing the Tab key will do the opposite of Tab.  It will select the previous sound on the 
track.  If it is the first track, it will select the last sound on the previous track. 

Musical Typing Keyboard (MTK)
If you do not have a MIDI keyboard attached to your computer, you can use your computer's keyboard to trigger 
notes!



Note: The functionality depends on the capability of your computer's keyboard.  Many keyboards do not allow more 
than three keys to be pushed at a time.  If you find yourself wanting more than three keys on the MTK, we recommend 
you purchase an actual MIDI keyboard rather than looking for a better computer keyboard.  This feature is supplied as 
a way to make music and is not necessarily the best way to make music, though.

How To Bring Up The MTK
Select "Musical Typing Keyboard" from the "Help" menu.  Alternatively, you can click the "Musical Typing..." button 
found on the Instrument Preset window.

Playing And Recording Notes
The MTK spans 17 notes or 1 1/2 octaves which can be played via the computer's keyboard.  Make sure to add a 
Virtual Instrument Track and choose a preset.  Press the keyboard buttons on the MTK to trigger the associated 
notes.  Press multiple keys at a time to play chords.  Press the Shift key to sustain notes.  Adjust the default velocity 
by clicking the velocity adjust keys < or >.  To bend the pitch down and up, click the 1 or 2 keys while playing back 
notes.  To adjust the modulation, click the keys 3 to 8 from off to maximum modulation.

Adjusting The Playable Range
You can change the playable range by an octave or note.  To change the playable range by an octave, press the Z or 
X keys.   To switch the playable range by a note, press the C or V keys.  Alternatively, you can click on a note on the 
smaller keyboard on the bottom.  This will set the starting key for the playable range.

Keyboard Shortcuts

A thru "     - Mapped to playable notes (white keys)
Q thru {   -  Mapped to playable notes (black keys)
1,2  -  Adjust the pitch bend
3 thru 8   - Adjust the modulation from off to max.
Shift  - Sustain the currently played notes, even if the keys are released.
Z, X  -  Adjust the playable range by +/- one octave.
C,V  - Adjust the playable range by +/- one note.
<,>  - Adjust the default velocity for new notes.

Cursors
 Arrow

The default cursor

 Envelope Point Edit



This cursor shows that an envelope point can be added or moved.

 Eraser
This cursor shows that you can erase notes or controller data.

 FlexAudio™
By holding down the Ctrl key and dragging, this lets you visually time stretch any audio clip.

    I-Beam
This cursor shows that a selection can be made on a sound.

 Pencil
This cursor shows that you can draw new notes or controller data.

 Play Sound
This cursor shows that you can play a sound in the sound library.

 Resize Interface
This cursor is shown when resizing the details area or resizing a track.

 Resize Or Loop Sound
This cursor shows that you can resize or loop a sound from the left or right.

 Track Volume
This cursor is used when changing the master volume or a track volume's slider.

 Flat Tool
This cursor is used to lower a note or piano roll bar by one half step/semitone in the Notation View.

 Sharp Tool
This cursor is used to raise a note or piano roll bar by one half step/semitone in the Notation View. 

Troubleshooting
Playback And Recording
Can't Play Sound!
Recording Is Not Working!
Sound Is Breaking Up / Popping Or Clicking
Sound Is Delayed Or Lagging (Latency)
Notes Will Not Stop Playing
Recordings Are Drifting And/Or Start At The Wrong Time
Recordings Are Not In Sync
Managing Recording 'Takes'
ASIO Is Not Available
I Can't Hear Myself During Recording!
New Tracks Are Recording Sound From Old Tracks

Formats
Mixcraft Won't Load The Sound
Sound Plays Back To Slow Or Fast
WMA File Support

Effects
How Can I Disable Certain Effects From Loading?



How Do I Add A VST Effect?
How Can I Hear Effects During Recording?

CD Burning
My CD/DVD Recorder Is Not Supported!
I Am Getting Burn Failures
How Do I Get Rid Of The Two Second Gap Between Tracks On My Burned CD?
The Burned CD Does Not Play In My Car or Home CD Player

Video
Video Loading Problems
Video Playback Problems

Downloading Sounds
Can't Download Sounds In Library

If you are still having problems, please visit our support with online help, videos, FAQs, tutorials and customer 
support.

  

Can't Play Sound
You've added sounds, but you can't play anything...  There are a few things you can check here.

1. Are the speakers on and plugged in?  (Sorry, management made us ask.) 
2. Can you play a Wave file through Windows or  another sound application?   If you can't there may be a problem 
with your sound card's configuration or drivers.  Refer to your sound card documentation to try to figure out what is 
wrong.
3. Load the volume control that came with your sound card and make sure that the Wave device is turned up and not 
muted.
4. Another program may be using the sound card at the same time (May happen with older versions of Windows.) 
5. Update or install your sound card's drivers.  Check their website for the latest drivers and documentation. 

Recording Is Not Working!
You can play audio, but you can't record anything!!!  There can be many reasons why this is not working. 

1. If recording from the microphone, make sure your microphone is plugged in to the right input in the back of your 
sound card.  Consult your sound card's documentation.  Or, if you are recording from the Line-In, make sure that the 
you are connected to the Line-In port in the back of your sound card.
2. You're trying to record audio from a CD but you are not seeing any signal.  Make sure that your sound card has a 
connection to your CD player.  This is usually an internal cable.  Most new computers do not have this problem,  
though.
3. Make sure that you are arming the correct input.  See more on arming tracks.
4. Make sure that you have the correct source selected for the armed track.
5. Make sure that the armed track's recording level is turned up.  See more on setting the level.
6. Try recording in Wave mode if you are in ASIO mode or vice versa.  You can try WaveRT mode if you are using 
Vista.

Always make sure that you have the latest drivers for your sound card.  Visit your sound card manufacturer's website 
to see if there is an update. 

Sound Is Breaking Up / Popping Or Clicking
When playing back a project, if the audio sounds like it is starting and stopping quickly, it could be because the 
computer is over tasked due to other programs running at the same time.  In addition, your computer may not be 

http://www.acoustica.com/mixcraft/support.htm


powerful enough to mix the audio.  Always shut down as many unnecessary programs as possible.  It may even be 
advantageous to temporarily shut down your virus software.  (We do not recommend doing this unless you have done 
a full scan and are not connected to the Internet.)

Mixcraft has to work harder as it mixes more sounds or processes more effects, especially when time stretching or 
beat matching. 

Try increasing the buffer size or the number of buffers in the Sound Device Preferences if your are in Wave mode.  If 
you are in ASIO mode, try a different ASIO driver or go into the ASIO driver's mixer and increase the latency.  If you 
are in WaveRT mode, try increasing the latency time.

You can also try freezing a track if there is a lot of effects or compressed audio formats on the track.  (Frozen tracks 
do not use as much computer power.)

Try setting Mixcraft to conserve CPU mode.  Go to the Preferences and click on Display.  Check the option to use 
Conserve CPU Mode.

Notice the CPU meter on the lower right hand corner of Mixcraft.  

This will report how much CPU Mixcraft is using compared to the entire computer's CPU usage.

Always make sure that you have the latest drivers for your sound card.  Visit your sound card manufacturer's website 
to see if there is an update. 

Sound Is Delayed Or Lagging (Latency)
The opposite problem of sound breaking up or gapping is that the sound will be delayed and have a latency from the 
time an edit is made to the time you hear it.  For example, if you are playing back audio and change an envelope 
point.  If it takes several seconds to hear the effect of the change, it means that you are experiencing latency.  The 
solution to latency depends on the type of audio drivers you are using.

Reducing Latency Using Wave drivers
Go to the Wave preferences and reduce the number of buffers and/or size.  Try different settings to try and find the 
right balance between performance and smooth non-gapping audio.

Reducing Latency Using ASIO
Go to the ASIO preferences and click the Open Mixer... button.  Use your ASIO driver control to configure the latency.  
Usually, you will have some way to set the latency in terms of milliseconds.  If possible, choose 10 milliseconds.  40-
80 milliseconds is also tolerable.

Reducing Latency Using WaveRT
Go to the WaveRT preferences and choose a lower latency time.

Always make sure that you have the latest drivers for your sound card.  Visit your sound card manufacturer's website 
to see if there is an update. 

Notes Will Not Stop Playing!
If you are playing back Virtual Instrument Clips and some notes continue to play after stopping, then you have 'stuck' 
notes.  T

The solution is to click MIDI Reset! from the Mix menu.  This should stop all stuck notes on the virtual instruments 
configured on the Virtual Instrument Tracks.

If this does not stop the notes from playing, try saving your project and restarting Mixcraft.  If it is an external 
synthesizer, try resetting or restarting the external synthesizer. 



Recordings Are Drifting And/Or Start At The Wrong Time
Welcome to the world of inaccurate timing and sound cards.  If you notice that your recordings are not lining up 
properly at the start, you'll need to adjust the offset or start time of the recorded sound.  Make sure snap is off and 
move the sound so that it lines up properly. You'll want to zoom in for the best accuracy.  Switching to an ASIO driver 
may help.  In addition, purchasing a better sound device may help.

However, if you're noticing that your recordings are slowly drifting over time, the problem is due to an inaccurate clock 
on your sound card or sound device.  Each device is made with more or less accurate clocks and not all devices have 
the same time as an atomic clock, for example.

If you have a Soundblaster LIVE, try recording in 48 kHz mode, by switching your Sound Device preferences to use 
the sample rate of 48,000 Hz.

Drift Work Around
Assuming the start of the sound is lined up properly, go to the end of the sound and visually time stretch it with 
FlexAudio using the Ctrl key so that it lines up properly.  Make sure to change the pitch shift mode to Do Not Fix 
Pitch.   Once you've lined up the end of the recording, you should be able to go to the Sound Details Tab to view the 
time stretch percentage that was needed to get it in sync.  (Example percentages will be around 99.995% or 
100.004%)  You can simply apply this drift percentage to all recordings after that.  (Don't forget to change the pitch 
shift mode to Do Not Fix Pitch)! 

Recordings Are Not In Sync
There are a couple of possibilities here.

The starting position of my recordings is wrong.
If the start offset of the recording is wrong, you can try the following suggestions:

• Adjust the sound manually 
• Update your sound card's drivers if possible.  Check the sound card's website. 
• Get a new sound device.  Get a more professional sound card designed for recording music, if possible. 
• Try switching to ASIO mode. or WaveRT mode for better synchronization.

My recordings are slowly losing synchronization over time!
If after 10 minutes or so, your recordings are noticeably out of synchronization, you may need to get a new sound 
device that won't lose synchronization.
Here are some tips to deal with drifting recordings on some sound cards.

Always make sure that you have the latest drivers for your sound card.  Visit your sound card manufacturer's website 
to see if there is an update. 

Managing Recording 'Takes'
When you make a recording it goes into your Project's recording folder.  By default, a recording is named based on 
the track's name.

Recordings are deleted when you save your project or quit the software if the recording was not included in a project 
that you saved. 

So, if you make a recording and aren't happy with it, simply click Undo on the toolbar or delete it by clicking the Delete 
key or selecting Delete from the Edit menu.  If you are worried about filling up your hard drive with bad takes, simply 
delete the take from within Mixcraft and then Save your project. 

ASIO Is Not Available



Make sure you have the latest drivers for your sound card.  Go to your sound card manufacturer's website to 
download and install the latest drivers. If you still do not have ASIO, you can try the following:

• Purchase a sound device that supports ASIO. 
• Try the free ASIO4All online.      (This is not guaranteed to work well on with all sound cards.)

Alternatively, if you have Window's Vista or Windows 7,  try WaveRT mode. 

I Can't Hear Myself During Recording!
Some sound cards or USB devices do not have a way to monitor the live recording.  If you can't hear yourself or 
whatever you are recording, you can use Mixcraft to play the incoming audio by monitoring the track.  Click the 
Monitor Incoming Audio option on the armed track.  Note that you may need to find the right balance between latency 
and non-gapping audio. 

Mixcraft Won't Load The Sound
There are many different types of sound file formats.  Mixcraft currently supports the Wave (.WAV & .AIF), MP3, 
OGG, and WMA formats.  

In addition, Mixcraft will work with the Window's Audio Compression Manager (ACM) to load compressed Wave files, 
other than PCM.   

If it is a WMA file, make sure that WMA format support is installed. and that they file does not have Digital 
Rights Management (DRM) on it. 

Sound Plays Back To Slow Or Fast
If you load in a sound and it plays back too fast or too slow, it's because it is being tempo adjusted most likely.  Click 
on the sound and then click on the Sound Details tab and adjust the sound to be in Time Stretch By mode instead of 
Adjust To Project Tempo.

When a sound plays back at a different speed, it can sound odd if it's too drastic. 

WMA File Support
In order to load and save to WMA files, you must have support for Microsoft Windows Media Format 7.1.  If you are 
trying to load a WMA file or export to WMA file and the option is grayed out, you probably do not have this installed.  
To download and install it, please visit http://www.acoustica.com/plugins/wma-install.htm .  (You do not 
need to restart your computer!)

If you've already installed WMA support, you may be trying to open a WMA with Digital Rights Management (DRM).  If 
you created this WMA file with Windows Media Player, you could recreate it with DRM turned off.  To turn off DRM, 
run Windows Media Player, choose Options from the Tool menu, click on "Copy Music" and make sure that "Copy 
Protect Music" is unchecked.  You'll have to recreate the WMA in this case.  (The old WMA file with DRM will not 
work.) 

How Can I Disable Certain Effects From Loading?
Mixcraft has two files, which you can edit to exclude effects from loading.  These files are located in your Mixcraft 
directory, which defaults to C:\Program Files\Acoustica Mixcraft 4\

DXIgnore.ini  - DirectX effect ignore list
VSTIgnore.ini  - VST effect ignore list 

Simply open or double click the file and then add the name of the effect and set it to equal = 1.  For example,  if you 
had an effect called 'Digital Media StudioDenoiser' that you didn't want the software to load, you would enter
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Digital Media StudioDenoiser=1

Save the ignore file and restart Mixcraft and the effect will not be loaded.   For VST effects, you will need to use the 
name of the dll such as SuperDuperReverb.dll=1 

How Do I Add A VST Effect?
VST effects are actually .DLL files.  Download and install your VST file (.DLL) into your VST folder and then restart 
Mixcraft.  Your new VST effect should now be in the effect drop down lists..  

If you don't know where your VST folder is, you can create a new one and then add it in the VST Folders section.  To 
add your own VST folder, go to the Effects Preferences and click on Edit VST Effect Folders.  Click the Add button to 
add your own folder or click the Auto-Scan For VST Directories to try and find one automatically.  Just make sure to 
put your new VST effect (.DLL) into one of the folders in your VST folder list and then restart Mixcraft and you should 
see the effect show up in the effect drop down lists! 

New Tracks Are Recording Sound From Other Tracks
If your newly recorded tracks are picking up parts of other tracks, your microphone or input device is probably picking 
up the sound from your speakers.  

Try using headphones.  

If that doesn't work, your sound card may have some noisy circuitry.  Go to your Window's mixer recording settings 
and make sure that only the devices you are interested in recording are not heard.  Mute any sources such as the CD 
player or auxiliary that you are not recording from.  To bring up your sound card's mixer click the Window's Start 
button followed by clicking Run...  Type in sndvol32 and push the enter key.  

Open your sound card's mixer!

Also, make sure you've selected the correct recording source. If possible, it's best to choose a specific source, instead 
of something general like "stereo mix," "what you hear" or "digital wave." For example, if your recording source is a 
microphone, choose "microphone." If you're recording from your computer's Line In input, choose that.

To choose your recording source in Mixcraft, click on the small down arrow that appears to the right of the arm button 
on the track you want to use for recording. First, choose the sound device you want to use (you may only have one 
choice), and you'll see a sub menu with a Stereo Source option.

Again, if you already have a specific source selected, your microphone could be picking up the sound from your 
speakers.  Try turning off your speakers and using headphones to monitor the audio! 

How Can I Hear Effects During Recording?
Some sound cards or USB devices have a way to monitor the live recording independent of Mixcraft.  However, if 
you'd like to hear the effects during recording, you'll need to disable the sound device's monitoring and use Mixcraft's 
monitoring system.  For example, if you are making a weird recording of your voice and would like to hear the echo or 
delay while recording, you'll need to turn on monitoring.  You'll need to enable Mixcraft's monitoring and disable any 
sound card's built in monitoring.

To turn on Mixcraft's monitoring, click the Monitor Incoming Audio option on the armed track.  Note that you may be 
fighting latency versus non-gapping audio by enabling monitoring.

To turn off the sound card's built in monitoring, you may need to go into the Window's audio mixer and go the 
playback section and click the advanced button (if it's there) to disable it.

sndvol32


My CD/DVD Recorder Is Not Supported!
Mixcraft supports three burning engines: Primo, Goldenhawk and IMAPI.  

The default and preferred engine is Primo which works on XP, Vista and above.  It will burn on the fly, burn CD Text 
and supports gap-less tracks.

If you are using Windows XP or Windows Vista, you can use the built in IMAPI burning engine.  The draw back to 
IMAPI is that it burns two second gaps between tracks on the burned CD.

Goldenhawk
Goldenhawk will burn on the fly and burns without gaps between tracks on the burned CD.  Unfortunately, 
Goldenhawk does not support as many CD and DVD writers.  However, there is some hope.

Since many drives are clones and use the same basic technology, they also share the command system that instructs 
the CD and DVD writers what to do.  With that in mind, you can try different drive definitions to see if they work with 
your drive.

Go into the CD Burning Preferences, make sure that Goldenhawk is selected and then click the Goldenhawk Drive 
Override... button.  This brings up some options for your unsupported devices.  Choose the unsupported drive from 
the drop down Select A Drive.  First try the Use A Generic CD Writer Drive and then click OK.  Restart the software to 
see if it's supported by trying a test burn.  If that doesn't work, go back into the Goldenhawk Override dialog and try 
Use The Driver For This Drive Type option.  Select a drive that sounds similar to your drive.  Consult the web to find 
out what type of drive it could be cloned from.  Try a drive with the same manufacturer but at a slower speed, etc.  
Note that it is not guaranteed to work, but this is an option to try.

Otherwise, switch to Primo or IMAPI mode if you are using XP or Vista. 

I Am Getting Burn Failures
Here are some suggestions to troubleshoot a burn failure.

• Try a burn in 'Test Mode' first. 
• Try a different blank CD (Make sure it's not full or scratched) 
• Try a different blank CD from a different manufacturer. 
• Shut down other programs and temporarily shut down your virus checker during a burn.  ( Shutting down your 

virus checker should be done at your own risk.  Make sure you are not connected to the Internet and have 
done a full virus scan recently.) 

• Try burning at a slower speed, especially if your CD recorder does not have 'Burn Proof'. 
• Try checking the option to 'Convert To WAV First.' 
• If you have more than one CD or DVD recorder, try switching to the other recorder on the burn CD window. 
• If you have Windows XP or Vista, try switching to IMAPI. 
• Try switching to a different burning engine.  Choose between Primo (recommended), Goldenhawk and IMAPI. 
• Try burning a short sound just to verify that CD recorder can still burn and is not defective. 
• Try burning with another program such as Windows Media Player to verify that your CD recorder is not 

defective or having some kind of system conflict.

How Do I Get Rid Of The Two Second Gap Between Tracks On My Burned CD?
In Primo or Goldenhawk mode, audio CDs will not have a two second gap between tracks.  

However, if you are burning in IMAPI mode, you are forced by the IMAPI system to have a two second gap between 
tracks.  

There are two options:



1) Click the checkbox to Burn As One Track on the burn CD window.  The problem with this option is that you will 
have to fast forward or rewind the burned CD to get to a specific part.

2) Mix the project down to WAV files and then use a 3rd party burning program that supports your CD writer or DVD 
writer.  On the Mix Down dialog, make sure that you check the option to Create A New File For Each CD Marker.  We 
recommend WAV files at CD quality for the mix down.  Then import the WAV files into your 3rd party CD writer 
software, arrange them in the correct order and burn the CD! 

The Burned CD Does Not Play In My Car or Home CD Player
There are a few things you can try:

• Make sure that you actually burned the CD!  Look at the back of the CD under a light and make sure that you 
see a difference between a burned area and a blank section. 

• Make sure that there aren't any scratches or smudges on the CD data surface.   
• Try a different burning engine.  Primo is the latest and newest engine.  Change the engine in the CD Burning 

preferences. 
• Try a different blank CD made from a different manufacturer.  See if there is a recommended type of CD for 

your CD player. 
• Try burning at a slower speed.  Older CD players are not as tolerant and if you burn at a slower speed, it will 

burn with a higher precision of quality.  Also, some blank CDs are not rated for higher speeds.  Check the 
information that came with your blank CDs for its burn speed rating. 

• If there is a paper sticker label on the CD, it could be interfering with the weight balance or it may not be 
spinning at the right speed.  Try a CD without a label on it. 

• Check to see if the CD plays in other CD players, besides your computer. 

Video Loading Problems
By default, Mixcraft will support AVI and WMV video files.  However, there are a lot of different types of video files out 
there.  Knowing what type of video you have is important.  

Mixcraft uses the DirectX decoders that Windows Movie Maker or Windows Media Player uses.  As a general rule, if 
you can't load it in one of those programs, you won't be able to load it into Mixcraft.

If You Can't See Your Video File To Load
To load a video, select "Add Video File..." from the "Video" menu.  Navigate to the folder with your video in it.  If your 
video is not in the .AVI or .WMV formats, you will need to switch the File Type drop down from "Default Video Files" to 
"All Files".  Now, you should see your video file.  Select it to load it.

If Your Video Is Not Loading
If the video fails to load, it is because you are most likely missing the correct DirectX video decoder.  The best advice 
is to do one of the following:

• Install the software that came with your video camera.  It may also have come with a DirectX video decoder 
that would allow other programs such as Windows Movie Maker or Windows Media Player to play the files.  
(This assumes that the file was created with a video camera that you own.)  Make sure to restart your 
computer after installing. 

• Download a video file converter to convert it to AVI.  This is better than loading the original video format, as it 
will be faster. 

• Install a DirectX/DirectShow video decoder for the video format you are attempting to load.  Beware of many 
faulty/buggy/error prone decoders out there.

Video Playback Problems
If after loading your video, Mixcraft does one of the following:

• Mixcraft crashes with an error window 
• Mixcraft freezes and stops responding 



• Mixcraft's CPU usage goes way up to above 60% or so. 
• Video frames appear distorted.

If one of the above is happening, it could definitely be the DirectX video decoder.  The best advice is to convert your 
video file into an AVI or WMV.  AVI and WMV files are tested to be compatible with Mixcraft.  AVI files will use less 
CPU power, as well.

Search the Internet for "video converter software" that will convert from your video format to AVI and/or WMV.   

Can't Download Sounds In Library
If you can't download sounds from the library, make sure of the following things.

• Make sure that you are connected to the Internet.  Try launching your Internet browser and going to a news 
article or website that you haven't been to.  (This verifies that you aren't viewing cached content.) 

• Make sure that your security software or Internet firewall is not blocking Mixcraft from accessing the Internet.  
You will need to go into your firewall or security software and allow Mixcraft access to the Internet.  (You may 
need to use your security or fire wall's help manual or documentation to figure this out.) 

• Try a different Internet download server by changing Mixcraft's Loop Library Download option. 

Glossary
ASIO
ASIO provides an interface between your audio application and the sound card, and stands for: Audio Stream 
Input/Output. It was developed by Steinberg Media Technologies and helps manufacturers and developers to create 
hardware and driver software which extend the personal computer's audio connectivity to meet the needs of 
musicians and audio engineers. ASIO offers a relatively simple way of accessing multiple audio inputs and outputs. 
The Audio Stream I/O API addresses the areas of efficient audio processing, high data throughput, synchronization, 
low latency and extensibility on the audio hardware side. The interface is not bound to any fixed number of input and 
output channels, and provides a constant streaming model.

ASPI
ASPI stands for  Advanced SCSI Programming interface and standardizes communication between a SCSI host 
adapter and CD drives, hard drives and other devices.  (Most people can think of it as a special driver to communicate 
with your CD writer.)

Audio Clips
Audio clips represent audio files that can be stretched, edited, looped and played in Mixcraft.  Audio clips will usually 
be OGG, WAV, MP3, WMA or AIFF files.

AVI
AVI (Audio Video Interleave) is a Microsoft video file format standard for storing audio and video on PCs.  AVI files 
can contain compressed or uncompressed video and audio.

BPM
Beats per minute. The usual measurement of tempo in music.

Burn Proof
Burn Proof is a proprietary technology for buffer under-run protection developed by Plextor.  Other buffer under-run 
avoidance technologies are called Safe Burn, Power Burn and Just Speed.  Most new drives have a buffer underrun 
protection technology.

Buffer Underrun
This is when the computer cannot deliver data fast enough to a CD writer.

CD Quality
CD Quality is the standard quality used on audio CDs.  It is 44,100 Hz, 16 bit, stereo.



Clipboard
The clipboard is a buffer of sounds that can be stored and pasted later.  Currently, clipboard operations involving 
sound is limited to Mixcraft and it will not share audio data with other programs unless you add the audio file directly.

DAO
DAO stands for Disc At Once.  During the CD burning process, the entire CD is written at once without the write laser 
being turned off.  Thus, you can have seamless uninterrupted audio with 'seekable' tracks.

Decibel
The decibel (dB) is a logarithmic unit of relative measurement used to compare the ratio of the intensities of two 
signals.  When an amplitude doubles, the increase corresponds to 6 dB.

Decoder
An algorithm or process for taking compressed or encrypted data and turning it into uncompressed or unencrypted 
data.

DirectX Effects
DirectX Effects are Microsoft's method of processing audio.  Audio goes in to an effect and comes out manipulated. 

DRM
DRM stands for Digital Rights Management.  DRM provides a security layer on software, audio or any type of media 
to help ensure proper licensing and use of the content.  DRM on audio files is constantly evolving and the 'jury is still 
out' as to whether it is effective.

Effects Chain
A list of effects in which audio is processed.  Audio is sent down the effect chain list from top to bottom and the final 
result is heard on your speakers.

Encoder
An algorithm or process for taking uncompressed data and turning it into compressed or encrypted data.

Goldenhawk
The company that built the Goldenhawk burning engine used in this software.  The Goldenhawk burning engine uses 
ASPI to communicate with your CD writers.

General MIDI
General MIDI or GM is a standardized mapping of patch numbers to specific instruments.  For example, patch 0 is 
always 'Acoustica Piano'.  Each GM standard synthesizer will have patch 0 mapped to 'Acoustica Piano'.  More 
details can be found on Wikipedia.

IMAPI
IMAPI is the built in burning system found on Window's XP and Vista.  IMAPI stands for Image Mastering Application 
Programming Interface.

ISRC
ISRC stands for International Standard Recording Code.  If your intention is to burn an audio CD for commercial use, 
you will need to enter in your ISRC codes for each track.

Key
The key identifies the tonic triad, the chord, major or minor, which represents the final point of rest for a piece, or the 
focal point of a section.

Latency
Latency is a delay between the time something occurs and the time that you sense the occurrence. In audio software, 
this might be the difference from the time audio is mixed and processed to the time you hear it.

Megabyte
A megabyte is approximately one million bytes ( 1024 X 1024 bytes ).  A typical hard drive stores around 40 GB 
(gigabytes).  A gigabyte is equivalent to a billion bytes or 1024 X 1024 X 1024 bytes. 
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Metronome
A metronome is a device or system that produces a regulated pulse, usually used to keep a beat steady in musical 
compositions.

MIDI
MIDI is an acronym for Musical Instrument Digital Interface and is the way that physical and virtual synthesizers 
communicate with each other.  For example, when you press middle C on your musical keyboard, it sends a message 
says "Play Middle C".  It is a small and compact series of codes.

MP3
MPEG-1 Audio Layer 3, more commonly referred to as MP3, is a popular digital audio encoding, lossy compression 
format, and algorithm, designed to greatly reduce the amount of data required to represent audio, yet still sound like a 
faithful reproduction of the original uncompressed audio to most listeners.

Mixcraft LE
Mixcraft LE is the light edition of Mixcraft.  In Mixcraft LE, you are restricted to 8 audio tracks and 16 virtual instrument 
tracks.  The LE version cannot burn audio CDs or create MP3 files.  If you have the LE version, you will not need to 
purchase the software.  However, you will have the option to upgrade to the full version of Mixcraft so that you can 
burn audio CDs, create MP3 files and have unlimited tracks.

Multitrack
Multitrack recording ('multitracking' or just 'tracking' for short) is a method of sound recording that allows for the 
separate recording of multiple sound sources to create a cohesive whole.

Normalize
The process of raising the volume so that the biggest volume in the sound is increased to the maximum possible and 
the rest of the sound is raised in volume by the same percentage.

OGG
Ogg is a patent-free, fully open and standardized multimedia bit stream container format designed for efficient 
streaming and manipulation (concatenation and muxing) by the Xiph.Org Foundation.

Overdub
Overdubbing (the process of making an overdub, or overdubs) is a technique used by recording studios to add a 
supplementary recorded sound to a previously recorded performance.

Pan
The balance or ratio between the left and right speakers (channels).

Peaks
A visual display of a sound's amplitude over time. (Mixcraft shows one peak per millisecond.)

PCM
Pulse-code modulation (PCM) is a digital representation of an analog signal where the magnitude of the signal is 
sampled regularly at uniform intervals, then quantized to a series of symbols in a digital (usually binary) code. PCM 
has been used in digital telephone systems and is also the standard form for digital audio in computers and the 
compact disc red book format.

Primo
Primo is a CD burning engine created by Primo Software.  It works with XP, Vista or greater and is the default burning 
engine.

Sample Bit Depth
In digital audio, bit depth describes the amount of data contained in each sample, using the unit bits (not to be 
confused with bytes). Common examples of bit depth include CD audio, which is recorded at 16 bits, and DVD-Audio 
which can support up to 24-bit audio.

Sample Channels
Sample channels describes the number of channels contained in each audio sample.  For example, CD audio has two 
channels in each sample.



Sample Rate
The sampling rate, sample rate, or sampling frequency defines the number of samples per second (or per other unit) 
taken from a continuous signal to make a discrete signal. For time-domain signals, it can be measured in hertz (Hz).

Semitone
A semitone, or half-step is a musical interval. It is the smallest interval commonly used in Western music, and is 
considered the most dissonant. 

Standard MIDI File
This is a standard file format that stores multiple tracks of MIDI data.  Most MIDI software will read standard MIDI files 
(.MID)

Tag
A tag is extra ancillary information stored inside of an audio file, which includes things like artist, album, genre and 
copyright.

TAO
Track-At-Once or TAO is a recording mode where the recording laser stops after each track is finished and two run-
out blocks are written. One link block and four run-in blocks are written when the next track is recorded. TAO discs 
can have both data and audio at the same time.

Tempo
In musical terminology, tempo (Italian for "time", from Latin Tempus) is the speed or pace of a given piece. 

Time Signature
The time signature (also known as "meter signature") is a notational convention used in Western musical notation to 
specify how many beats are in each bar and what note value constitutes one beat.

Time Stretch
Time stretching is the process of changing the speed or duration of an audio signal without affecting its pitch. 

Virtual Instrument Clips
A Virtual Instrument Clip contains MIDI data which is a series of notes and other events.  To produce actual audio, it 
sends the note data to the synthesizer configured on a Virtual Instrument Track.

Virtual Instrument Track
A Virtual Instrument Track is a track that has a Virtual Instrument or external synthesizer which it sends MIDI 
information to.

Volume
The amplitude of sound.  The minimum is 0% and the maximum is 200%

VST Effects
Virtual Studio Technology and its acronym VST refer to an interface standard for connecting audio synthesizer and 
effect plug ins to audio editors and hard-disk recording systems. VST and similar technologies allow the replacement 
of traditional recording studio hardware with software counterparts.

WAV
WAV (or WAVE), short for Waveform Audio Format, is a Microsoft and IBM audio file format standard for storing audio 
on PCs.

Wave Form
Waveform means the shape and form of a signal, such as a wave moving across the surface of water, or the vibration 
of a plucked string.

WaveRT
This is the new low latency, high performance audio driver system on Windows Vista.  It stands for Wave Real Time.

WDM



WDM stands for Windows Driver Model.

WMA
WMA stands for Windows Media Audio.  WMA files contain perceptually encoded sound data.  
The frequencies that humans cannot perceive are removed, although some audio purists say they can tell the 
difference between a high bit-rate WMA and a Wave file.  A WMA file can be as much as 20 times smaller than an 
equivalent WAV file. 

WMV
WMV (Windows Media Video) is a Microsoft video file format for storing and streaming audio and video on PCs.  
WMV files contain compressed video and audio. 

Acoustica was founded in 1998 and is located in the foothills of the Yosemite Valley.  Acoustica's mission is to create 
high quality, intuitive and powerful software.  We value diligence, creativity and innovation.  We are embracing Internet 
technology and the new world that it is creating.  We also have this curious idea that SOFTWARE SHOULD BE EASY 
TO USE!

Mixcraft 5 is the latest in a series of highly innovative and user-friendly software we've created.  Other products 
include Pianissimo, Beatcraft, CD/DVD Label Maker & Spin It Again.

Acoustica
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U.S.A.
www.acoustica.com
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